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Capítulo 1. Introdução

Você pode gerenciar e configurar o IBM®
ERserver BladeCenter™ 2-Port Fibre

Channel Switch Module por meio de uma conexão Telnet com a CLI (Interface da
Linha de Comandos) incorporada ou utilizando o aplicativo IBM BladeCenter SAN
Utility. O SAN Utility fornece uma GUI (Interface Gráfica com o Usuário) que você
pode utilizar para configurar módulos de múltiplas chaves Fibre Channel por meio
de outros dispositivos SAN conectados a partir de uma única interface. O aplicativo
IBM BladeCenter SAN Utility é referido em toda esta publicação como SAN Utility.
O IBM BladeCenter 2-Port Fibre Channel Switch Module é referido em todas esta
publicação como módulo de chave.

Este Guia do Usuário fornece instruções para:

v Configurar seu módulo de chave

v Gerenciar malhas, portas e módulos de chave

v Utilizar o Telnet e a CLI para configurar parâmetros do módulo de chave

Você pode gerenciar a malha do BladeCenter por meio de uma rede Ethernet,
utilizando o SAN Utility ou a CLI. O SAN Utility é instalado em uma estação de
trabalho de gerenciamento de rede Microsoft® Windows® 2000, Red Hat Linux®

Advanced Server Versão 2.1, Red Hat Linux Versão 7.x ou SuSE Linux
Professional Versão 8.0.

O módulo de chave possui um servidor Telnet incorporado por meio do qual um
cliente do Telnet pode conectar e gerenciar o módulo de chave utilizando a CLI.
Consulte o Capítulo 2, “CLI (Interface da Linha de Comandos)”, na página 5 para
obter informações adicionais sobre os comandos do Telnet e da CLI.

O SNMP fornece monitoração e funções de traps para a malha. O firmware do
módulo de chave suporta o SNMP Versões 1, 2 e 3; o FA-MIB (Fibre Alliance
Management Information Base) versão 4.0; e o FE-MIB (Fabric Element
Management Information Base) RFC 2837. Os traps são formatados utilizando o
SNMP versão 2.

Se você for um usuário experiente, poderá utilizar a CLI do Telnet para executar as
seguintes tarefas:

v Gerenciar o módulo de chave a partir da interface do módulo de gerenciamento
do BladeCenter para o cliente do Telnet

v Executar um gerenciamento de chave única

v Utilizar comandos de controle avançados

Se você for um usuário iniciante ou se precisar gerenciar módulos de múltiplas
chaves a partir de uma única interface, poderá utilizar a GUI do SAN Utility para
executar as seguintes tarefas:

v Gerenciar seu módulo de chave a partir de um cliente remoto ou da estação de
trabalho de gerenciamento de rede

v Gerenciar sua malha de múltiplas chaves

Para obter informações sobre como instalar o módulo de chave e o SAN Utility,
consulte o IBM BladeCenter 2-Port Fibre Channel Switch Module: Guia de
Instalação que é fornecido com o módulo de chave.

© Copyright IBM Corp. 2003 1



Você pode obter informações atualizadas sobre seu módulo de chave e outros
produtos de servidor IBM em http://www.ibm.com/eserver/bladecenter/.

Publicações Relacionadas
Este Guia do Usuário descreve como utilizar o aplicativo SAN Utility. Descreve
também como iniciar a CLI do Telnet e lista os comandos da CLI e seu uso.

Além deste Guia do Usuário, a seguinte informação relacionada é fornecida com
seu módulo de chave:

v IBM Eserver BladeCenter 2-Port Fibre Channel Switch Module: Guia de
Instalação

Esta publicação contém instruções detalhadas sobre a instalação do módulo de
chave. Ela também fornece informações gerais sobre seu módulo de chave,
incluindo informações sobre os recursos, como instalar e configurar seu módulo
de chave, como instalar o aplicativo SAN Utility e como obter ajuda.

v IBM Eserver BladeCenter Tipo 8677: Guia de Instalação e do Usuário

Esta publicação é fornecida em PDF (Portable Document Format) no CD de
Documentação do BladeCenter da IBM. Ela contém informações gerais sobre a
sua unidade BladeCenter, incluindo:

– Informações sobre recursos

– Como configurar, cabear e iniciar a unidade BladeCenter

– Como instalar opcionais na unidade BladeCenter

– Como configurar a unidade BladeCenter

– Como detectar problemas básicos da unidade BladeCenter

– Como obter ajuda

v IBM Eserver BladeCenter HS20 Tipo 8678: Guia de Instalação e do Usuário

Esta publicação é fornecida em PDF no CD de Documentação do BladeCenter
da IBM. Ela contém informações gerais sobre seu servidor blade, incluindo:

– Informações sobre recursos

– Como configurar e iniciar o servidor blade

– Como instalar opcionais no servidor blade

– Como configurar o servidor blade

– Como instalar um sistema operacional no servidor blade

– Como detectar problemas básicos do servidor blade

– Como obter ajuda

v IBM Eserver HS20 Fibre Channel Expansion Card: Guia de Instalação e do
Usuário

Esta publicação contém instruções para instalar sua Placa de Expansão IBM
HS20 Fibre Channel em um servidor blade IBM BladeCenter HS20 e
informações sobre:

– Configuração da Placa de Expansão HS20

– Atualização do código BIOS e dos drivers de dispositivo da Placa de
Expansão HS20.

v IBM Eserver BladeCenter SAN Solutions Guide

Esta publicação é fornecida em PDF no CD de Documentação do BladeCenter
da IBM. Ela fornece uma discussão direcionada aos usuários sobre como os
opcionais do BladeCenter Fibre Channel são utilizados para fornecer diferentes
soluções de armazenamento SAN para diferentes necessidades do aplicativo.
Este documento também fornece uma visão geral e uma descrição das soluções
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de backup e restauração, soluções de continuidade e alta disponibilidade de
negócios e soluções de consolidação de armazenamento e compartilhamento de
dados.

v IBM Eserver BladeCenter Fibre Channel Switch Interoperability Guide

Esta publicação é fornecida em PDF no CD de Documentação do BladeCenter
da IBM. Ela fornece dados de configuração do módulo de chave Fibre Channel e
procedimentos de configuração passo a passo para integrar a unidade
BladeCenter a malhas de chave de outros fornecedores. A configuração de cada
fornecedor inclui uma lista de verificação de integração inicial, limitações de
configuração, versões de chave e firmware suportadas, operações específicas
do aplicativo de gerenciamento e uma lista de verificação de integração
bem-sucedida.

v Instruções de Instalação em Rack

Esta publicação contém as instruções para instalar a sua unidade BladeCenter
em um rack.

v Informações sobre Segurança

Esta publicação multilíngüe é fornecida em PDF no CD de Documentação do
BladeCenter da IBM. Ela contém versões traduzidas das instruções de cuidado e
perigo que aparecem na documentação. Cada instrução de cuidado e perigo
possui um número, que você pode utilizar para localizar a instrução
correspondente em seu idioma.

v IBM Eserver BladeCenter Hardware Maintenance Manual and Troubleshooting
Guide

Esta publicação é fornecida em PDF no CD de Documentação do BladeCenter
da IBM. Ela contém informações para ajudá-lo a resolver problemas sozinho ou
para fornecer informações úteis para um técnico de serviço.

Dependendo do modelo do servidor blade, poderão ser incluídas publicações
adicionais no CD de Documentação do BladeCenter da IBM.

Além de consultar as publicações nesta biblioteca, certifique-se de consultar o IBM
Eserver BladeCenter Planning and Installation Guide em
http://www.ibm.com/eserver/bladecenter/ na World Wide Web para obter
informações que o ajudarão a preparar a instalação e configuração.

Avisos Utilizados neste Manual
Os seguintes avisos são utilizados neste manual:

v Notas: Estes avisos fornecem dicas, orientações ou conselhos importantes.

v Importante: Esses avisos fornecem informações ou avisos que podem auxiliar a
evitar situações inconvenientes ou de problema.

v Atenção: Estes avisos indicam potenciais danos aos programas, dispositivos ou
dados. Um aviso de atenção aparece imediatamente antes da instrução ou
situação em que podem ocorrer danos.
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Capítulo 2. CLI (Interface da Linha de Comandos)

O módulo de chaves contém um servidor Telnet incorporado. Este servidor permite
que o cliente estabeleça uma sessão Telnet com o módulo de chaves para
recuperar informações ou para configurar parâmetros usando a CLI. Com a CLI
você poderá executar várias tarefas de gerenciamento de malha e de chave por
meio de uma conexão Ethernet com a unidade BladeCenter.

A interface Telnet pode ser acessada de duas maneiras:

v Na interface da Web do módulo de gerenciamento do BladeCenter

v Em uma janela de linha de comandos em uma estação de trabalho de
gerenciamento de rede conectada

Importante: Antes de configurar o módulo de chaves, verifique se os módulos de
gerenciamento na unidade BladeCenter estão configurados corretamente. Além
disso, para acessar e gerenciar o módulo de chaves estando em um ambiente
externo, talvez seja necessário ativar certos recursos, tais como portas externas e
o gerenciamento externo em todas as portas. Consulte as publicações
BladeCenter: Guia de Instalação e do Usuário aplicáveis no CD de Documentação
do BladeCenter da IBM para obter informações adicionais. Para obter informações
mais detalhadas sobre a configuração do módulo de chaves, consulte o Eserver

BladeCenter 2-Port Fibre Channel Switch Module: Guia de Instalação no CD de
Documentação do BladeCenter da IBM.

Além de rever as publicações nesta biblioteca, certifique-se de rever o Eserver

BladeCenter Planning and Installation Guide da IBM em
http://www.ibm.com/eserver/bladecenter na World Wide Web para obter
informações que o ajudarão a preparar a instalação e configuração da unidade
BladeCenter.

Efetuando Logon em uma Chave
Para efetuar logon em uma chave usando a Telnet, execute as seguintes etapas:

1. Abra uma janela de linha de comandos na estação de trabalho de
gerenciamento de rede, digite um dos seguintes comandos e pressione Enter.

Para o compartimento 3 do módulo de chaves:
telnet 192.168.70.129

Para o compartimento 4 do módulo de chaves:
telnet 192.168.70.130

Abre-se uma janela de prompt de comandos.

2. No prompt Login, digite o padrão inicial do ID do usuário, USERID. No prompt
Password, digite a senha padrão inicial, PASSW0RD (o sexto caractere é um
zero, não é a letra O). O ID do usuário e a senha diferenciam maiúsculas e
minúsculas.

Essa conta do usuário fornece acesso completo à chave e a sua configuração.
Após planejar as necessidades do gerenciamento de malha e criar suas próprias
contas do usuário, considere a possibilidade de alterar a senha dessa conta.
Consulte “Comandos” na página 6 para obter mais informações sobre níveis de
autoridade. Consulte “Comando User” na página 61 para obter informações sobre a
criação de contas de usuário.
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Nota: O módulo de chaves dá suporte a um combinado com 15 logins no máximo.
Isto inclui o SAN Utility na faixa e logins fora da faixa, logins de Telnet fora
da faixa e logins de SNMP fora da faixa. São aceitos no máximo 10 logins
do SAN Utility. Os logins adicionais serão recusados.

Sintaxe de Comandos
A sintaxe de comandos é a seguinte:

comando
palavra-chave
palavra-chave [valor]
palavra-chave [valor1] [valor2]

O comando é seguido por uma ou mais palavras-chave. Leve em consideração as
seguintes regras e convenções:

v Os comandos e palavras-chave são expressos em minúsculas e fazem distinção
entre maiúsculas e minúsculas.

v Os valores requeridos de palavras-chave são mostrados em fonte padrão:
[valor]. Os valores opcionais são mostrados em itálico: [valor].

v A parte sublinhada de cada palavra-chave indica a abreviatura que pode ser
usada. Por exemplo, a palavra-chave Excluir pode ser abreviada com Exc.

Comandos
O conjunto de comandos fornece níveis de autoridade de Usuário e Admin.

v A autoridade de Usuário concede acesso de visualização para a malha e as
chaves usando o comando Show e outros comandos somente leitura.

v A autoridade Admin inclui a autoridade de Usuário e concede permissão para
usar o comando Admin. O comando Admin Start abre uma sessão admin, a qual
fornece acesso aos comandos que alteram as configurações de chave e de
malha. Consulte “Comando Admin” na página 8.

Nota: A autoridade Admin é aplicada apenas se a segurança da malha estiver
ativada na chave. Por padrão, a segurança da malha é desativada.
Consulte as palavras-chave do “Comando Set Setup” na página 39 para
obter informações sobre a configuração da segurança da malha.

Os comandos e seus números de página são listados por nível de autoridade na
Tabela 1 na página 7. Os seguintes comandos da sessão Admin possuem algumas
palavras-chave que estão disponíveis com a autoridade de Usuário:

Alias
Config
Date
Set
User
Zone
Zoneset
Zoning
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Tabela 1. Comandos Listados por Nível de Autoridade

Comandos de autoridade de Usuário Comando de autoridade Admin

Help (página 15)

History (página 16)

Ps (página 20)

Quit (página 21)

Show (página 42)

Show Config (página 49)

Show Log (página 51)

Show Perf (página 53)

Show Setup (página 55)

Uptime (página 60)

Whoami (página 63)

Admin (página 8)

Comandos da sessão Admin

Alias (página 9)

Config (página 11)

Date (página 13)

Fallback (página 14)

Image (página 17)

Lip (página 18)

Passwd (página 19)

Reset (página 22)

Set (página 26)

Set Config (página 28)

Set Log (página 34)

Set Port (página 37)

Set Setup (página 39)

Shutdown (página 57)

Test (página 58)

User (página 61)

Zone (página 64)

Zoneset (página 67)

Zoning (página 69)
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Comando Admin
Abre e fecha uma sessão admin. A sessão admin fornece comandos que alteram
as configurações de malha e de chave. Apenas uma sessão admin pode ser aberta
na chave a qualquer hora. Uma sessão admin inativa esgotará o tempo limite após
um período de tempo que pode ser alterado com o comando Set Setup System.
Consulte “Comando Set Setup” na página 39.

Autoridade
Admin

Sintaxe
admin

start
end
cancel

Palavras-chave
start

Abre a sessão admin.

end
Fecha a sessão admin. Os comandos Logout, Shutdown e Reset Switch
também finalizam uma sessão admin.

cancel
Encerra uma sessão admin aberta por outro usuário. Utilize esta palavra-chave
com cautela porque ela encerra a sessão admin sem avisar o outro usuário e
sem salvar alterações pendentes.

Notas
Fechar uma janela Telnet durante uma sessão admin não finaliza a sessão. Neste
caso, será necessário esperar o tempo limite da sessão admin ou usar o comando
Admin Cancel.

Exemplos
O seguinte exemplo mostra como abrir e fechar uma sessão admin.
FCSM: user1> admin start

FCSM: (admin) user1>

.

.

.

FCSM (admin) : user1> admin end
FCSM: user1>
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Comando Alias
Cria um conjunto de portas nomeado. Os aliases facilitam a atribuição de um
conjunto de portas a muitas zonas. Um alias não pode possuir uma zona ou outro
alias como membro.

Autoridade
Admin

Sintaxe
alias

add [alias] [members]
copy [alias_source] [alias_destination]
create [alias]
delete [alias]
list
members [alias]
remove [alias] [members]
rename [alias_old] [alias_new]

Palavras-chave
add [alias] [members]

Especifica uma ou mais portas dadas por [members] a serem adicionas em um
alias denominado [alias]. Um alias pode ter no máximo 2.000 membros.
[members] pode ter um dos seguintes formatos:

v ID do domínio e par de números da porta (ID de domínio, número da porta).
Os IDs de domínio e números de portas são expressos no formato decimal.
Os números de portas iniciam-se com 0.

v Endereço de Fibre Channel de dispositivo hexadecimal de 6 caracteres (hex)

v Nome no mundo inteiro da porta hexadecimal de 16 caracteres (PWWN)
com o formato xx:xx:xx:xx:xx:xx:xx:xx.

O aplicativo verifica se o formato [alias] está correto mas não valida a
existência de tal porta.

copy [alias_source] [alias_destination]
Cria um novo alias denominado [alias_destination] e copia a associação para si
com base no alias dado por [alias_source].

create [alias]
Cria um alias com o nome dado por [alias]. Um nome de alias deve iniciar com
uma letra e não pode ter mais que 64 caracteres. Os caracteres válidos são
0-9, A-Z, a-z, &, _ e -. O banco de dados de zoneamento dá suporte a 256
aliases no máximo.

alias delete
Exclui o alias especificado dado por [alias] do banco de dados de zoneamento.
Se o alias for um membro do conjunto de zonas ativo, o alias não será
removido do conjunto de zonas ativo até que o mesmo conjunto seja
desativado.

list
Exibe uma lista de todos os aliases. Essa palavra-chave é válida para a
autoridade de Usuário e não requer uma sessão de edição de zoneamento ou
uma sessão admin.
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members [alias]
Exibe todos os membros do alias dado por [alias]. Essa palavra-chave está
disponível com a autoridade de Usuário e não requer uma sessão de edição de
zoneamento ou uma sessão admin.

remove [alias] [members]
Remove as portas dadas por [members] do alias dado por [alias]. [members]
pode ter um dos seguintes formatos:

v ID do domínio e par de números da porta (ID de domínio, número da porta).
Os IDs de domínio e números de portas são expressos no formato decimal.
Os números de portas iniciam-se com 0.

v Endereço de Fibre Channel de dispositivo hexadecimal de 6 caracteres (hex)

v Nome no mundo inteiro de porta hexadecimal de 16 caracteres (PWWN)
para o dispositivo com o formato xx:xx:xx:xx:xx:xx:xx:xx.

rename [alias_old] [alias_new]
Renomeia o alias [alias_old] para o alias [alias_new].

10 BladeCenter Fibre Channel Switch Management: Guia do Usuário



Comando Config
Gerencia as configurações do Fibre Channel em uma chave. Para obter
informações sobre a configuração da porta e da chave, consulte “Comando Set
Config” na página 28.

Autoridade
Admin para todas as palavras-chave, exceto List

Sintaxe
config

activate [config]
backup
cancel
copy [config_source] [config_destination]
delete [config]
edit [config]
list
restore
save [config]

Palavras-chave
activate [config]

Ativa a configuração dada por [config]. Se a configuração for omitida, será
utilizada a configuração atualmente ativa. Apenas uma configuração pode estar
ativa por vez.

backup
Cria um arquivo denominado configdata, o qual contém informações sobre a
configuração. Para fazer download desse arquivo, abra a sessão FTP (File
Transfer Protocol), registre-se com o nome da conta images e senha images e
digite get configdata.

cancel
Encerra a sessão de edição de configuração atual sem salvar as alterações
feitas.

copy [config_source] [config_destination]
Copia a configuração dada por [config_source] para a configuração dada por
[config_destination]. A chave dá suporte para 10 configurações no máximo
incluindo a configuração padrão.

delete [config]
Exclui o arquivo de configuração especificado onde [config] é o nome do
arquivo.

edit [config]
Abre uma sessão de edição da configuração dada por [config]. Se o nome da
configuração for omitido, será utilizada a configuração atualmente ativa.

list
Exibe uma lista de todas as configurações disponíveis. Essa palavra-chave
está disponível com a autoridade de Usuário.

restore
Restaura as definições para uma chave fora da banda de um arquivo de
backup denominado configdata, o qual deve ser primeiramente transferido por
upload para a chave que estiver usando o FTP. O arquivo de backup é criado
com o comando Config Backup. Utilize o FTP para carregar o arquivo de
backup em uma chave e, em seguida, insira o comando Config Restore.
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save [config]
Salva as alterações feitas durante uma sessão de edição de configuração na
configuração dada por [config]. Se o valor do nome da configuração for omitido,
será usada a configuração que for escolhida para o comando Config Edit.

Notas
Se a configuração ativa for editada, as alterações serão suspensas até que a
configuração seja reativada ou que até que outra configuração seja ativada.

Exemplos
O exemplo a seguir mostra como abrir e fechar uma sessão de Edição de
Configuração.
FCSM: user1> admin start

FCSM (admin) : user1> config edit
.
.
.
FCSM (admin-config) : user1> config cancel

O modo Configuração será cancelado. Confirma (y/n): [n] y

FCSM (admin) : user1> admin end
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Comando Date
Exibe ou define a data e hora do servidor blade. Para definir a data e hora, é
necessário fornecer a cadeia de informações neste formato: MMDDhhmmCCYY,
onde MM = mês, DD = dia, hh = hora, mm = minuto, CC = século e YY = ano. É
necessário redefinir a chave para que a nova data tenha efeito.

Autoridade
Admin para alterar a data; usuário para exibir a data.

Sintaxe
date

[MMDDhhmmCCYY]

Palavras-chave
[MMDDhhmmCCYY]

Especifica a data – isto requer uma sessão admin. Se [MMDDhhmmCCYY] for
omitido, a data atual será exibida – isto está disponível com a autoridade de
Usuário.

Exemplos
É exibido a seguir um exemplo do comando Date.
FCSM: user1> date

Thu Sep 26 07:51:24 2002

Capítulo 2. CLI (Interface da Linha de Comandos) 13



Comando Fallback
Carrega a versão anterior do firmware da memória da chave. A chave armazena
duas versões do firmware. Esse comando ativa alternativamente as duas versões.

Autoridade
Admin

Sintaxe
fallback

Notas
v O comando Show Switch exibe as versões de firmware disponíveis e a versão

atualmente ativa.

v Após executar o comando Fallback, redefina a chave para efetivar o firmware.

Exemplos
É exibido a seguir um exemplo do comando Fallback.
FCSM: user1> admin start
FCSM (admin) : user1> fallback

Revertendo para imagem de software anterior. Confirma (y/n): [n] y
FCSM: user1> admin end
FCSM: user1>
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Comando Help
Exibe uma breve descrição do comando especificado e suas palavras-chave.

Autoridade
Usuário

Sintaxe
help

[command]
[keyword]

Palavras-chave
[command]

Um nome de comando. Se este valor for omitido, todos os comandos
disponíveis para escolha serão exibidos.

[keyword]
Uma palavra-chave associada ao comando denominado [command]. Se esse
valor for omitido, serão exibidas palavras-chave disponíveis do comando
especificado.

all Exibe uma lista de todos os comandos disponíveis (incluindo variações de
comandos).

Exemplos
É exibido a seguir um exemplo do comando Help Set.
FCSM: user1> help set

set SET_OPTIONS
Há muitos atributos que podem ser definidos.
Digite help com um dos seguintes comandos para obter mais informações:

set alarm
set beacon
set blade
set config blade
set config port
set config ports
set config switch
set config threshold
set config zoning
set log
set pagebreak
set port
set setup snmp
set setup system
set switch

É exibido a seguir um exemplo do comando Help Set Beacon.
FCSM: user1> help set beacon
set beacon On | Off
Esse comando faz piscar as luzes na frente da chave.
A opção On começa e a opção Off pára de piscar as luzes.
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Comando History
Exibe uma lista numerada dos comandos previamente inseridos dos quais é
possível reexecutar os comandos selecionados.

Autoridade
Usuário

Sintaxe
history

Notas
Use o comando history para fornecer contexto para o comando !.

v Insira ![comando] para inserir novamente a execução mais recente de tal
comando.

v Insira ![número da linha] para executar novamente o comando correspondente
da exibição History

v Insira ![cadeia de comando parcial] para executar novamente um comando que
corresponda à cadeia de comandos.

v Insira !! para executar novamente o comando mais recente.

Exemplos
É exibido a seguir um exemplo do comando History.
FCSM: user1> history

1 show switch
2 date
3 help set
4 history

FCSM: user1> !2
date

Thu Sep 26 11:03:07 2002
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Comando Image
Gerencia e instala o firmware de chaves.

Autoridade
Admin

Sintaxe
image

cleanup
fetch [account_name] [ip_address] [file_source] [file_destination]
list
unpack [file]

Palavras-chave
cleanup

Remove todos os arquivos firmware image da chave. Todos os arquivos
firmware image são automaticamente removidos cada vez que a chave é
redefinida.

fetch [account_name] [ip_address] [file_source] [file_destination]
Recupera o arquivo image dado por [file_source] e o armazena na chave com
o nome de arquivo dado por [file_destination]. O arquivo image é recuperado
do dispositivo com o endereço IP dado por [Ip_address] e um nome de conta
dado por [account_name]. Se um nome de conta necessitar de uma senha
para acessar o dispositivo, você será avisado disso.

list
Exibe a lista de arquivos image que residem na chave.

unpack [file]
Instala o arquivo firmware dado por [file]. Após descompactar o arquivo,
aparece uma mensagem confirmando que a descompactação foi
bem-sucedida. A chave deve ser redefinida para que o novo firmware tenha
efeito.
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Comando Lip (para Portas Externas Somente)
Reinicializa a porta loop especificada.

Autoridade
Admin

Sintaxe
lip

[port_number]

Palavras-chave
[port_number]

O número da porta a ser reinicializada.

Exemplos
É exibido a seguir um exemplo do comando Lip.
FCSM (admin) : user1> lip 2
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Comando Passwd
Altera a senha de uma conta do usuário.

Autoridade
Admin para alterar a senha de outra conta; usuário para alterar a própria senha.

Sintaxe
passwd

[account_name]

Palavras-chave
[account_name]

O nome da conta do usuário. É necessário abrir uma sessão admin para alterar
a senha de um nome de conta que não seja sua própria conta. Se
[account_name] for omitido, o prompt solicitará a alteração da senha do nome
da conta atual.

Exemplos
É exibido a seguir um exemplo do comando Passwd.
FCSM (admin) : user1> passwd user2

Pressione ’q’ e a tecla ENTER para interromper este comando.

senha OLD da conta :
senha NEW da conta (4 a 20 carac.) :

confirme senha NEW da conta:

a senha foi alterada.

Nota: Se você perder a senha da conta, entre em contato com o Suporte da IBM
(consulte o Apêndice B, “Obtendo Ajuda e Assistência Técnica”, na
página 139).
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Comando Ps
Exibe informações sobre o processo do servidor blade atual.

Autoridade
Usuário

Sintaxe
ps

Exemplos
É exibido a seguir um exemplo do comando Ps.
FCSM: user1> ps
PID PPID %CPU TIME ELAPSED COMMAND

341 329 0.0 00:00:00 2-00:58:29 cns
342 329 0.0 00:00:02 2-00:58:29 ens
343 329 0.0 00:00:27 2-00:58:29 dlog
344 329 1.3 00:40:39 2-00:58:29 ds
345 329 1.4 00:41:38 2-00:58:29 mgmtApp
346 329 0.0 00:00:06 2-00:58:29 fc2
347 329 0.5 00:16:35 2-00:58:29 nserver
348 329 0.4 00:12:20 2-00:58:29 mserver
349 329 3.6 01:47:29 2-00:58:29 util
350 329 0.0 00:00:36 2-00:58:29 snmpservicepath
351 329 0.5 00:15:24 2-00:58:29 eport
352 329 0.0 00:00:05 2-00:58:29 PortApp
361 329 0.0 00:00:08 2-00:58:28 port_mon
362 329 0.2 00:07:14 2-00:58:28 zoning
363 329 0.0 00:00:00 2-00:58:28 diagApp
385 329 0.0 00:00:02 2-00:58:18 snmpd
386 329 0.0 00:00:00 2-00:58:18 snmpmain
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Comando Quit
Fecha a sessão Telnet.

Autoridade
Usuário

Sintaxe
quit, exit ou logout
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Comando Reset
Redefine a chave e os parâmetros de configuração de porta.

Autoridade
Admin

Sintaxe
reset

config [config_name]
factory
port [port_number]
snmp
switch (default)
system
zoning

Palavras-chave
config [config_name]

Redefine a configuração dada por [config_name], para os valores padrão de
fábrica da chave, porta, limite de alarme e configuração de zoneamento. A
palavra-chave limpa todas as definições de zoneamento. Se [config_name] não
existir na chave, será criada uma configuração com tal nome. Se [config_name]
for omitido, a configuração ativa será redefinida. Será necessário ativar a
configuração ou redefinir a chave para que as alterações tenham efeito.
Consulte da Tabela 2 na página 23 a Tabela 4 na página 24.

factory
Restabelece as definições de configuração de chave, limite de alarme, porta,
SNMP, configuração de zoneamento e servidor blade para os valores padrão
de fábrica. A configuração de chave é ativada automaticamente. Consulte da
Tabela 2 na página 23 a Tabela 6 na página 24.

port [port_number]
Reinicializa a porta dada por [port_number]. As portas são numeradas
iniciando-se com 0. Para obter mais informações, consulte a Tabela 37 na
página 137.

snmp
Restabelece as definições de configuração do SNMP para os valores padrão
de fábrica. Consulte os valores padrão de configuração do SNMP na Tabela 5
na página 24.

switch
Reinicializa a chave. Este é o padrão. Este comando também fecha a sessão
Telnet.

system
Restabelece as definições de configuração do servidor blade para os valores
padrão de fábrica. Consulte a Tabela 6 na página 24 para obter os valores
padrão de configuração.

zoning
Limpa o banco de dados de zoneamento e desativa o conjunto de zonas ativo.
Os valores de configuração de zoneamento permanecem inalterados.
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Notas
As tabelas a seguir especificam as várias definições de padrão de fábrica.

Tabela 2. Padrões de Configuração de Chave

Parâmetro Padrão

Admin State Online

Broadcast Enabled True

Inband Enable True

Domain ID 1

Domain ID Lock False

Symbolic Name Fibre Channel Switch Module

R_T_TOV 100

R_A_TOV 10000

E_D_TOV 2000

FS_TOV 5000

DS_TOV 5000

Principal Priority 254

System Description IBM BladeCenter 2-Port Fibre Channel
Switch Module

Configuration Last Saved By Inicial

Configuration Last Saved On Inicial

Tabela 3. Padrões de Configuração de Porta

Parâmetro Padrão de porta externa
(0,15)

Padrão de porta interna
(1-14)

Admin State Online Online

Link Speed Auto 2 Gbps

Port Type GL F

TL_Port Mode TLTargetMode TLTargetMode

ISL Security Any Any

Symbolic Name Port0 ou Port15 Port1 – Port14

ALFairness False False

ARB_FF False False

InteropCredit 0 0

ExtCredit 0 0

FanEnable True True

LCFEnable False False

MFSEnable True True

MFS_TOV 10 10

MSEnable True True

NoClose False False

IOStreamGuard False False

VIEnable False False

CheckAlps False False
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Tabela 4. Padrões de Configuração de Limite

Parâmetro Padrão

ThresholdMonitoringEnabled True

CRCErrorsMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
25
1
10

DecodeErrorsMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
200
0
10

ISLMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
2
0
10

LoginMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
5
1
10

LogoutMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
5
1
10

LOSMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
100
5
10

Tabela 5. Padrões de Configuração de SNMP

Parâmetro Padrão

Contact Indefinido

Location Indefinida

Description Indefinida

Trap [1] Address 10.0.0.1

Trap [2-5] Address 0.0.0.0

Trap [1-5] Port 162

Trap [1-5] Severity Aviso

Trap [1-5] Enabled False

ObjectID 1.3.6.1.4.1.1663.1.1.1.1.16

AuthFailureTrap False

Tabela 6. Padrões de Configuração de Sistema

Parâmetro Padrão

Ethernet Network IP Address Compartimento do módulo de chaves 3:
192.168.70.129

Compartimento do módulo de chaves 4:
192.168.70.130
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Tabela 6. Padrões de Configuração de Sistema (continuação)

Parâmetro Padrão

Ethernet Network IP Mask 255.255.255.0

Ethernet Gateway Address 10.90.90.254

Ethernet Network Discovery Estático

Admin Timeout 30 minutos

Security Enabled False

Local Log Enabled True

Remote Log Enabled False

Remote Log Host IP Address 10.0.0.254
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Comando Set
Define vários parâmetros de porta e de chave.

Autoridade
Admin para todas as palavras-chave exceto Alarm Clear, Beacon e Pagebreak que
estão disponíveis com a autoridade de Usuário.

Sintaxe
set

alarm clear
beacon [state]
config [option]
log [option]
pagebreak [state]
port [option]
setup [option]
switch [state]

Palavras-chave
alarm clear

Limpa o log de alarme. Esta palavra-chave está disponível com a autoridade de
Usuário.

beacon [state]
Ativa ou desativa o flash dos LEDs da Porta com Logging de acordo com
[state]. Esta palavra-chave está disponível com a autoridade de Usuário. [state]
pode ser um dos seguintes:

On
Ativa o beacon piscante.

Off
Desativa o beacon piscante.

config [option]
Define parâmetros de configuração de porta, chave, limite de alarme e
zoneamento. Consulte “Comando Set Config” na página 28.

log [option]
Especifica o tipo de entrada a ser inserida no caso de um registro de eventos.
Consulte “Comando Set Log” na página 34.

pagebreak [state]
Especifica a quantidade de informações exibidas por vez na tela de acordo
com o valor dado por [state]. Essa palavra-chave está disponível com a
autoridade de Usuário. [state] pode ser um dos seguintes:

on
Limita a exibição de informações a 20 linhas por vez.

off
Permite a exibição contínua de informações sem interrupções.

port [option]
Define temporariamente o estado e a velocidade da porta especificada até a
próxima redefinição de chave ou ativação de nova configuração. Consulte
“Comando Set Port” na página 37.
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setup [option]
Altera as definições de configuração de SNMP e do servidor blade. Consulte
“Comando Set Setup” na página 39.

switch [state]
Altera temporariamente o estado administrativo de todas as portas na chave
para o estado dado por [state]. As definições anteriores de Set Config Switch
são restauradas após uma redefinição de chave ou uma reativação de
configuração de chave. [state] pode ser um dos seguintes:

Online
Coloca todas as portas online

Offline
Coloca todas as portas offline

Diagnóstico
Prepara todas as portas para teste.
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Comando Set Config
Define os parâmetros de configuração de porta, chave, limite de alarme e
zoneamento.

Autoridade
Autoridade Admin e uma sessão Config Edit. Consulte “Comando Config” na
página 11 para obter informações sobre como iniciar uma sessão Config Edit.

Sintaxe
set config

port [port_number]
ports [port_number]
switch
threshold
zoning

Palavras-chave
port [port number]

Inicia uma sessão de edição para alterar os parâmetros de configuração do
número de porta dado por [port_number]. Se [port_number] for omitido, a
unidade BladeCenter iniciará pela porta 0 e continuará ordenadamente até a
porta 15. Em cada parâmetro, insira um valor novo ou pressione a tecla Enter
para aceitar o valor atual mostrado entre colchetes. Digite q para cancelar a
configuração de uma porta ou qq para cancelar a configuração de todas as
portas. A Tabela 7 descreve os parâmetros da porta.

Nota: Para portas externas (0,15), são aplicados todos os parâmetros de
porta. Para portas internas, apenas a definição do estado de porta é
configurável. Para obter informações sobre numeração e mapeamento
de portas, consulte a Tabela 37 na página 137.

ports [port number]
Inicia uma sessão de edição para alterar os parâmetros de configuração de
todas as portas com base na configuração da porta dada por [port_number]. Se
[port_number] for omitido, será usada a porta 0. Em cada parâmetro, digite um
novo valor ou pressione a tecla Enter para aceitar o valor atual mostrado entre
colchetes. Digite q para cancelar a configuração. A Tabela 7 descreve os
parâmetros de porta. Nas portas externas (0,15), todos os parâmetros são
aplicados. Em portas internas (de 1 a 14) é aplicado apenas o AdminState.

Tabela 7. Parâmetros Set Config da Porta

Parâmetro Descrição

AdminState Estado administrativo da porta: online,
offline, diagnostics ou down.

LinkSpeed 1 Gbps ou 2 Gbps

PortType Tipo de porta

TLPortMode Inicia a configuração de atributos de portas
externas. Indica se deve ser usado um
iniciador ou dispositivos de destino no loop.
Se [port_number] for especificado, a exibição
apresentará atributos apenas daquela porta;
caso contrário, todos os atributos de todas
as portas estarão disponíveis para
configuração.
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Tabela 7. Parâmetros Set Config da Porta (continuação)

Parâmetro Descrição

ISLSecurity Segurança E_Port. Determina as chaves
com as quais a porta estabelecerá vínculos.

v Qualquer - Estabelecerá vínculo com
qualquer chave.

v Nossa - Estabelecerá vínculo somente
com outro módulo de chaves do
BladeCenter Fibre Channel.

v Nenhuma - A porta não estabelecerá um
vínculo ISL.

SymbolicPortName Nome descritivo

ALFairness Padrão é a chave que tem prioridade

ARB_FF Use ARB_FF em vez de inativos na opção
FCAL loop

InteropCredit Número de créditos de buffer a buffer por
porta. 0 significa que o padrão (12) não é
alterado.

ExtCredit Porta de crédito estendido

FANEnable Notificação de Endereço de Malha. Se
ativado, notifica NL_Ports com loggin do
endereço, nome de porta e nome de nó
FL_Port.

LCFEnable Preferência de quadro de controle de link,
R_CTL = 0xC

MFSEnable Pacote de seqüência multiquadros

MFS_TOV Limite MFS para camp on

MSEnable Servidor de Gerenciamento ativado nesta
porta

NoClose Não feche a menos que outro dispositivo o
exija

I/O Stream Guard Ativa ou desativa a supressão de RSCN
(registered State Change Notification)

VIEnable Não aplicável

CheckAlps Feche antes de enviar quadros a um novo
destino

switch
Inicia uma sessão de edição para alterar definições de configuração. Cada
parâmetro é exibido, uma linha por vez e é solicitado um valor. Em cada
parâmetro, insira um valor novo ou pressione a tecla Enter para aceitar o valor
atual mostrado entre colchetes. Digite q para cancelar a configuração.

Tabela 8. Parâmetros Set Config de Chave

Parâmetro Descrição

AdminState Estado administrativo da chave: online, offline ou
diagnóstico.

Broadcast Enable Ativa (True) ou desativa (False) o envio de
quadros de difusão.
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Tabela 8. Parâmetros Set Config de Chave (continuação)

Parâmetro Descrição

InbandEnabled Ativa (True) ou desativa (False) a capacidade
para gerenciar a chave em um ISL.

DefaultDomainID Definição de ID de domínio padrão.

DomainIDLock Impede (True) ou permite (False) a reatribuição
dinâmica do ID de domínio.

SymbolicName Nome descritivo

R_T_TOV Valor de Tempo Limite do Receptor Transmissor.
Especifica o número de milissegundos que uma
porta deve esperar para receber uma resposta de
outra porta. O padrão é 100.

R_A_TOV Valor de Tempo Limite de Alocação de Recursos.
O número de milissegundos que a chave espera
para permitir que duas portas aloquem recursos
suficientes para estabelecer um vínculo. O padrão
é 10.000.

E_D_TOV Valor de Tempo Limite de Detecção de Erro.
Especifica o número de milissegundos que uma
porta deve esperar para limpar erros. O padrão é
2.000 ms.

FS_TOV Valor de Tempo Limite de Estabilidade da Malha.
O padrão é 5.000 ms.

DS_TOV Valor de Tempo Limite de Serviços Distribuídos
(Servidor de Gerenciamento, Servidor de Nomes).
O padrão é 5.000 ms.

PrincipalPriority A prioridade usada no algoritmo de seleção de
chave principal FC-SW-2. 1 é alto, 255 é baixo.

ConfigDescription O nome da configuração. O padrão é indefinido.

threshold
Inicia uma sessão de configuração com a qual são gerados e registrados
alarmes de eventos selecionados. Cada evento, seus limites e intervalo de
amostragem são exibidos, uma linha por vez, e você é solicitado a fornecer um
valor. Em cada parâmetro, digite um novo valor ou pressione a tecla Enter para
aceitar o valor atual mostrado entre colchetes. Esses parâmetros devem ser
salvos em uma configuração e ativados antes de se tornarem efetivos.
Consulte “Comando Config” na página 11 para obter informações sobre como
salvar e ativar uma configuração. A Tabela 9 descreve os parâmetros de limite
Set Config.

Tabela 9. Parâmetros de Limite Set Config

Parâmetro Descrição

Threshold Monitoring Enabled Parâmetro ativar/desativar principal de todos
os eventos. Ativa (True) ou desativa (False)
a geração de todos os alarmes de eventos
ativados.
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Tabela 9. Parâmetros de Limite Set Config (continuação)

Parâmetro Descrição

CRCErrorsMonitoringEnabled
DecodeErrorsMonitoringEnabled
ISLMonitoringEnabled
LoginMonitoringEnabled
LogoutMonitoringEnabled
LOSMonitoringEnabled

O parâmetro ativar/desativar tipo de evento.
Ativa (True) ou desativa (False) a geração
de alarmes de cada um dos seguintes
eventos:
v Erros CRC
v Erros Decode
v Contagem de conexão ISL
v Erros de Login
v Erros de Logout
v Erros de Perda de sinal

Rising Trigger A contagem de eventos acima da qual é
registrado um evento. Quando a contagem
excede o limite superior, é registrado um
alarme. A chave não irá gerar outro alarme
para esse evento até que a contagem caia
abaixo do limite inferior e suba novamente
acima do limite superior.

Falling Trigger A contagem de evento acima da qual um
evento qualifica-se para efetuar login no log
de alarme.

Sample Window O período de tempo em segundos durante o
qual os eventos são contados.

zoning
Inicia uma sessão de edição para alterar os atributos de zoneamento da chave.
Cada parâmetro é exibido, uma linha por vez e é solicitado um valor. Em cada
parâmetro, insira um novo valor ou pressione a tecla Enter para aceitar o valor
atual mostrado entre colchetes.

Tabela 10. Parâmetros de Zoneamento Set Config

Parâmetro Descrição

AutoSave Determina se as alterações de zoneamento
serão salvas na memória flash (não volátil)
(On) ou na memória RAM (volátil) (Off). O
padrão é On.

Default Determina a comunicação entre
portas/dispositivos na ausência de um
conjunto de zonas ativo. “All” ativa todas as
portas/dispositivos para comunicarem entre
si. “None” proíbe a comunicação entre
portas/dispositivos.

Exemplos
É exibido a seguir um exemplo do comando Set Config Port.
FCSM: user1> admin start
FCSM (admin) : user1> config edit
FCSM (admin-config) : user1> set config port 0

Segue-se uma lista de atributos com valores atuais e de formatação.
Insira um valor novo ou simplesmente pressione a tecla ENTER para
aceitar o valor atual.
Se desejar terminar esse processo antes de atingir o fim da lista
pressione ’q’ ou ’Q’ e a tecla ENTER para tal.
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Configurando o Número da Porta: 0
------------------------

AdminState (1=Online, 2=Offline, 3=Diagnostics, 4=Down) [Online ]
LinkSpeed (1=1Gb/s, 2=2Gb/s, 3=Auto) [Auto ]
PortType (TL / GL / G / F / FL / Donor) [GL ]
TLPortMode (1=TLTargetMode, 2=TLInitiatorMode) [TLTargetMode]
ISLSecurity (Qualquer / Nosso / Nenhum) [Any ]
SymPortName (cadeia, máx=32 carac.) [Port0 ]
ALFairness (True / False) [False ]
ARB_FF (True / False) [False ]
InteropCredit (valor decimal, 0-255) [0 ]
ExtCredit (valor dec, aumentos de 11, apenas não-loop) [0 ]
FANEnable (True / False) [True ]
LCFEnable (True / False) [False ]
MFSEnable (True / False) [True ]
MFS_TOV (valor decimal, 10-20480 ms) [10 ]
MSEnable (True / False) [True ]
NoClose (True / False) [False ]
IOStreamGuard (Enable / Desable) [Disabled ]
VIEnable (True / False) [False ]
CheckAlps (True / False) [False ]

Configuração de atributos concluída.
Essa configuração deve ser salva (consulte o comando config save) e
ativada (consulte o comando config activate) para torná-la efetiva.
Para descartar essa configuração, use o comando config cancel.

É exibido a seguir um exemplo do comando Set Config Switch.
FCSM: user1> admin start
FCSM (admin) : user1> config edit
FCSM (admin-config) : user1> set config switch

Segue-se uma lista de atributos com valores atuais e de formatação.
Insira um valor novo ou simplesmente pressione a tecla ENTER para
aceitar o valor atual.
Se desejar terminar esse processo antes de atingir o fim da lista
pressione ’q’ ou ’Q’ e a tecla ENTER para tal.

AdminState (1=Online, 2=Offline, 3=Diagnostics) [Online]
BroadcastEnabled (True / False) [True]
InbandEnabled (True / False) [True]
DefaultDomainID (valor decimal, 1-239) [1]
DomainIDLock (True / False) [False]
SymbolicName (cadeia, máx=32 carac.) [Fibre Channel

Switch Module]
R_T_TOV (valor decimal, 1-1000 ms) [100]
R_A_TOV (valor decimal, 100-100000 ms) [10000]
E_D_TOV (valor decimal, 10-20000 ms) [2000]
FS_TOV (valor decimal, 100-100000 ms) [5000]
DS_TOV (valor decimal, 100-100000 ms) [5000]
PrincipalPriority (valor decimal, 1-255) [254]
ConfigDescription (cadeia, máx=64 caracteres) [IBM BladeCenter(TM)

2-port Fibre Channel
Switch Module]

Configuração de atributos concluída.
Essa configuração deve ser salva (consulte o comando config save) e
ativada (consulte o comando config activate) para torná-la efetiva.
Para descartar essa configuração, use o comando config cancel.

É exibido a seguir um exemplo do comando Set Config Threshold.
FCSM (admin-config) : user1> set config threshold

Segue-se uma lista de atributos com valores atuais e de formatação.
Insira um valor novo ou simplesmente pressione a tecla ENTER para
aceitar o valor atual.
Se desejar terminar esse processo antes de atingir o fim da lista
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pressione ’q’ ou ’Q’ e a tecla ENTER para tal.
ThresholdMonitoringEnabled (True / False) [False]

CRCErrorsMonitoringEnabled (True / False) [False]
RisingTrigger (valor decimal, 1-1000) [25 ]
FallingTrigger (valor decimal, 0-1000) [1 ]
SampleWindow (valor decimal, 1-1000 seg) [10 ]

DecodeErrorsMonitoringEnabled (True / False) [True ]
RisingTrigger (valor decimal, 1-1000) [200 ]
FallingTrigger (valor decimal, 0-1000) [0 ]
SampleWindow (valor decimal, 1-1000 seg) [10 ]

ISLMonitoringEnabled (True / False) [True ]
RisingTrigger (valor decimal, 1-1000) [2 ]
FallingTrigger (valor decimal, 0-1000) [0 ]
SampleWindow (valor decimal, 1-1000 seg) [10 ]

LoginMonitoringEnabled (True / False) [True ]
RisingTrigger (valor decimal, 1-1000) [5 ]
FallingTrigger (valor decimal, 0-1000) [1 ]
SampleWindow (valor decimal, 1-1000 seg) [10 ]

LogoutMonitoringEnabled (True / False) [True ]
RisingTrigger (valor decimal, 1-1000) [5 ]
FallingTrigger (valor decimal, 0-1000) [1 ]
SampleWindow (valor decimal, 1-1000 seg) [10 ]

LOSMonitoringEnabled (True / False) [True ]
RisingTrigger (valor decimal, 1-1000) [100 ]
FallingTrigger (valor decimal, 0-1000) [5 ]
SampleWindow (valor decimal, 1-1000 seg) [10 ]

É exibido a seguir um exemplo do comando Set Config Zoning.
FCSM: user1> admin start
FCSM (admin) : user1> config edit
FCSM (admin-config) : user1> set config zoning

Segue-se uma lista de atributos com valores atuais e de formatação.
Insira um valor novo ou simplesmente pressione a tecla ENTER para
aceitar o valor atual.
Se desejar terminar esse processo antes de atingir o fim da lista
pressione ’q’ ou ’Q’ e a tecla ENTER para tal.

AutoSave (True / False) [True]
Default (All / None) [All ]

Configuração de atributos concluída.
Essa configuração deve ser salva (consulte o comando config save) e
ativada (consulte o comando config activate) para torná-la efetiva.
Para descartar essa configuração, use o comando config cancel.
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Comando Set Log
Especifica o tipo de entradas a serem inseridas em um registro de eventos. O log é
um arquivo de armazenamento contido na chave. O log pode conter 200 entradas
no máximo. Quando o log fica cheio, as entradas são substituídas a partir da
entrada mais antiga, para produzir uma lista dos últimos 200 eventos ocorridos. As
entradas de log são criadas para níveis de gravidade de portas, componentes e
eventos.

Autoridade
Admin

Sintaxe
set log

archive
clear
component [list]
level [level]
port [port_list]
restore
save
start (default)
stop

Palavras-chave
archive

Arquiva as entradas de log em um arquivo na chave denominada logfile que
pode ser transferido da chave por download através do FTP. Para transferir o
arquivo de log por download, abra uma sessão FTP, efetue login com um nome
de conta images e senha images e digite get logfile.

clear
Limpa todas as entradas de log.

component [list]
Especifica um ou mais componentes cujos eventos devem ser monitorados.
Use espaços para delimitar os valores na lista. Use um ou mais dos seguinte
valores:

All
Monitora todos os componentes. Para manter o desempenho otimizado da
chave, não utilize essa definição com a palavra-chave Level definida como
Info.

Blade
Não aplicável

Chassis
Não aplicável

Eport
Monitora todas as E_Ports.

Mgmtserver
Monitora o status do servidor de gerenciamento.

Nameserver
Monitora o status do servidor de nomes.

None
Não monitora nenhum dos eventos do componente.
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Other
Monitora outros eventos variados.

Port
Monitora todos os eventos de portas.

Switch
Monitora eventos de gerenciamento de chaves.

Zoning
Monitora eventos de conflito de zoneamento.

level [level]
Especifica o nível de gravidade dado por [level] para ser usado na monitoração
de eventos de componentes ou de portas especificados. [level] pode ser um
dos seguintes valores:

Critical
Monitora eventos críticos.

Warn
Monitora eventos de aviso.

Info
Monitora eventos informativos. Para manter o desempenho otimizado da
chave, não utilize essa definição com a palavra-chave Component definida
para All.

None
Não monitora nível de gravidade algum.

port [port_list]
Especifica uma ou mais portas cujos eventos devem ser monitorados. Use um
dos seguinte valores:

[port_list]
Especifica a porta ou as portas a monitorar. Use espaços para delimitar os
valores na lista. Os números de portas iniciam-se com 0.

All
Especifica todas as portas.

None
Desativa a monitoração em todas as portas.

restore
Retorna as definições de porta, componente e nível aos valores padrão.

save
Salva as definições de log de componente, nível e porta. Essas definições
permanecem em vigor após uma redefinição de chave. As definições de log
podem ser exibidas com o comando Show Log Settings. Para exportar as
entradas de log para um arquivo, utilize o comando Set Log Archive.

start
Inicia o registro de eventos com base nas palavras-chave Port, Component e
Level atribuídas à configuração atual. O registro continua até o comando Set
Log Stop ser inserido.

stop
Pára o registro de eventos.
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Notas
Para manter o desempenho otimizado da chave, não defina a palavra-chave
Component para All e a palavra-chave Level para Info ao mesmo tempo.
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Comando Set Port
Define temporariamente o estado e a velocidade da porta especificada até a
próxima redefinição de chave ou ativação de nova configuração. Este comando
também limpa os contadores de porta. Para obter informações sobre numeração e
mapeamento de portas, consulte a Tabela 37 na página 137.

Nota: Para portas externas (0,15), são aplicados todos os parâmetros de porta.
Em portas internas, apenas a definição do estado de porta é configurável.

Autoridade
Admin

Sintaxe
set port [port_number]

bypass [alpa] (somente para portas externas)
clear
enable [alpa] (somente para portas externas)
speed [transmission_speed]
state [state]

Palavras-chave
[port_number]

Especifica a porta. As portas são numeradas iniciando-se com 0. Para obter
informações sobre numeração e mapeamento de portas, consulte a Tabela 37
na página 137.

bypass [alpa]
Envia um LPB (Loop Port Bypass) para um ALPA (Arbitrated Loop Physical
Address) ou para todos os ALPAs no loop arbitrário. [alpa] pode ser um ALPA
específico ou a palavra-chave ALL para escolher todos os ALPAs.

clear
Limpa os contadores na porta especificada.

enable [alpa]
Envia um LPE (Loop Port Enable) para todos os ALPAs no loop arbitrário.
[alpa] pode ser um ALPA específico ou a palavra-chave ALL para escolher
todos os ALPAs.

speed [transmission_speed]
Determina a velocidade de transmissão da porta especificada. Use um dos
seguintes valores de velocidade de porta:

1Gbps
Um gigabit por segundo.

2Gbps
Dois gigabits por segundo.

Auto
A velocidade da porta é detectada automaticamente.

state [state]
Determina o estado administrativo da porta especificada. Use um dos seguintes
valores de estado de porta:

Online
Coloca a porta online.
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Offline
Coloca a porta offline.

Diagnostics
Prepara a porta para teste.

Down
Desativa a porta.
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Comando Set Setup
Altera as definições da configuração SNMP e do servidor blade. A chave mantém
uma configuração SNMP e uma configuração.

Autoridade
Admin

Sintaxe
set setup

snmp

system

Palavras-chave
snmp

Avisa-o, linha por linha, para alterar as definições de configuração SNMP. A
Tabela 11 descreve os campos SNMP. Em cada parâmetro, digite um novo
valor ou pressione a tecla Enter para aceitar o valor atual mostrado entre
colchetes.

Tabela 11. Definições de Configuração SNMP

Entrada Descrição

Contact Especifica o nome da pessoa de contato que responde pelos
eventos trap. O padrão é Indefinido.

Location Especifica o nome da localização da chave. O padrão é
Indefinido.

Trap [1-5] Address Especifica o endereço IP ao qual são enviados os traps SNMP.

Trap [1-5] Port Especifica a porta à qual são enviados os traps SNMP.

Trap [1-5] Severity Especifica o nível de gravidade usado ao monitorar eventos trap.
O padrão é Warning.

Trap [1-5] Enabled Especifica se os traps (informações sobre eventos) são ativados
ou desativados (padrão).

ReadCommunity Autenticação Read Community. Um campo somente leitura; o
valor na chave e no servidor de gerenciamento SNMP deve ser
o mesmo.

WriteCommunity Autenticação Write Community. Um campo somente gravação; o
valor na chave e no servidor de gerenciamento SNMP deve ser
o mesmo.

TrapCommunity Autenticação Trap Community. Um campo somente gravação; o
valor na chave e no servidor de gerenciamento SNMP deve ser
o mesmo.

AuthFailureTrap Especifica o endereço IP para onde é enviada uma notificação
no caso de uma falha de autenticação.

system
Avisa-o, linha por linha, para alterar as definições de configuração do servidor
blade. A Tabela 12 na página 40 descreve os campos de configuração do
sistema. Em cada parâmetro, digite um novo valor ou pressione a tecla Enter
para aceitar o valor atual mostrado entre colchetes.
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Tabela 12. Definições de Configuração do Sistema

Entrada Descrição

Eth0NetworkAddress Endereço IP (Internet Protocol) Ethernet

Eth0NetworkMask Endereço de máscara de sub-rede Ethernet da porta Ethernet.

Eth0GatewayIPAddress Gateway do endereço IP Ethernet

Eth0NetworkDiscovery Método de reinicialização Ethernet (1 - Estático).
Nota: BootP, DHCP e RARP não são aplicáveis

AdminTimeout Especifica o tempo em minutos que a chave espera antes de
encerrar uma sessão Admin inativa. Zero (0) desativa o limite de
tempo limite. O padrão é 30; o máximo é 1440.

Security Enabled Ativa ou desativa a aplicação de nomes de contas e senhas.

Remote Log Enabled Se o log remoto for ativado ou desativado. Se ativado, as
informações sobre o log são salvas em um host remoto que
suporta o protocolo syslog.

RemoteLogHost IP
Address

O endereço IP do host que receberá as informações de log
remoto se o log remoto estiver ativado.

Notas
Os dois componentes de segurança são a autenticação do usuário e a segurança
de malha. O usuário deve ser autenticado antes de obter acesso a uma chave. Se
for inserida uma combinação de nome de conta/senha inválida, esse usuário não
poderá acessar a chave e, portanto, não obterá acesso à malha. Se a segurança
estiver ativada (True) e uma combinação de nome de conta/senha válida for
inserida, esse usuário poderá acessar a chave mas não poderá executar comandos
que excedam seu nível de autoridade (privilégios). Se a segurança estiver
desativada (False) e uma combinação de nome de conta/senha válida for inserida,
esse usuário terá acesso a todas as chaves na malha e poderá executar todos os
comandos (tanto usuário como admin), independentemente de seu nível de
autoridade (privilégios).

Exemplos
É exibido a seguir um exemplo do comando Set Setup SNMP.
FCSM: user1> admin start
FCSM (admin) : user1> set setup snmp

Segue-se uma lista de atributos com valores atuais e de formatação.
Insira um valor novo ou simplesmente pressione a tecla ENTER para
aceitar o valor atual.
Se desejar terminar esse processo antes de atingir o fim da lista
pressione ’q’ ou ’Q’ e a tecla ENTER para tal.

Opções de Gravidade de Trap
---------------------
unknown, emergency, alert, critical, error, warning, notify, info, debug, mark

Contact (cadeia, máx=32 carac.) [<sysContact undefined> ]
Location (cadeia, máx=32 carac.) [<sysLocation undefined>]
Trap1Address (End IP c/notação de pontos) [10.0.0.1 ]
Trap1Port (valor decimal) [162 ]
Trap1Severity (v. opções permitidas acima) [warning ]
Trap1Enabled (True / False) [False ]
Trap2Address (End IP c/notação de pontos) [0.0.0.0 ]
Trap2Port (valor decimal) [162 ]
Trap2Severity (v. opções permitidas acima) [warning ]
Trap2Enabled (True / False) [False ]
Trap3Address (End IP c/notação de pontos) [0.0.0.0 ]
Trap3Port (valor decimal) [162 ]
Trap3Severity (v. opções permitidas acima) [warning ]
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Trap3Enabled (True / False) [False ]
Trap4Address (End IP c/notação de pontos) [0.0.0.0 ]
Trap4Port (valor decimal) [162 ]
Trap4Severity (v. opções permitidas acima) [warning ]
Trap4Enabled (True / False) [False ]
Trap5Address (End IP c/notação de pontos) [0.0.0.0 ]
Trap5Port (valor decimal) [162 ]
Trap5Severity (v. opções permitidas acima) [warning ]
Trap5Enabled (True / False) [False ]
ReadCommunity (cadeia, máx=32 carac.) [public ]
WriteCommunity (cadeia, máx=32 carac.) [private ]
TrapCommunity (cadeia, máx=32 carac.) [public ]
AuthFailureTrap (True / False) [False ]

Deseja salvar e ativar esta configuração snmp? (y/n): [n]

É exibido a seguir um exemplo do comando Set Setup System.
FCSM: user1> admin start
FCSM (admin) : user1> set setup system

Segue-se uma lista de atributos com valores atuais e de formatação.
Insira um valor novo ou simplesmente pressione a tecla ENTER para
aceitar o valor atual.
Se desejar terminar esse processo antes de atingir o fim da lista
pressione ’q’ ou ’Q’ e a tecla ENTER para tal.

Eth0NetworkAddress (End IP c/notação de pontos) [10.90.10.93 ]
Eth0NetworkMask (End IP c/notação de pontos) [255.255.252.0]
Eth0GatewayAddress (End IP c/notação de pontos) [10.20.8.254 ]
Eth0NetworkDiscovery (1=Static, 2=Bootp, 3=Dhcp, 4=Rarp) [Static ]
AdminTimeout (valor dec 0-1440 minutos, 0=nunca) [30 ]
SecurityEnabled (True / False) [False ]
LocalLogEnabled (True / False) [True ]
RemoteLogEnabled (True / False) [False ]
RemoteLogHostAddress (End IP c/notação de pontos) [10.0.0.254 ]

Deseja salvar e ativar esta configuração do sistema? (y/n): [n]

Capítulo 2. CLI (Interface da Linha de Comandos) 41



Comando Show
Exibe informações operacionais sobre a malha, chave e porta.

Autoridade
Usuário

Sintaxe
show

about

alarm

broadcast

chassis

config [option]

domains

donor

fabric

interface

log [option]

lsdb

mem [count]

ns [option]

pagebreak

perf [option]

port [port_number]

post log

setup [option]

steering [domain_id]

support

switch

topology

users

version

Palavras-chave
about

Exibe um conjunto introdutório de informações sobre os atributos operacionais
da chave . Essa palavra-chave é equivalente à palavra-chave Version.

alarm
Exibe as 200 últimas entradas de alarme.

broadcast
Exibe informações sobre a árvore de difusão e sobre todas as portas que
atualmente estão transmitindo e recebendo quadros de difusão.

chassis
Não aplicável

config [option]
Exibe os atributos de configuração de chave e de porta. Para obter mais
informações, consulte “Comando Show Config” na página 49.
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domains
Exibe uma lista de cada domínio e seu nome no mundo inteiro, na malha.

donor
Exibe uma lista da configuração donor atual de todas as portas.

fabric
Exibe uma lista de cada domínio, ID de malha, nome no mundo inteiro,
endereço IP do nó, endereço IP da porta e nome simbólico na malha.

interface
Exibe o status das interfaces de rede ativas.

log [option]
Exibe as entradas de log. Consulte “Comando Show Log” na página 51.

lsdb
Exibe informações sobre o banco de dados Link State.

mem [count]
Exibe informações sobre a atividade de memória do número de segundos dado
por [count]. Se [count] for omitido, será usado o valor 1. Os valores de memória
exibidos estão em unidades de 1 KB.

Nota: Essa palavra-chave exibirá as atualizações de atividade de memória até
que [count] seja atingida; ela não pode ser interrompida. Sendo assim,
evite usar valores grandes para [count].

ns [option]
Exibe informações sobre o servidor de nomes para a [option] especificada. Se
[option] for omitida, serão exibidas as informações sobre o servidor de nomes
do ID de domínio local. [option] pode ter os seguintes valores:

all Exibe informações sobre o servidor de nomes para todas as chaves e
portas.

[domain_id]
Exibe informações sobre o servidor de nomes para a chave dada por
[domain_id]. [domain_id] é um ID de domínio de chave.

[port_id]
Exibe informações sobre o servidor de nomes para a porta dada por
[port_id]. [port_id] é um endereço de Fibre Channel de porta.

pagebreak
Exibe a definição de quebra de página atual. A definição de quebra de página
limita a exibição de informação a 20 linhas (On) ou permite a exibição contínua
de informações sem quebra (Off).

perf [option]
Exibe informações sobre o desempenho de todas as portas. Consulte
“Comando Show Perf” na página 53.

port [port_number]
Exibe informações operacionais sobre a porta dada por [port_number]. As
portas são numeradas iniciando com 0. Se o número de porta for omitido,
serão exibidas informações sobre todas as portas.Tabela 13 na página 44
descreve os parâmetros de porta. Para obter informações sobre numeração e
mapeamento de portas, consulte Tabela 37 na página 137.

Nota: Nas portas externas (0,15), todos os parâmetros são aplicados. Em
portas internas (de 1 a 14) é aplicado apenas o AdminState.

Capítulo 2. CLI (Interface da Linha de Comandos) 43



Tabela 13. Parâmetros Show Port

Entry Descrição

AIinit Incrementada a cada vez que a porta começa a inicialização AL.

AIinitError Número de vezes em que porta começou a inicializar e a
inicialização falhou.

ClassXFramesIn Número de quadros de classe x recebidos por esta porta.

ClassXFramesOut Numero de quadros de classe x enviados por esta porta.

ClassXWordsIn Número de palavras de classe x recebidas por esta porta.

ClassXWordsOut Número de palavras de classe x enviadas por esta porta.

DecodeError Erro de decodificação detectado.

EpConnects Número de vezes em que uma E_Port é conectada através de
negociação ISL.

FBusy Número de vezes em que a chave enviou um F_BSY porque o
quadro de Classe 2 não pôde ser entregue dentro do tempo
ED_TOV. Número de quadros (F_BSY) ocupados, de classe 2 e
de classe 3, gerados por esta porta em resposta a quadros de
recebimento. Geralmente isso indica uma condição de ocupado
na malha ou em N_port, o que está impedindo a entrega deste
quadro.

Flowerrors Quadro recebido quando não havia créditos disponíveis.

FReject Número de quadros de dispositivos que foram rejeitados.

InvalidCRC CRC inválido detectado.

InvalidDestAddr Endereço de destino inválido detectado.

LIP ALPD ALPS Número de reinicializações de F7, AL_PS LIPs ou AL_PD
(específicos do fornecedor), executadas.

LIPF7ALPS Esse LIP é usado para reinicializar o loop. Uma L_port,
identificada como AL_PS, pode ter detectado uma degradação
de desempenho e está tentando restaurar o loop.

LIPF8ALPS Esse LIP exprime uma falha de loop detectada por L_port
identificada como AL_PS.

LIPF7F7 Um quadro primitivo de inicialização usado para adquirir um
AL_PA válido.

LIPF8F7 Um quadro primitivo de inicialização de loop usado para indicar
que foi detectada uma falha de loop no receptor.

Link Failures Número de falhas de links óticos detectadas por essa porta.
Uma falha de link é uma perda de sincronização durante um
período de tempo maior que o valor de R_T_TOV ou por perda
de sinal durante um estado não offline. Uma perda de sinal faz a
chave tentar restabelecer o link. Se o link não for restabelecido
durante o tempo especificado por R_T_TOV, é contada uma
falha de link. Após uma falha de link, é executada uma
reinicialização do link.

Login Hora em que o usuário efetuou login.

Logout Hora em que o usuário efetuou logout.

LoopTimeouts Um tempo limite de 2 segundos conforme especificado por
FC-AL-2.

LossOfSync Número de perdas de sincronização (>100 ms) detectadas por
esta porta. Uma perda de sincronização é detectada pelo
recebimento de uma palavra de transmissão inválida.
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Tabela 13. Parâmetros Show Port (continuação)

Entry Descrição

PrimSeqErrors Erros de seqüência primitiva detectados.

RxLinkResets Número de reinicializações de links primitivos recebidos do
dispositivo conectado.

RxOfflineSeq Número de seqüências offline recebidas. É emitido um OLS para
a inicialização do link, para Receber e Reconhecer um estado
NOS (Not_Operational) ou para informar um estado offline.

TotalErrors Número total de erros detectados.

TotalLIPsRecvd Número de quadros primitivos de inicialização de loop recebidos
por esta porta.

TotalLinkResets Número total de reinicializações primitivas de link.

TotalOfflineSeq Número total de Seqüências Offline emitidas por essa porta.

TotalRxFrames Número total de quadros recebidos por essa porta.

TotalRxWords Número total de palavras recebidas por essa porta.

TotalTxFrames Número total de quadros emitidos por essa porta.

TotalTxWords Número total de palavras emitidas por essa porta.

TxLinkResets Número de Reinicializações de Link emitidas por essa porta.

TxOfflineSeq Número total de Seqüências Offline emitidas por essa porta.

TxWait Tempo de espera para transmitir quando bloqueado sem
créditos. Medido em tempos FC Word.

post log
Exibe o log POST que contém resultados do POST.

setup [option]
Exibe os atributos de configuração do sistema, SNMP e do fabricante da
chave. Consulte “Comando Show Setup” na página 55.

steering [domain_id]
Exibe as rotas que os dados percorrem até a chave dada por [domain_id]. Se
[domain_id] for omitido, o sistema exibirá as rotas de todas as chaves na
malha.

support
Executa vários comandos que exibem uma descrição completa da chave, sua
configuração e operação. A exibição pode ser capturada na tela e usada para
fazer diagnóstico de problemas. Essa palavra-chave é indicada para ser usada
a pedido de seu provedor de manutenção autorizado. São executados os
seguintes comandos:

v Date

v Alias List

v Config List

v Date

v History

v Ps

v Show (About, Alarm, Backtrace, Chassis, Config Port, Config Switch, Dev,
Dev Settings, Domains, Donor, Fabric, Log, Log Settings, Lsdb, Mem, Ns,
Perf, Port, Setup Mfg, Setup Snmp, Setup System, Steering, Switch,
Topology, Users)
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v Uptime

v User Accounts

v Whoami

v Zoneset (Active, List)

v Zoning (History, Limits, List)

switch
Exibe informações operacionais sobre a chave.

topology
Exibe todos os dispositivos conectados.

users
Exibe uma lista de usuários registrados. É equivalente ao comando User List.

version
Exibe um conjunto introdutório de informações sobre os atributos operacionais
da chave. Essa palavra-chave é equivalente à palavra-chave About.

Exemplos
É exibido a seguir um exemplo do comando Show Setup SNMP.
FCSM: user1> show setup snmp

Informações sobre SNMP
----------------
Contact <sysContact undefined>
Location <sysLocation undefined>
Description IBM BladeCenter(TM) 2-port Fibre Channel Switch Module
Trap1Address 10.0.0.1
Trap1Port 162
Trap1Severity warning
Trap1Enabled False
Trap2Address 0.0.0.0
Trap2Port 162
Trap2Severity warning
Trap2Enabled False
Trap3Address 0.0.0.0
Trap3Port 162
Trap3Severity warning
Trap3Enabled False
Trap4Address 0.0.0.0
Trap4Port 162
Trap4Severity warning
Trap4Enabled False
Trap5Address 0.0.0.0
Trap5Port 162
Trap5Severity warning
Trap5Enabled False
ObjectID 1.3.6.1.4.1.1663.1.1.1.1.16
AuthFailureTrap False

É exibido a seguir um exemplo do comando Show Topology.
FCSM: user1> show topology
Chave de ID Exclusiva

-------------
A = ALPA, D = Domain ID, P = Port ID

Loc Local Rem Remote Unique
Port Type PortWWN Type NodeWWN ID
---- ---- ------- ---- ------- ------
Ext:15 E 20:0f:00:c0:dd:00:90:fb E 10:00:00:c0:dd:00:90:d74 (0x4) D

É exibido a seguir um exemplo do comando Show Topology (para a Porta #15).
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FCSM: user1> show topology 15
Informações sobre Link Local

----------------------

Port Ext2:15
PortID 020f00
PortWWN 20:0f:00:c0:dd:00:90:fb
PortType E

Informações sobre Link Remoto
-----------------------

Chave Remota

PortNumber 10
DomainID 04
NodeWWN 10:00:00:c0:dd:00:90:d7
PortType E
Description Switch
IPAddress 10.0.0.3

É exibido a seguir um exemplo do comando Show Port.
FCSM: user1> show port 0

Número de Porta: 0
------------
AdminState Online PortID 640000
AsicNumber 0 PortWWN 20:00:00:c0:dd:00:91:03
AsicPort 0 RunningType E
ConfigType GL SFPPartNumber FTRJ-8519-3-2.5
DiagStatus Transmitido SFPRevision X1
EpConnState Conectado SFPType 100-M5-SN-I
EpIsoReason Não Aplicável SFPVendor FINISAR CORP.
LinkSpeed 2Gb/s SFPVendorID 00659000
LinkState Ativo SymbolicName Port0
LoginStatus Registrado SyncStatus SyncAcquired
MaxCredit 12 XmitterEnabled True
OperationalState Online
ALInit 11 FlowErrors 0 PrimSeqErrors 0
ALInitError 1 FReject 0 RxLinkResets 0
Class2FramesIn 0 InvalidCRC 0 RxOfflineSeq 0
Class2FramesOut 0 InvalidDestAddr 0 TotalErrors 1
Class2WordsIn 0 LIP_AL_PD_AL_PS 0 TotalLIPsRecvd 15
Class2WordsOut 0 LIP_F7_AL_PS 0 TotalLinkResets 0
Class3FramesIn 0 LIP_F7_F7 15 TotalOfflineSeq 0
Class3FramesOut 0 LIP_F8_AL_PS 0 TotalRxFrames 0
Class3Toss 0 LIP_F8_F7 0 TotalRxWords 0
Class3WordsIn 0 LinkFailures 0 TotalTxFrames 0
Class3WordsOut 0 Login 7 TotalTxWords 0
DecodeErrors 0 Logout 6 TxLinkResets 0
EpConnects 7 LoopTimeouts 0 TxOfflineSeq 0
FBusy 0 LossOfSync 1 TxWaits 0

É exibido a seguir um exemplo do comando Show Switch.
FCSM: user1> show switch
Informações sobre a Chave
------------------
SymbolicName Fibre Channel Switch Module
SwitchWWN 10:00:00:c0:dd:00:91:03
SwitchType BladeCenter
PROMVersion V1.4.0.1-0 (Thu Sep 12 17:46:41 2002)
CreditPool 0
DomainID 1 (0x1)
FirstPortAddress 010000
FlashSize - MBytes 128
LogLevel Critical
MaxPorts 16
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NumberOfResets 14
ReasonForLastReset NormalReset
SWImageVersion (1) - build date V1.4.0.18-3 (Thu Sep 19 03:55:16 2002)
SWImageVersion (2) - build date V1.4.0.19-1 (Fri Sep 20 03:56:20 2002)
ActiveConfiguration padrão
ActiveSWImage 2
AdminState Online
AdminModeActive False
BeaconOnStatus False
OperationalState Online
PrincipalSwitchRole True
BoardTemp (1) - Degrees Celsius 50
BoardTemp (2) - Degrees Celsius 50
SwitchDiagnosticsStatus Passed
SwitchTemperatureStatus Normal
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Comando Show Config
Exibe atributos de porta, chave, limite de alarme e zoneamento da configuração
atual.

Autoridade
Usuário

Sintaxe
show config

port [port_number]

switch

threshold

zoning

Palavras-chave
port [port_number]

Exibe os parâmetros de configuração do número da porta dado por
[port_number]. As portas são numeradas iniciando com 0. Se o valor da porta
for omitido, todas as portas serão especificadas.

Nota: Nas portas externas (0,15), todos os parâmetros são aplicados. Em
portas internas (de 1 a 14) é aplicado apenas o AdminState. Para obter
informações sobre numeração e mapeamento de portas, consulte
Tabela 37 na página 137.

switch
Exibe os parâmetros de configuração da chave.

threshold
Exibe os parâmetros de configuração do limite de alarme da chave.

zoning
Exibe os parâmetros de configuração de zoneamento da chave.

Exemplos
É exibido a seguir um exemplo do comando Show Config Port.
FCSM: user1> show config port 15

Nome da Configuração: lei
-------------------
Número de Porta: 15
------------
AdminState Online
LinkSpeed Auto
PortType GL
TLPortMode TLTargetMode
ISLSecurity Any
SymbolicName Port15
ALFairness False
ARB_FF False
InteropCredit 0
ExtCredit 0
FANEnable True
LCFEnable False
MFSEnable True
MFS_TOV 10
MSEnable True
NoClose False
IOStreamGuard Disabled
VIEnable False
CheckAlps False
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É exibido a seguir um exemplo do comando Show Config Switch.
FCSM: user1> show config switch

Nome da Configuração: lei
-------------------
Informações sobre a Configuração da Chave
--------------------------------
AdminState Online
BroadcastEnabled True
InbandEnabled True
DomainID 1 (0x1)
DomainIDLock False
SymbolicName Fibre Channel Switch Module
R_T_TOV 100
R_A_TOV 10000
E_D_TOV 2000
FS_TOV 5000
DS_TOV 5000
PrincipalPriority 254
ConfigDescription IBM BladeCenter(TM) 2-port Fibre Channel Switch Module
ConfigLastSavedBy Initial
ConfigLastSavedOn Initial

É exibido a seguir um exemplo do comando Show Config Threshold.
FCSM: user1> show config threshold

Nome da Configuração: padrão
-------------------

Informações sobre a Configuração do Limite
-----------------------------------
ThresholdMonitoringEnabled True
CRCErrorsMonitoringEnabled True

RisingTrigger 25
FallingTrigger 1
SampleWindow 10

DecodeErrorsMonitoringEnabled True
RisingTrigger 200
FallingTrigger 0
SampleWindow 10

ISLMonitoringEnabled True
RisingTrigger 2
FallingTrigger 0
SampleWindow 10

LoginMonitoringEnabled True
RisingTrigger 5
FallingTrigger 1
SampleWindow 10

LogoutMonitoringEnabled True
RisingTrigger 5
FallingTrigger 1
SampleWindow 10

LOSMonitoringEnabled True
RisingTrigger 100
FallingTrigger 5
SampleWindow 10

É exibido a seguir um exemplo do comando Show Config Zoning.
FCSM: user1> show config zoning

Nome da Configuração: padrão
-------------------
Informações sobre a Configuração do Zoneamento
--------------------------------
AutoSave True
Default All
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Comando Show Log
Exibe o conteúdo do log ou os parâmetros usados para criar entradas no log. O log
contém 200 entradas no máximo. Quando o log atinge sua capacidade de
entradas, as entradas subseqüentes sobrescrevem as entradas existentes,
iniciando com a mais antiga.

Autoridade
Usuário

Sintaxe
show log

component

level

options

port

settings

Palavras-chave
component

Exibe os componentes de eventos monitorados atualmente.

level
Exibe o nível de gravidade do evento necessário para criar uma entrada no log.
Se o nível de gravidade ocorrer em uma porta ou em um componente não
definido, não serão efetuadas entradas no log.

options
Exibe as opções usadas para definir os atributos do componente e do nível de
log.

port
Exibe as portas de eventos em monitoração. Se ocorrer um evento com o nível
definido em um componente também definido mas não em uma porta definida,
não serão efetuadas entradas no log.

settings
Exibe as definições atuais de component, level e port. Esse comando é
equivalente à execução dos seguintes comandos separadamente: Show Log
Component, Show Log Level e Show Log Port.

Exemplos
É exibido a seguir um exemplo do comando Show Log.
FCSM: user1> show log component

Definição(ões) atual(is) do componente do log: NameServer

É exibido a seguir um exemplo do comando Show Log Level.
FCSM: user1> show log level

Definições atuais do log
------------------------
nível Crítico

É exibido a seguir um exemplo do comando Show Log Options.
FCSM: user1> show log options

Opções permitidas para ’level’: Critical,Warn,Info,None

Opções permitidas para ’component’: All,None,NameServer,MgmtServer,Zoning,Switch,
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Chassis,Blade,Port,Eport,Snmp,Other

Definição(ões) atual(is) da porta do log: 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

É exibido a seguir um exemplo do comando Show Log.
[327][Wed Jan 25 09:36:54.860 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Eport
State = E_A0_GET_DOMAIN_ID]

[328][Wed Jan 25 09:36:54.860 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][FSPF
PortUp state=0]

[329][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send
ing init hello]

[330][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Proc
essing EFP, oxid= 0x8]

[331][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Epor
t State = E_A2_IDLE]

[332][Wed Jan 25 09:36:54.861 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][EFP,
WWN= 0x100000c0dd00b845, len= 0x30]

[333][Wed Jan 25 09:36:54.864 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send
ing LSU oxid= 0xc: type= 1]

[334][Wed Jan 25 09:36:54.864 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send
Zone Merge Request]

[335][Wed Jan 25 09:36:54.865 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][LSDB
Xchg timer set]

[336][Wed Jan 25 09:36:54.865 1989][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Sett
ing attribute Oper.UserPort.0.8.EpConnState Connected]
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Comando Show Perf
Exibe o desempenho da porta em quadros por segundo e bytes por segundo. Se a
palavra-chave for omitida, o comando exibirá os dados transmitidos (out), os dados
recebidos (in) e o total de dados transmitidos e recebidos em quadros por segundo
e bytes por segundo.

Autoridade
Usuário

Sintaxe
show perf

byte

inbyte

outbyte

frame

inframe

outframe

errors

Palavras-chave
byte

Exibe continuamente dados sobre o desempenho em total de bytes por
segundo transmitidos e recebidos em todas as portas. Digite q e pressione a
tecla Enter para parar a exibição.

inbyte
Exibe continuamente dados sobre o desempenho em total de bytes por
segundo recebidos em todas as portas. Digite q e pressione a tecla Enter para
parar a exibição.

outbyte [port_number]
Exibe continuamente dados sobre o desempenho em total de bytes por
segundo transmitidos em todas as portas. Digite q e pressione a tecla Enter
para parar a exibição.

frame [port_number]
Exibe continuamente dados sobre o desempenho em total de quadros por
segundo transmitidos e recebidos em todas as portas. Digite q e pressione a
tecla Enter para parar a exibição.

inframe [port_number]
Exibe continuamente dados sobre o desempenho em total de quadros por
segundo recebidos em todas as portas. Digite q e pressione a tecla Enter para
parar a exibição.

outframe [port_number]
Exibe continuamente dados sobre o desempenho em total de quadros por
segundo transmitidos em todas as portas. Digite q e pressione a tecla Enter
para parar a exibição.

errors [port_number]
Exibe continuamente contagens de erros de todas as portas. Digite q e
pressione a tecla Enter para parar a exibição.

Exemplos
É exibido a seguir um exemplo do comando Show Perf.
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FCSM: user1>: show perf

Bytes/s Bytes/s Bytes/s Quadros/s Quadros/s Quadros/s
Port (in) (out) (total) (in) (out) (total)
---- ------- ------- ------- -------- -------- --------
Ext1:0 0 0 0 0 0 0
Ext2:15 0 0 0 0 0 0

Bay1 0 0 0 0 0 0
Bay2 0 0 0 0 0 0
Bay3 0 0 0 0 0 0
Bay4 0 0 0 0 0 0
Bay5 0 0 0 0 0 0
Bay6 0 0 0 0 0 0
Bay7 0 0 0 0 0 0
Bay8 0 0 0 0 0 0
Bay9 0 0 0 0 0 0
Bay10 0 0 0 0 0 0
Bay11 0 0 0 0 0 0
Bay12 0 0 0 0 0 0
Bay13 0 0 0 0 0 0
Bay14 0 0 0 0 0 0
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Comando Show Setup
Exibe as definições atuais de SNMP e de sistema.

Autoridade
Usuário

Sintaxe
show setup

mfg

snmp

system

Palavras-chave
mfg

Exibe as informações sobre a chave do fabricante.

snmp
Exibe as definições atuais de SNMP.

system
Exibe as definições atuais de sistema.

Exemplos
É exibido a seguir um exemplo do comando Show Setup Mfg.
FCSM: user1> show setup mfg
Informações do Fabricante

-------------------------
BoardSerialNumber P9
BrandName IBM
BuildDate Unknown
ChassisPartNumber Unknown
ChassisSerialNumber P9
MACAddress 00:c0:dd:00:91:02
PlanarPartNumber Unknown
SwitchSymbolicName Fibre Channel Switch Module
SwitchWWN 10:00:00:c0:dd:00:91:03
SystemDescription IBM BladeCenter(TM) 2-port Fibre Channel Switch Module
SystemObjectID 1.3.6.1.4.1.1663.1.1.1.1.16

É exibido a seguir um exemplo do comando Show Setup Snmp.
FCSM: user1> show setup snmp

Informações sobre SNMP
----------------
Contact <sysContact undefined>
Location <sysLocation undefined>
Description IBM BladeCenter(TM) 2-port Fibre Channel Switch Module
Trap1Address 10.0.0.254
Trap1Port 162
Trap1Severity warning
Trap1Enabled False
Trap2Address 0.0.0.0
Trap2Port 162
Trap2Severity warning
Trap2Enabled False
Trap3Address 0.0.0.0
Trap3Port 162
Trap3Severity warning
Trap3Enabled False
Trap4Address 0.0.0.0
Trap4Port 162
Trap4Severity warning
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Trap4Enabled False
Trap5Address 0.0.0.0
Trap5Port 162
Trap5Severity warning
Trap5Enabled False
ObjectID 1.3.6.1.4.1.1663.1.1.1.1.16
AuthFailureTrap False

É exibido a seguir um exemplo do comando Show Setup System.
FCSM: user1> show setup system
Informações sobre Sistema

------------------
Eth0NetworkAddress 10.20.8.188
Eth0NetworkMask 255.255.252.0
Eth0GatewayAddress 10.20.8.254
Eth0NetworkDiscovery Static
AdminTimeout 30
SecurityEnabled False
LocalLogEnabled True
RemoteLogEnabled False
RemoteLogHostAddress 10.0.0.254

56 BladeCenter Fibre Channel Switch Management: Guia do Usuário



Comando Shutdown
Encerra todas as transferências de dados na chave em pontos convenientes e
fecha a sessão Telnet. Sempre efetue um ciclo de energia da chave após inserir
este comando.

Autoridade
Admin

Sintaxe
shutdown

Notas
Sempre efetue este comando para fazer um encerramento ordenado antes de
remover a energia da chave. Caso contrário, a memória flash e a configuração da
chave poderão ser danificadas.
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Comando Test
Testa as portas do módulo de chaves usando testes internos (nível SerDes),
externos SFP (Small Form-Factor Pluggable) e loopback online. Os testes internos
e externos requerem que a porta do módulo de chaves esteja em modo de
diagnóstico. Consulte “Comando Set Port” na página 37 para obter informações
sobre a alteração do estado administrativo das portas. Enquanto o teste estiver em
execução, as outras portas na chave permanecerão totalmente operacionais.
Consulte a seção “Teste de Porta” na página 128 para obter mais informações.

Autoridade
Admin

Sintaxe
test

port [port_number] [test_type]

cancel

status

Palavras-chave
port [port_number] [test_type]

Testa a porta dada por [port_number] usando o teste dado por [test_type]. Se
[test_type] for omitido, será usado o Interno. [test_type] pode ter os seguintes
valores:

Interno (para portas internas e externas)
Teste do SerDes. Esse é o padrão. A porta deve estar no modo diagnóstico
para executar esse teste.

Externo (somente para portas externas)
Testa ambos SerDes e SFP. A porta deve estar no modo diagnóstico para
executar esse teste e um plugue loopback deve ser instalado no SFP.

Online (para portas internas e externas)
Testa a porta online.

cancel
Cancela o teste online em andamento.

status
Exibe o status de um teste em andamento, ou se não houver teste em
andamento, o status do último teste executado.

Exemplos
Para executar testes de porta Internos (SerDes) ou Externos (SFP), execute as
seguintes etapas:

1. Para iniciar uma sessão admin, digite o seguinte comando:
admin start

2. Coloque a porta no modo diagnóstico, digitando o seguinte comando (x =
número da porta):
set port x state diagnostics

3. Insira o plugue loopback no SFP da porta selecionada (somente para teste de
porta externa).

4. Escolha um dos dois tipos de testes loopback de porta para executar:

v Para executar um teste de loopback interno, digite o seguinte comando:
test x internal
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v Para executar um teste de loopback externo, digite o seguinte comando.
Deve ser instalado um plugue de loopback para transmitir esse teste.
test x external

Nota: O teste de loopback externo pode ser executado apenas em portas de
módulo de chaves externas.

Após escolher o tipo de teste e executar o comando, aparecerá uma
mensagem na tela detalhando os resultados do teste.

5. Após a execução do teste, coloque a porta de volta no estado online, digitando
o seguinte comando (x = número da porta):
set port x state online

6. Para verificar se a porta está online novamente, digite o comando a seguir. O
conteúdo do campo AdminState deve estar Online.
show port x

O teste online nó-a-nó pode testar apenas uma porta por vez, e tal porta deverá
estar online e conectada a um dispositivo externo ou a uma placa de expansão
Fibre Channel do servidor blade. Para executar o teste nó-a-nó online, execute as
seguintes etapas:

1. Para iniciar uma sessão admin, digite o seguinte comando:
admin start

2. Para executar o teste nó-a-nó online, digite o seguinte comando:
test x online

São exibidos vários parâmetros de teste na tela.

3. Pressione a tecla Enter para aceitar cada valor de parâmetro padrão ou digite
um novo valor para cada parâmetro e pressione a tecla Enter. O parâmetro
TestLength é o número de quadros enviados, o parâmetro FrameSize (256
bytes no máximo em alguns casos) é o número de bytes em cada quadro e o
parâmetro DataPattern é o padrão na carga útil. Antes de executar o teste,
certifique-se de que o dispositivo conectado à porta pode identificar os
parâmetros de teste.
FCSM (admin) : user1> test x online

Segue-se uma lista de atributos com valores atuais e de formatação.
Insira um valor novo ou simplesmente pressione a tecla ENTER para
aceitar o valor atual. Se desejar encerrar esse processo antes de atingir
o fim da lista, pressione ’q’ ou ’Q’ e a tecla ENTER para tal.

TestLength (valor decimal, 1-4294967295) [100 ]
FrameSize (valor decimal, 36-2148) [256 ]
DataPattern (valor 32-bit hex ou ’Default’) [Default]
StopOnError (True/False) [False ]

Deseja iniciar o teste? (y/n) [n]

4. Após definir todos os parâmetros, pressione a tecla Y para iniciar o teste.
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Comando Uptime
Exibe o tempo decorrido desde que a chave foi redefinida pela última vez e seu
método de reinicialização.

Autoridade
Usuário

Sintaxe
uptime

Exemplos
É exibido a seguir um exemplo do comando Uptime.
FCSM: user1> uptime

Elapsed up time : 0 day(s), 2 hour(s), 28 min(s), 44 sec(s)
Reason last reset: NormalReset
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Comando User
Administra ou exibe contas do usuário.

Autoridade
Admin. A palavra-chave List fica disponível com a autoridade de Usuário.

Sintaxe
user

accounts

add

delete [account_name]

list

Palavras-chave
accounts

Exibe todas as contas do usuário que existem na chave.

add
Adiciona uma conta do usuário na chave. Após a execução desse comando o
administrador será solicitado a fornecer as informações necessárias para
estabelecer a conta do usuário. Uma chave pode ter no máximo 15 contas. Os
nomes de contas são limitados a 15 caracteres; as senhas a 31 caracteres.

delete [account_name]
Exclui o nome da conta dado por [account_name] da chave.

list
Exibe a lista de usuários atualmente registrados e seus números de sessão.
Executa a mesma função do comando Show Users. Essa palavra-chave é
válida para a autoridade de Usuário e não requer uma sessão admin.

Exemplos
É exibido a seguir um exemplo do comando User Accounts.
FCSM (admin) : user1> user accounts

Lista atual de contas de usuário
-----------------------------
images (autoridade admin = False)
admin (autoridade admin = True)
USERID (autoridade admin = True)

É exibido a seguir um exemplo do comando User Add.
FCSM (admin) : user1> user add

Pressione ’q’ e a tecla ENTER para interromper esse comando.

nome da conta (1-15 carac.) : user3
senha da conta (4-20 carac.) :

confirme a senha da conta:
essa conta deve ter autoridade admin? (y/n) [n] : y
Está OK adicionar a conta de usuário ’user3’ com autoridade admin?
Confirme (y/n): [n] y

É exibido a seguir um exemplo do comando User Delete.
FCSM (admin) : user1> user del user3

A conta do usuário será excluída. Confirme (y/n): [n] y

É exibido a seguir um exemplo do comando User List.
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FCSM (admin) : user1> user list
Lista atual de usuário registrados
-------------------------------
admin@OB-session1 - no modo admin
admin@OB-session2
user1@OB-session3
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Comando Whoami
Exibe o nome da conta, o número de sessão e o ID de domínio da chave da
sessão Telnet.

Autoridade
Usuário

Sintaxe
whoami

Exemplos
É exibido a seguir um exemplo do comando Whoami.
FCSM: user1> whoami

Nome de usuário : admin@OB-session3
Nome da chave : Fibre Channel Switch Module
ID de domínio da chave : 100 (0x64)
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Comando Zone
Gerencia as zonas e a associação de zonas em uma chave. O comando Zone
define membros (portas e dispositivos) de uma única chave. As zonas são
membros de conjuntos de zonas.

Autoridade
Autoridade admin e uma sessão de Edição de Zoneamento. Consulte “Comando
Zoning” na página 69 para obter informações sobre como iniciar uma sessão de
Edição de Zoneamento. As palavras-chave List, Members e Zonesets estão
disponíveis com a autoridade de Usuário e não requerem uma sessão de Edição
de Zoneamento.

Sintaxe
zone

add [zone] [members]
copy [zone_source] [zone_destination]
create [zone]
delete [zone]
list
members [zone]
remove [zone] [members]
rename [zone_old] [zone_new]
type [zone] [zone_type]
zonesets [zone]

Palavras-chave
add [zone] [members]

Especifica uma ou mais portas dadas por [members] para adicionar à zona
denominada [zone]. Uma zona pode ter no máximo 256 membros. [members]
pode ter um dos seguintes formatos:

v Par de ID de domínio com número de porta (ID de domínio, número da
porta). Os IDs de domínio e os números de portas são expressos no formato
decimal. Os números de portas iniciam-se com 0.

v Endereço de Fibre Channel de dispositivo hexadecimal de 6 caracteres (hex)

v Nome no mundo inteiro de porta hexadecimal de 16 caracteres (PWWN)
com o formato xx:xx:xx:xx:xx:xx:xx:xx.

v Nome do alias

O aplicativo verifica se o formato [zone] está correto mas não valida a
existência de tal porta.

copy [zone_source] [zone_destination]
Cria uma nova zona denominada [zone_destination] e nela copia a associação
com base na zona dada por [zone_source].

create [zone]
Cria uma zona com o nome dado por [zone]. Um nome de zona deve iniciar
com uma letra e não pode ter mais que 64 caracteres. Os caracteres válidos
são 0 9, A a Z, a a z, &, _, e -. O banco de dados de zoneamento suporta 256
zonas no máximo.

delete [zone]
Exclui a zona especificada dada por [zone] do banco de dados de zoneamento.
Se a zona for um membro do conjunto de zonas ativo, a zona não será
removida do conjunto de zonas ativo até que o mesmo conjunto seja
desativado.
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list
Exibe uma lista de todas as zonas e os conjuntos de zonas dos quais são
membros. Essa palavra-chave é válida para a autoridade de Usuário e não
requer uma sessão de edição de zoneamento.

members [zone]
Exibe todos os membros da zona dada por [zone]. Essa palavra-chave é válida
para a autoridade de Usuário e não requer uma sessão de Edição de
Zoneamento.

remove [zone] [members]
Remove as portas dadas por [members] da zona dada por [zone]. [members]
pode ter um dos seguintes formatos:

v Par de ID de domínio com número de porta (ID de Domínio, Número da
Porta). Os IDs de domínio e números de portas são expressos no formato
decimal. Os números de portas iniciam-se com 0.

v Endereço de Fibre Channel de dispositivo hexadecimal de 6 caracteres (hex)

v Nome no mundo inteiro de porta hexadecimal de 16 caracteres (PWWN)
com o formato xx:xx:xx:xx:xx:xx:xx:xx.

v Nome do alias

rename [zone_old] [zone_new]
Renomeia a zona dada por [zone_old] para a zona dada por [zone_new].

type [zone] [zone_type]
Especifica o tipo de zona dado por [zone_type] ao qual será atribuído o nome
de zona dado por [zone]. Se [zone_type] for omitido, o sistema exibirá o tipo da
zona dada por [zone]. [zone_type] pode ser um dos seguintes:

soft
Zona do servidor de nomes

hardacl
Zona compacta de lista de controle de acesso

hardvpf
Zona compacta de malha privada virtual

zonesets [zone]
Exibe todos os conjuntos de zonas dos quais a zona dada por [zone] é um
membro. Essa palavra-chave está disponível com a autoridade de Usuário e
não requer uma sessão de Edição de Zoneamento.

Exemplos
É exibido a seguir um exemplo do comando Zone List.
FCSM: user1> zone list

Zona ZoneSet
-------------------
wwn_b0241f

zone_set_1

wwn_23bd31
zone_set_1

wwn_221416
zone_set_1

wwn_2215c3
zone_set_1

wwn_0160ed
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zone_set_1

wwn_c001b0
zone_set_1

wwn_401248
zone_set_1

wwn_02402f
zone_set_1

wwn_22412f
zone_set_1

É exibido a seguir um exemplo do comando Zone Members.
FCSM: user1> zone members wwn_b0241f

Lista Atual de Membros da Zona: wwn_b0241f
---------------------------------
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
21:00:00:e0:8b:02:41:2f

É exibido a seguir um exemplo do comando Zone Zonesets.
FCSM: user1> zone zonesets zone1

Lista Atual de ZoneSets da Zona: wwn_b0241f
----------------------------------
zone_set_1
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Comando Zoneset
Gerencia conjuntos de zonas e associações de conjuntos de zonas em toda a
malha.

Autoridade
Autoridade admin e uma sessão de Edição de Zoneamento. Consulte “Comando
Zoning” na página 69 para obter informações sobre como iniciar uma sessão de
Edição de Zoneamento. As palavras-chave Active, List e Zones estão disponíveis
com a autoridade de Usuário. É necessário fechar a sessão de Edição de
Zoneamento antes de usar as palavras-chave Activate e Deactivate.

Sintaxe
zoneset

activate [zone_set]
active
add [zone_set] [zone_list]
copy [zone_set_source] [zone_set_destination]
create [zone_set]
deactivate
delete [zone_set]
list
remove [zone_set] [zone_list]
rename [zone_set_old] [zone_set_new]
zones [zone_set]

Palavras-chave
activate [zone_set]

Ativa o conjunto de zonas dado por [zone_set]. Essa palavra-chave desativa o
conjunto de zonas ativo. Feche a sessão de Edição de Zoneamento antes de
usar essa palavra-chave.

active
Exibe o nome do conjunto de zonas ativo. Essa palavra-chave está disponível
com a autoridade de Usuário e não requer uma sessão de Edição de
Zoneamento.

add [zone_set] [zone_list]
Adiciona uma lista de zonas e de aliases dados por [zone_list] ao conjunto de
zonas dado por [zone_set]. Os nomes de zonas e de aliases são delimitados
por espaços na [zone_list]. Essa palavra-chave requer uma sessão de Edição
de Zoneamento.

copy [zone_set_source] [zone_set_destination]
Cria uma zona nova denominada [zone_set_destination] e nela copia a
associação do conjunto de zonas dado por [zone_set_source]. Essa
palavra-chave requer uma sessão de Edição de Zoneamento.

create [zone_set]
Cria o conjunto de zonas com o nome dado por [zone_set]. Um nome de
conjunto de zonas deve começar com uma letra e não ter mais que 64
caracteres. Os caracteres válidos são 0 a 9, A a Z, a a z, &, _, e -. Essa
palavra-chave requer uma sessão de Edição de Zoneamento. O banco de
dados de zoneamento suporta 256 conjuntos de zonas no máximo.

deactivate
Desativa o conjunto de zonas ativo. Feche a sessão de Edição de Zoneamento
antes de usar essa palavra-chave.

Capítulo 2. CLI (Interface da Linha de Comandos) 67



delete [zone_set]
Exclui o conjunto de zonas dado por [zone_set]. Se o conjunto de zonas
especificado estiver ativo, o comando será suspenso até o conjunto de zonas
ser desativado. Essa palavra-chave requer uma sessão de Edição de
Zoneamento.

list
Exibe uma lista de todos os conjuntos de zonas. Essa palavra-chave está
disponível com a autoridade de Usuário e não requer uma sessão de Edição
de Zoneamento.

remove [zone_set] [zone_list]
Remove uma lista de zonas e de aliases dados por [zone_list] do conjunto de
zonas dado por [zone_set]. Os nomes de zonas e de aliases são delimitados
por espaços na [zone_list]. Se [zone_set] for o conjunto de zonas ativo, a zona
não será removida até que o conjunto de zonas seja desativado. Essa
palavra-chave requer uma sessão de Edição de Zoneamento.

rename [zone_set_old] [zone_set_new]
Renomeia o conjunto de zonas dado por [zone_set_old] para o nome dado por
[zone_set_new]. O conjunto de zonas ativo pode ser renomeado. Essa
palavra-chave requer uma sessão de Edição de Zoneamento.

zones [zone_set]
Exibe todas as zonas que são membros do conjunto de zonas dado por
[zone_set]. Essa palavra-chave está disponível com a autoridade de Usuário e
não requer uma sessão de Edição de Zoneamento.

Notas
v Uma zona deve estar ativa para que suas definições sejam aplicadas à malha.

v Apenas um conjunto de zonas pode estar ativo por vez.

v Uma zona pode ser membro de mais de um conjunto de zonas.

Exemplos
É exibido a seguir um exemplo do comando Zoneset Active.
FCSM: user1> zoneset active

O ZoneSet ativo é: Beta

É exibido a seguir um exemplo do comando Zoneset List.
FCSM: user1> zoneset list

Lista Atual de ZoneSets
------------------------
alpha
beta

É exibido a seguir um exemplo do comando Zoneset Zones.
FCSM: user1> zoneset zones ssss

Lista Atual de Zonas de ZoneSet: ssss
----------------------------------
zone1
zone2
zone3
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Comando Zoning
Abre uma sessão de Edição de Zoneamento na qual os conjuntos de zonas e as
zonas são criados e gerenciados. Consulte “Comando Zone” na página 64” e
“Comando Zoneset” na página 67” para obter informações sobre o gerenciamento
de zonas e de conjuntos de zonas.

Autoridade
Admin. A palavra-chave List está disponível com a autoridade de Usuário.

Sintaxe
zoning

active
cancel
clear
edit
history
limits
list
restore
save

Palavras-chave
active

Exibe informações sobre a associação da do conjunto de zonas ativo incluindo
as zonas-membro e os membros de zonas.

cancel
Fecha a sessão de Edição de Zoneamento atual. São perdidas todas as
alterações não salvas.

clear
Limpa todos os conjuntos de zonas inativos da cópia de edição volátil do banco
de dados de zoneamento. Essa palavra-chave não afeta o banco de dados de
zoneamento não volátil. No entanto, se o comando Zoning Clear for inserido
seguido pelo comando Zoning Save, o banco de dados de zoneamento não
volátil será excluído da chave. O método preferido para limpar o banco de
dados de zoneamento na chave é o comando Reset Zoning.

edit
Abre uma sessão de Edição de Zoneamento.

history
Exibe o histórico de modificações de zoneamento incluindo o seguinte:

v Hora da ativação ou desativação mais recente do conjunto de zonas e o
usuário que a executou.

v Hora das modificações mais recentes no banco de dados de zoneamento e
o usuário que as executou.

v Checksum do banco de dados de zoneamento.

limits
Exibe os limites máximos impostos pelo banco de dados de zoneamento para o
número de conjuntos de zonas, zonas, aliases, membros por zona, membros
por alias e total de membros.

list
Lista todas as definições de zoneamento da malha. Essa palavra-chave está
disponível com a autoridade de Usuário.
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restore
Reverte as alterações no banco de dados de zoneamento que foram feitas
durante a última sessão de Edição de Zoneamento desde a última inserção do
comando Zoning Save.

save
Salva as alterações feitas durante a sessão de Edição de Zoneamento atual. O
sistema o informará que o conjunto de zonas deve ser ativado para poder
implementar alterações. Isto não se aplica se o comando Zoning Clear tiver
sido inserido durante a sessão de Edição de Zoneamento.

Exemplos
É exibido a seguir um exemplo do comando Zoning Edit.
FCSM: user1> admin start

FCSM (admin) : user1> zoning edit

FCSM (admin-zoning) : user1>
.
.
FCSM (admin-zoning) : user1> zoning cancel

O modo de edição de zoneamento será cancelado. Confirme (y/n): [n] y

FCSM (admin) : user1> admin end

É exibido a seguir um exemplo do comando Zoning List.
FCSM: user1> zoning list

Informações sobre o ZoneSet Ativo

ZoneSet Zone ZoneMember
--------------------------------
wwn

wwn_b0241f
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
21:00:00:e0:8b:02:41:2f

wwn_23bd31
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
10:00:00:00:c9:23:bd:31

wwn_221416
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
10:00:00:00:c9:22:14:16

wwn_2215c3
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
10:00:00:00:c9:22:15:c3

Informações sobre o Zoneamento Configurado

ZoneSet Zone ZoneMember
--------------------------------
wwn

wwn_b0241f
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
21:00:00:e0:8b:02:41:2f
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wwn_23bd31
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
10:00:00:00:c9:23:bd:31

wwn_221416
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
10:00:00:00:c9:22:14:16

wwn_2215c3
50:06:04:82:bf:d2:18:c2
50:06:04:82:bf:d2:18:d2
10:00:00:00:c9:22:15:c3
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Capítulo 3. Utilizando o SAN Utility

Você pode utilizar o aplicativo SAN Utility para acessar e configurar módulos de
chave. Para obter informações sobre como instalar, remover a instalação e iniciar o
aplicativo SAN Utility, consulte o IBM ERserver BladeCenter 2-Port Fibre Channel
Switch Module: Guia de Instalação. O aplicativo SAN Utility pode ser instalado em
um servidor blade BladeCenter ou em uma estação de trabalho de gerenciamento
de rede externa configurada com um dos sistemas operacionais descritos no IBM
Eserver BladeCenter 2-Port Fibre Channel Switch: Guia de Instalação.

Para gerenciar as malhas e os módulos de chave, o aplicativo SAN Utility fornece
duas janelas básicas: Topology e Faceplate. A interface com o usuário do SAN
Utility, seus elementos e as tarefas que podem ser desempenhadas nas janelas
Faceplate e Topology são descritas neste capítulo.

Importante: Antes de configurar o módulo de chave, certifique-se de que os
módulos de gerenciamento da unidade BladeCenter estão configurados
corretamente. Além disso, para acessar e gerenciar o módulo de chave a partir de
um ambiente externo, poderá ser necessário ativar determinados recursos, como
as portas externas e o gerenciamento externo de todas as portas. Consulte as
publicações BladeCenter Unit: Guia de Instalação e do Usuário aplicáveis no CD
de Documentação do BladeCenter da IBM para obter informações adicionais.

Além de revisar as publicações nessa biblioteca, certifique-se de revisar o IBM
BladeCenter Planning and Installation Guide em
http://www.ibm.com/eserver/bladecenter/ na World Wide Web para obter
informações para ajudá-lo a preparar a instalação e configuração do sistema.

Interface com o Usuário do SAN Utility
A janela Topology e e a Faceplate compartilham os seguintes elementos comuns:

v Barra de menu

v Barra de ferramentas

v Árvore de malha

v Janela de gráficos

v Janela de dados e guias

v Indicador de status de trabalho

A janela Topology exibe todos os módulos de chave que são ativados e as
conexões entre módulos de chave e outros dispositivos Fibre Channel como
mostrado na Figura 1 na página 74.
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A janela Faceplate exibe a frente de um módulo de chave único e suas portas
ativas, como mostrado na Figura 2.

Barra de Menus
A barra de menus é exibida na parte superior da janela Faceplate e janela
Topology. Dependendo de qual janela esteja aberta, a barra de menus tem
seleções de menu semelhantes. A Figura 3 na página 75 mostra os itens de menu
que estão disponíveis na janela Topology. Na janela Faceplate, os itens de menu
exibidos com plano de fundo cinza estão disponíveis.

Figura 1. Janela Topology

Figura 2. Janela Faceplate
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Algumas seleções de menu possuem teclas de atalho como mostrado na
Tabela 14.

Tabela 14. Teclas de Atalho de Menu

Tecla de atalho Seleção de menu

F5

Ctrl+O

View → Refresh

File → Open View File

Além da barra de menus, as janelas Topology e Faceplate possuem menus
sensíveis ao contexto que abrem quando se clica na janela de gráficos com o
botão direito do mouse. Consulte “Abrindo a Janela Faceplate e os Menus Popup”
na página 81 para obter informações adicionais sobre esses menus popup.

Barra de Ferramentas
A barra de ferramentas consiste em uma linha de botões gráficos que podem ser
usados para acessar funções do SAN Utility como mostrado e descrito na
Tabela 15. Os botões da barra de ferramentas são um método alternativo de usar a
barra de menus.

Tabela 15. Botões da Barra de Ferramentas

Botões da barra de
ferramentas

Nome dos botões da
barra de ferramentas

Descrição

Incluir Malha Inclui uma nova malha

Open View File...
Save View As...
Change Default File Password...
Preferences...
Exit

File

Add Fabric...
Remove Fabric
Rediscover Fabric
Start Fabric View

Fabric

Help Topics
About...

Help

Port Properties...
Extended Credits...
Reset Port
Port Loopback Test...

Port

Edit Zoning...
Edit Zoning Config...
Activate Zone Set...
Deactivate Zone Set
Restore Default Zoning

Zoning

Refresh
Layout Topology

Toggle Auto Layout
Remember Layout
View Port Modes
View Port States
View Port Speeds
View Port Media

View

Delete
Export Name Server...
Switch Properties...
Network Properties...
Archive...
Restore...
Load Firmware...

Toggle Beach
Firmware Fallback...
Set Date/Time...

Toggle Beacon
Export Alarm Log...

Reset Switch
Restore Factory Defaults

Configure Alarm Thresholds...

Switch

Figura 3. Exemplos de Seleção da Barra de Menus
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Tabela 15. Botões da Barra de Ferramentas (continuação)

Botões da barra de
ferramentas

Nome dos botões da
barra de ferramentas

Descrição

Abrir Arquivo de Exibição Abre um arquivo de exibição de malha
existente

Salvar Exibição Como Salva a exibição de malha atual em um
arquivo

Atualizar Efetua poll na malha para atualizar a
janela Topology ou Faceplate com as
informações atuais

Tópicos da Ajuda Abre a ajuda online

Editar Zoneamento Abre a janela Edit Zoning (disponível
somente na janela Faceplate)

Árvore de Malha
A árvore de malha, no painel FC Fabric, relaciona as malhas gerenciadas e seus
módulos de chave. Para acertar a janela, clique e arraste a moldura da janela
móvel. Um identificador de entrada à esquerda de uma entrada na árvore indica
que é possível expandir a entrada. Ao clicar no identificador ou clicar duas vezes
na entrada, a entrada expande para mostrar suas chaves membro. Esses
elementos da árvore de malha são mostrados na Figura 4.

Cada entrada de árvore de malha tem um ícone pequeno ao lado que utiliza cor
para indicar o seguinte status operacional:

v Um ícone de entrada de módulo de chave verde indica que a chave está em
operação normal.

v Um ícone de entrada de módulo de chave vermelho indica que a chave
apresenta um defeito de comunicação.

Figura 4. Árvore de Malha
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v Um ícone de entrada de módulo de chave azul indica que o status da chave é
Desconhecido ou que a segurança está ativada no módulo de chave mas a
segurança está desativada na chave de gerenciamento de malha.

v Um ícone de entrada de módulo de chave âmbar indica que a chave está
operacional com erros.

A árvore de malha pode ser utilizada para acessar qualquer módulo de malha ou
de chave utilizando a janela Topology ou Faceplate. Pode-se clicar em uma entrada
de malha para abrir a janela Topology a partir da árvore de malha. Pode-se clicar
em uma entrada de módulo de chave para abrir a janela Faceplate a partir da
árvore de malha.

Janela de Gráficos
A janela de gráficos como mostrada na Figura 1 na página 74, mostra informações
gráficas sobre malhas e módulos de chave como a topologia de malha e a
faceplate de chave. Para acertar o comprimento da janela, clique e arraste a
moldura da janela que ela compartilha com a janela de dados.

Janela de Dados e Guias
A janela de dados como mostrado na Figura 2 na página 74 exibe uma tabela de
dados e estatísticas associadas à guia selecionada. Utilize a barra de rolagem para
procurar pelos dados. O comprimento da janela pode ser ajustada clicando e
arrastando a moldura que compartilha com a janela de gráficos.

Para acertar a largura da coluna, mova o ponteiro sobre a moldura do título da
coluna compartilhada por duas colunas até um gráfico de seta direita/esquerda ser
exibido. Clique e arraste a seta para a largura desejada. As guias da janela de
dados mostram opções dos tipos de informações que podem ser exibidas na janela
de dados. Essas opções variam dependendo da exibição.

Indicador de Status de Trabalho
O indicador de status de trabalho como mostrado na Figura 1 na página 74 está no
canto inferior direito da janela Topology e mostra quando a estação de trabalho de
gerenciamento de rede está trocando informações com a malha. À medida que as
condições se alteram, a malha avança essas informações para a estação de
trabalho de gerenciamento de rede na qual está refletida nas diversas exibições.

Usando a Janela Topology
A janela Topology mostrada na Figura 5 na página 78 efetua poll na malha
selecionada e exibe sua topologia. módulos de chave e ISL (Interswitch Links) são
exibidos na janela de gráficos e utilizam cor para indicar status. Os seguintes
elementos funcionais são exibidos na janela Topology quando se clica nas guias da
janela Data:

v Módulo de chave e status do link

v Trabalhando com módulos de chave e links

v Janelas de dados de topologia
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Módulo de Chave Fibre Channel e Status do Link
A forma e a cor do ícone do módulo de chave Fibre Channel fornecem informações
sobre a chave e seu estado operacional. Na janela Topology, as linhas representam
links entre módulos de chaves. Consulte Tabela 16 para módulo de chave Fibre
Channel e status do link e “Status de Malha” na página 87 para obter informações
adicionais sobre outros ícones da janela Topology.

Tabela 16. Módulo de Chave Fibre Channel e Indicadores de Status de Link

Cor do ícone do módulo de
chave

Status

Verde Operação de chave Fibre Channel normal

Âmbar Operacional com erros

Vermelho Inativa ou defeito da chave Fibre Channel

Azul Dispositivo Fibre Channel desconhecido

Trabalhando com Módulos de Chave e Links
Ícones de módulo de chave e de link podem ser selecionados e mudados e servem
como pontos de acesso para outras janelas e menus. Você seleciona módulos de
chave e links para exibir informações, modificar configurações ou exclui-los da
janela. Os menus popup sensíveis ao contexto podem ser acessados através dos
ícones de módulo de chave e de link.

Clique em um módulo de chave ou link na janela de gráficos para exibir seu status
na janela de dados. Para selecionar vários módulos de chave ou links, mantenha
pressionada a tecla Ctrl enquanto seleciona. Quando nenhum módulo de chave ou
link for selecionado, são exibidas informações sobre todos os módulo de chave.
Para desmarcar um módulo de chave ou link que esteja selecionado atualmente,
clique na chave ou no link.

Figura 5. Janela Topology
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Ícones de módulo de chave diferentes serão exibidos dependendo dos diferentes
produtos de fornecedores de chave presentes na malha anexada. Consulte a
Tabela 17 na página 87 para obter uma lista de ícones de módulo de chave e
fornecedores. Módulos de chave anexados que não podem ser gerenciados
através do SAN Utility serão exibidos como ícones de chave “gerenciáveis por
terceiros”. A configuração de topologia na Figura 6 mostra um exemplo de uma
malha de chave com módulos de chave de terceiros.

Organizando Módulos de Chave na Janela
Os dois métodos a seguir podem ser utilizados para organizar ícones de módulos
de chave individuais:

v Para mover um ícone de módulo de chave individual, clique e arraste o ícone
para outra localização na janela de gráficos. Os links expandem ou contraem
para permanecerem conectados.

v Para organizar todos os ícones de módulo de chave na janela Topology, clique
em View → Layout Topology.

A caixa de opções Toggle Auto Layout no menu View é selecionada por padrão
de modo que o SAN Utility possa organizar os ícones quando Layout Topology for
selecionado.

É possível salvar uma disposição personalizada, ou layout, e restaurar esse layout
durante uma sessão do SAN Utility. Para criar uma disposição personalizada,
organize os ícones; em seguida, clique em View → Remember Layout. Para
restaurar o layout salvo, clique em View, limpe a caixa de opções Toggle Auto
Layout e clique em Layout Topology.

Selecionando Módulos de Chave e Links
Selecionado os ícones do módulo de chave são realçados em violeta. Os ISLs
selecionados são realçados em âmbar. Os módulos de chave e os links podem ser
selecionados desempenhando-se as seguintes tarefas:

v Para selecionar um módulo de chave ou um link, clique no ícone ou no link.

v Para selecionar vários módulos de chave ou links, mantenha pressionada a tecla
Ctrl e clique nos módulos de chave ou links que desejar.

Figura 6. Malha de Chave Mostrando Módulos de Chave Gerenciáveis de Terceiros

Capítulo 3. Utilizando o SAN Utility 79



v Para selecionar todos os módulos de chave ou links, clique com o botão direito
no plano de fundo da janela de gráficos. Clique em Select All Switches ou em
All Links no menu popup.

Para cancelar uma seleção, mantenha pressionada a tecla Ctrl e selecione o item
novamente. Para cancelar várias seleções, clique no plano de fundo da janela de
gráficos.

Guias da Janela Topology Data
A janela Topology Data contém quatro guias na parte inferior da janela. Ao clicar
em uma guia, as seguintes informações são exibidas:

v Servidor de Nomes - Clique na guia Name Server para exibir todos os
dispositivos que estão registrados no servidor de nomes e sua localização na
configuração de malha atual. Consulte “Janela Name Server Data” na página 117
para obter informações adicionais sobre a configuração.

v Conjunto de Zonas Ativas - Clique na guia Active Zoneset para exibir o
conjunto de zonas ativas da malha, incluindo as zonas e suas portas membro.
Consulte “Janela Active Zoneset Data” na página 88 para obter informações
adicionais sobre essa janela de dados. Consulte “Efetuando Zoneamento em
uma Malha” na página 89 para obter informações sobre conjuntos de zonas e
zonas.

v Chave - Clique na guia Switch para exibir a rede atual e os dados de
configuração do módulo de chave das chaves selecionadas. Consulte a seção
“Janela Switch Data” na página 102 para obter informações adicionais.

v Link - Clique na guia Link para exibir o status de link atual dos módulos de
chave selecionados na malha.

Usando a Janela Faceplate
A janela Faceplate mostrada na Figura 7 na página 81 e descrita nesta seção exibe
o nome e o estado operacional do módulo de chave e o status da porta. Os
seguintes elementos funcionais são exibidos na janela Faceplate quando se clica
nas guias da janela Data:

v Exibições de porta e status

v Trabalhando com portas

v Janela de dados Faceplate
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Abrindo a Janela Faceplate e os Menus Popup
A janela Faceplate mostra a frente de um módulo de chave único e suas portas.
Você pode abrir a janela Faceplate e os menus popup quando estiver na janela
Topology desempenhando as seguintes tarefas:

v Para abrir a janela Faceplate ao exibir a janela Topology, clique em um ícone ou
uma entrada de módulo de chave na árvore de malha ou dê um clique duplo no
gráfico do módulo de chave.

v Para abrir o menu popup da malha ao exibir a janela Topology, clique com o
botão direito no plano de fundo da janela de gráfico. O menu popup da malha
exibe seleções para atualizar a malha, selecionar todos os módulos de chave,
selecionar todos os links ou topologia de layout.

v Para abrir o menu popup da chave ao exibir a janela Topology, clique com o
botão direito no ícone do módulo de chave na janela de gráficos. O menu popup
da chave exibe seleções para atualizar a chave, excluir a chave da exibição,
abrir a janela Switch Properties ou abrir a janela Network Properties.

v Para abrir o menu popup do link, clique com o botão direito no link. O menu
popup Link exibe uma seleção para excluir o link da exibição.

v Para abrir um menu popup da janela Faceplate, clique com o botão direito no
gráfico da faceplate na janela Graphic. O menu popup da faceplate exibe
seleções para atualizar o módulo de chave, selecionar todas as portas, gerenciar
chave, porta e propriedades de rede, estender créditos e executar os testes
Auto-Retorno da Porta.

Exibições e Status da Porta
Texto e cor da porta fornecem informações sobre a porta e seu estado operacional.
Verde indica que a porta está ativa e cinza indica que a porta está inativa. A janela
Faceplate exibe as seguintes exibições de status da porta correspondentes às
opções do menu View na janela Faceplate:

v Port mode

v Port state

v Port speed

Figura 7. Janela Faceplate
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v Port media

Consulte “Monitorando o Status da Porta” na página 113 para obter informações
adicionais sobre essas exibições.

Trabalhando com Portas
As portas são selecionáveis e servem como pontos de acesso para outras janelas
e menus. Você seleciona portas para exibir informações sobre elas na janela de
dados ou para modificá-las. Não é possível utilizar o SAN Utility para selecionar
compartimentos internos e portas externa ao mesmo tempo; deve-se selecionar
compartimentos internos ou portas externas. Menus popup sensíveis a contexto e
janelas de propriedades são acessíveis através da janela Faceplate e ícones de
porta.

Selecionando Portas
Ao selecionar uma porta, a porta é realçada com uma moldura branca. Você pode
selecionar portas das seguintes maneiras:

v Para selecionar uma porta, clique na porta na exibição Faceplate.

v Para selecionar um intervalo de portas consecutivas internas ou externas,
selecione uma porta e mantenha pressionada a tecla Shift e selecione outra
porta. O aplicativo seleciona as portas de extremidade e todas as portas entre
elas em número da porta.

v Para selecionar várias portas não consecutivas, mantenha pressionada a tecla
Ctrl ao selecionar as portas.

v Para selecionar todas as portas externas, clique com o botão direito em qualquer
lugar da faceplate do módulo de chave e selecione Select All Ports no menu
popup. Para selecionar todas as portas internas, clique em qualquer servidor
blade e selecione All Ports no menu popup.

Para cancelar uma seleção, mantenha pressionada a tecla Ctrl e selecione-a
novamente.

Abrindo Menus Popup
Você pode gerenciar o módulo de chave e suas portas utilizando os seguintes
métodos:

v Para abrir o menu popup, clique com o botão direito em qualquer parte da janela
de gráficos. Se não houver portas selecionadas, as tarefas específicas de porta
não estarão disponíveis no menu.

v Para selecionar uma ou mais portas e abrir o menu popup Port, clique com o
botão direito em uma porta.

Guias da Janela de Dados Faceplate
A janela de dados contém seis guias na parte inferior da exibição. Ao clicar em
uma guia, as seguintes informações são exibidas:

v Servidor de nomes - Clique na guia Name Server para exibir todos os
dispositivos conectados ao módulo de chave que estiverem registrados no
servidor de nomes.

v Chave - Clique na guia Switch para exibir os dados de configuração do módulo
de chave.

v Estatísticas da porta - Clique na guia Port Stats para exibir os dados de
desempenho da porta para a porta selecionada.

v Informações sobre a porta - Clique na guia Port Info para exibir informações
detalhadas sobre a porta selecionada.
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v Conjuntos de zonas configuradas - Clique na guia Configured Zonesets para
exibir todos os conjuntos de zonas, zonas e membros de zona no banco de
dados de zonas.

v Log de Alarme - Clique na guia Alarm Log para exibir informações de erro do
sistema.

Gerenciando Malhas
Esta seção descreve as quatro tarefas principais seguintes para gerenciar malhas:

v Configurando a segurança

v Gerenciando o banco de dados de malha

v Exibindo informações de malha

v Definindo zonas em uma malha

Configurando a Segurança
O acesso a um módulo de chave e a permissão de configurar uma chave são
gerenciados através de contas do usuário criadas por um administrador de malha.
Uma conta do usuário consiste em um nome de conta, uma senha e um nível de
autoridade. O nível de autoridade determina se uma conta pode meramente
monitorar o módulo de chave e a atividade de malha (Autoridade do usuário) ou
alterar as configurações do módulo de chave (Autoridade administrativa). Consulte
“Comando User” na página 61 para obter informações sobre como administrar
contas do usuário. A segurança da malha determina a aplicação de contas do
usuário em um módulo de chave. Um administrador de malha pode ativar ou
desativar a segurança de malha em um módulo de chave usando o comando Set
Setup System.

Se a segurança de malha for desativada (padrão), é possível utilizar o SAN Utility
para efetuar login em um módulo de chave sem um nome de conta e senha. Os
campos Login name e Password na janela Add a Fabric são ignorados e você
recebe autoridade de Administrador. Se a segurança de malha for ativada, é
necessário informar um nome de conta e senha para efetuar login em um módulo
de chave e incluir a malha na área de trabalho. Ao incluir uma malha com êxito,
você poderá desempenhar somente as tarefas do SAN Utility que são concedidas
pelo nível de autoridade dessa conta. Todos os módulos de chave de uma malha
devem usar o mesmo valor de segurança de malha. Consulte “Comando Set
Setup” na página 39 para obter informações sobre a palavra-chave Sistem e o
parâmetro Security Enable.

Nota: Um módulo de chave suporta um máximo combinado de 15 sessões de
login ativas. Isso inclui tentativas de efetuar login no SAN Utility em banda e
fora de banda, tentativas de efetuar login na Telnet fora de banda e sessões
de login no SNMP fora de banda. Dessas 15, pode haver um máximo de 10
tentativas de efetuar login no SAN Utility incluídas no total de 15 tentativas.
Logins adicionais são recusados.

Gerenciando o Banco de Dados de Malha
Um banco de dados de malha contém um conjunto de malhas que foram incluídas
durante uma sessão do SAN Utility. Inicialmente, uma janela Topology com um
banco de dados de malha vazio é exibida. Esta seção descreve as seguintes
tarefas de gerenciamento de banco de dados:

v Incluindo uma malha

v Removendo uma malha
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v Abrindo um arquivo de exibição de malha

v Salvando um arquivo de exibição de malha

v Redescobrindo uma malha

v Incluindo um novo módulo de chave em uma malha

v Substituindo um módulo de chave com defeito em uma malha

v Excluindo módulos de chave e links

Incluindo uma Malha
Conclua as seguintes etapas para incluir uma malha no banco de dados:

1. Na janela Faceplate, clique em Fabric → Add Fabric.

A janela Add a New Fabric é exibida, como mostrado na Figura 8.

2. No campo Fabric name, digite um nome de malha.

3. ’No campo IP address, digite o endereço IP do módulo de chave com o qual
gerencia a malha.

4. No campo Login name, digite o ID de login padrão inicial, USERID. No campo
Password digite a senha padrão inicial, PASSW0RD (o sexto caractere é um zero,
não a letra O). O ID do usuário e a senha fazem distinção entre maiúsculas e
minúsculas.

Nota: A senha é para o módulo de chave e está armazenada no firmware da
chave. Não é necessário informar um ID do usuário ou senha se a
segurança estiver desativada. Consulte “Configurando a Segurança” na
página 83. Consulte “Comando Set Setup” na página 39 para obter
informações sobre os comandos Set Setup na seção Telnet para efetuar
login e obter informações sobre senha e segurança.

5. Clique em Add fabric.

Removendo uma Malha
Conclua as seguintes etapas para excluir um arquivo de malha do banco de dados:

1. Selecione uma malha na árvore de malhas.

Figura 8. Janela Add a New Fabric
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2. Na janela Faceplate, clique em Fabric → Remove Fabric.

Abrindo um Arquivo de Exibição de Malha
Conclua as seguintes etapas para abrir um arquivo de exibição de malha existente:

1. Na janela Faceplate, clique em File → Open View File, ou clique no ícone
Open.

Se houver uma alteração na malha que estiver utilizando, você será avisado
para salvar as alterações no arquivo de exibição antes de abrir um arquivo de
exibição diferente.

A janela Open View é exibida.

2. Na janela Open View, digite o nome do arquivo que deseja abrir.

3. Digite uma senha de arquivo se necessário.

4. Clique em Load View File. Se a malha foi alterada, você é avisado para salvar
o arquivo antes de abrir a nova exibição.

Salvando um Arquivo de Exibição de Malha
Conclua as seguintes etapas para salvar um arquivo de exibição de malha:

1. Na janela Faceplate, clique em File → Save View As ou clique no ícone Save.

A janela Save View é exibida.

2. Na janela Save View, digite um novo nome do arquivo.

3. Clique em OK.

4. Digite uma senha de arquivo, se necessário.

Redescobrindo uma Malha
Após fazer alterações ou excluir módulos de chave de uma exibição de malha,
atualize a configuração de malha. Utilize a opção Redescobrir Malha para limpar as
informações de malha atuais que estão exibidas e redescobrir as informações do
módulo de chave. Para redescobrir uma malha, na janela Faceplate, clique em
Fabric → Rediscover Fabric.

Incluindo um Novo Módulo de Chave em uma Malha
Após instalar um módulo de chave na unidade BladeCenter, a chave utiliza as
definições de configuração de malha padrão. As definições de configuração de
malha padrão são as seguintes:

v A zona de malhas é enviada da malha para o módulo de chave.

v Todas as portas externas (0,15) são GL_Ports; todas as portas internas (1 a 14)
são F_Ports.

v Os endereços IP padrão são:

Para compartimento de módulo de chave 3:
192.168.70.129

Para compartimento de módulo de chave 4:
192.168.70.130

Conclua as etapas a seguir para incluir um novo módulo de chave em uma malha
e não fazer alterações nas definições de configuração de malha padrão:

1. Se o módulo de chave não for novo, para redefinir a chave para a configuração
de fábrica, na janela Faceplate, clique em Switch → Restore Factory Defaults.

2. Para gerenciar o módulo de chave através da porta Ethernet, defina a
configuração da rede SNMP utilizando a janela Network Properties. Para obter
informações adicionais, consulte “Propriedades da Rede” na página 110.

3. Configure quaisquer definições de chave especiais.
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Nota: Para prevenir comunicação com outros módulos de chave na malha até
a nova chave ser configurada, na janela Zoning Config, clique em None
no campo Default Visibility. Para obter informações adicionais, consulte
“Configuração de Zoneamento” na página 91.

4. Conecte os ISL (Interswitch Links), mas não conecte os dispositivos.

5. Na janela Port Properties, configure os tipos de porta da nova chave (GL_Port,
TL_Port, Donor).

6. Conecte os dispositivos Fibre Channel ao módulo de chave.

7. Na janela Edit Zoning, faça as alterações de zona necessárias.

Substituindo um Módulo de Chave com Defeito em uma Malha
Conclua as seguintes etapas para substituir um módulo de chave com defeito para
o qual haja um arquivo disponível. Consulte “Restaurando um Módulo de Chave”
na página 132 e “Arquivando um Módulo de Chave” na página 111 para obter
informações adicionais.

1. Remova o módulo de chave com defeito. Para obter informações adicionais,
consulte o Guia de Instalação.

2. Instale o novo módulo de chave de substituição. Para obter informações
adicionais, consulte o Guia de Instalação.

3. Efetue login na malha através do módulo de chave de substituição. Na janela
Topology, selecione o módulo de chave de substituição na árvore de malha.

4. Clique em Switch → Restore.

A janela Restore Switch é exibida.

5. Na janela Restore Switch, digite um nome ou selecione o arquivo de
configuração de chave arquivado para copiar no módulo de chave. Para obter
informações adicionais, consulte “Arquivando um Módulo de Chave” na
página 111.

6. Clique em OK para gravar o arquivo de configuração no módulo de chave.

Excluindo Módulos de Chave e Links da Exibição Topology
O SAN Utility não exclui automaticamente chaves de módulo ou links que
apresentaram defeito ou que foram removidos fisicamente. Nesse caso, você pode
excluir módulos de chave e links na janela Topology para atualizar a exibição. Se
excluir uma chave ou um link que ainda esteja ativo, o SAN Utility restaura-o
automaticamente. Também é possível atualizar a exibição.

Conclua as etapas a seguir para excluir um módulo de chave na janela Topology:

1. Selecione um ou mais módulos de chave na janela Topology.

2. Clique em Switch → Delete.

Conclua as etapas a seguir para excluir um link:

1. Selecione um ou mais links na janela Topology.

2. Clique em Switch → Delete.

Exibindo Informações de Malha
A janela Topology é a ferramenta principal para monitorar uma malha. A janela de
gráficos da janela Topology fornece informações de status para módulos de chave,
links interchaves e a conexão Ethernet à estação de trabalho de gerenciamento de
rede.

As guias de janela de dados mostram servidor de nomes, chave e informações de
conjunto de zona ativa. A guia Active Zoneset mostra as definições de zona do
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conjunto de zonas ativas. Consulte “Janela Switch Data” na página 102 e “Janela
Name Server Data” na página 117 para obter informações sobre as janelas Switch
Data e Name Server Data.

Status de Malha
A malha atualiza as janelas Topology e Faceplate encaminhando as alterações no
status para a estação de trabalho de gerenciamento de rede quando ocorrem.
Utilize a malha para atualizar o status de exibição ou atualize a exibição a qualquer
momento. Para atualizar a janela Topology, utilize um dos métodos a seguir:

v Na janela Topology, clique em Refresh.

v Clique em View → Refresh.

v Pressione a tecla F5.

v Clique em qualquer parte do plano de fundo da janela Topology. Selecione
Refresh Fabric no menu popup.

A A janela Topology exibe ícones de status e módulo de chave que fornecem
informações de status sobre chaves, links interchaves e a conexão Ethernet. Os
ícones de módulo de chave indicam chaves de fornecedores e tipos de chave
diferentes. Os ícones de status de módulo de chave, exibidos no lado esquerdo de
uma chave, variam em forma e cor. Cada módulo de chave gerenciado por um IP
(Internet protocol) Ethernet tem um ícone Ethernet colorido que é exibido no lado
direito da chave. Um ícone Ethernet verde indica operação normal, âmbar indica
operação com erros e vermelho indica inativo ou defeito. A Tabela 17 mostra os
ícones de módulo de chave diferentes e suas descrições.

Nota: Diferentes ícones de módulo de chave são exibidos dependendo dos
produtos de fornecedores de chave diferentes presentes na malha anexada.
Para obter uma lista de ícones de módulo de chave e fornecedores,
consulte a Tabela 17. Os módulos de chave anexados não gerenciáveis
através do SAN Utility são exibidos como ícones de chave gerenciáveis por
terceiros. A configuração da topologia na Figura 6 na página 79 mostra um
exemplo de uma malha de chave com módulos de chave de terceiros.

Tabela 17. Ícones de Status e Módulo de Chave da Janela Topology

Ícone do módulo de
chave

Descrição

Módulo de chave Fibre Channel BladeCenter

Módulo de chave Fibre Channel de 8 portas QLogic

Módulo de chave Fibre Channel de 16 portas QLogic

Módulo de chave Inrange

Módulo de chave McData

Módulo de chave Brocade

Outros módulos de chave de terceiros
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Tabela 17. Ícones de Status e Módulo de Chave da Janela Topology (continuação)

Ícone do módulo de
chave

Descrição

Comunicação de chave normal (verde)

A chave está operacional com erros (âmbar)

Comunicação de chave interrompida (vermelho)

Comunicação de gerenciamento de chave desconhecida (azul)

Conexão Ethernet de chave de gerenciamento de malha normal
(verde)

Conexão Ethernet de chave de gerenciamento de malha crítica
(vermelho)

Conexão Ethernet de chave de gerenciamento de malha em
aviso (âmbar)

Janela Active Zoneset Data
A janela Active Zoneset Data exibe os membros de zona do conjunto de zonas
ativas que residem na chave de gerenciamento de malha. O conjunto de zonas
ativas é o mesmo em todos os módulos de chave da malha. Isso pode ser
confirmado incluindo uma malha através de outro módulo de chave e comparando
exibições de Active Zoneset Data.

Para abrir a janela Active Zoneset Data, clique na guia Active Zoneset Data
abaixo da janela de dados na janela Topology. Consulte “Efetuando Zoneamento
em uma Malha” na página 89 para obter informações adicionais sobre conjuntos de
zonas e zonas. Consulte “Janela Configured Zonesets Data” na página 104 para
obter informações sobre as definições de conjuntos de zonas de um módulo de
chave específico.

A janela de dados Active Zoneset Data, mostrada na Figura 9 na página 89, utiliza
convenções de exibição para expandir e contrair entradas que são semelhantes à
árvore de malha. Um identificador de entrada à esquerda de uma entrada na
árvore de malha indica que a entrada pode ser expandida. Clique nesse
identificador ou dê um clique duplo nas seguintes entradas para expandi-las ou
contrai-las:

v Uma entrada de conjunto de zonas expande para mostrar suas zonas membros.

v Uma entrada de zona expande para mostrar suas portas membros.

v Uma entrada de porta expande para mostrar o endereço Fibre Channel da porta.

v Uma entrada de endereço Fibre Channel expande para mostrar o nome
universal da porta da porta.
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Efetuando Zoneamento em uma Malha
As malhas Fibre Channel utilizam zoneamento para restringir ou estender o acesso
a dispositivos na malha. Uma zona é um grupo nomeado de dispositivos que
podem comunicar-se uns com os outros.

Você pode utilizar efetuando zonas para dividir as portas e dispositivos da malha
em zonas para comunicação mais eficiente e segura entre nós agrupados
funcionalmente. É possível definir os parâmetros de configuração de zona Auto
Save e Default Visibility utilizando o SAN Utility ou o comando Set Config Zoning.
Consulte “Salvamento Automático” na página 92 para obter informações sobre o
parâmetro Auto Save, consulte “Visibilidade Padrão” na página 92 para obter
informações sobre o parâmetro Default Visibility e consulte “Utilizando a Janela
Zoning Config” na página 92 para obter informações sobre o comando Set Config
Zoning.

Conceitos de Zoneamento
Os conceitos de zoneamento a seguir fornecem algum contexto para as tarefas de
zoneamento descritas nesta seção:

v Zonas

v Aliases

v Conjuntos de zonas

v Banco de dados de zoneamento

v Configuração de zoneamento

Zonas: Uma zona é um grupo nomeado de portas ou dispositivos que podem
comunicar-se uns com os outros. Participar de uma zona como membro é definido
pelo número da porta, endereço Fibre Channel do dispositivo ou WWN (World
Wide Name) do dispositivo. Os membros da zona podem comunicar-se somente
com os membros da mesma zona. As zonas podem sobrepor-se; ou seja, uma
porta ou dispositivo pode ser membro de mais de uma zona.

Figura 9. Janela Active Zoneset Data
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Há três tipos de zonas que são suportados, mas têm níveis de comunicação
restritivos. Esses tipos de zonas são:

v Zona temporária

v ACL (Access control list) - zona fixa

v VPF (Virtual Private Fabric) - zona fixa

Zoneamento Temporário: O zoneamento temporário divide a malha para fins de
controlar a descoberta. Os membros da mesma zona temporária descobrem
automaticamente e comunicam-se livremente com todos os outros membros da
mesma zona. O limite de uma zona temporária não é seguro; o tráfego através de
zonas temporárias pode ocorrer se endereçado corretamente. As zonas
temporárias que incluem membros de vários módulos de chave não precisam
incluir as portas dos links interchaves. Os limites da zona temporária produzem
para os limites de zona ACL e VPF. As zonas temporárias podem sobrepor-se; ou
seja, uma porta pode ser membro de mais de uma zona temporária. Os membros
são definidos pelo endereço Fibre Channel, ID da porta e ID do domínio ou nome
universal da porta. O zoneamento temporário suporta todos os modos de porta.

Zonas Access Control List: O zoneamento ACL (Access Control List) divide a
malha para fins de controlar a descoberta e o tráfego de entrada. O zoneamento
ACL é um tipo de zoneamento fixo que é aplicado pelo hardware. Esse tipo de
zoneamento é útil para controlar o acesso a determinados dispositivos sem
isolá-los totalmente da malha. Os membros podem comunicar-se uns com os
outros e transmitir para fora da zona ACL mas não podem receber tráfego de
entrada de fora da zona. O limite da zona ACL é seguro contra tráfego de entrada.
As zonas ACL podem sobrepor-se; ou seja, uma porta pode ser membro de mais
de uma zona ACL. As zonas ACL que incluem membros de vários módulos de
chave não precisam incluir as portas dos links interchaves. Os limites da zona ACL
suplantam os limites da zona temporária mas produzem para limites da zona VPF.
Os membros podem ser definidos somente por ID da porta e ID de domínio. O
zoneamento ACL suporta todos os modos de porta exceto TL_Ports.

Zonas Virtual Private Fabric: O zoneamento VPF (Virtual Private Fabric) divide a
malha para fins de controlar a descoberta e o tráfego de entrada e de saída. Esse
tipo de zoneamento é útil para fornecer segurança e reservar caminhos entre
dispositivos para garantir largura de banda. O zoneamento VPF é um tipo de
zoneamento fixo aplicado por hardware. Os membros podem transmitir e receber
somente de membros da mesma zona VPF. O limite da zona VPF é segura contra
tráfego de entrada e de saída. As zonas VPF que incluem membros de vários
módulos de chave devem incluir as portas dos links interchaves. As zonas VPF não
podem se sobrepor; ou seja, uma porta pode ser membro de somente uma zona
VPF. Os limites da zona VPF suplantam os limites de zona temporária e ACL. Os
membros podem ser definidos somente por ID da porta e ID de domínio. O
zoneamento VPF suporta todos os modos de porta.

Nota: Os conflitos de ID de domínio podem resultar em reatribuição automática de
IDs de domínio de módulo de chave. Essas reatribuições não são refletidas
em zonas que utilizam ID de domínio e pares de números de porta ou
endereços Fibre Channel para definir seus membros. Certifique-se de
reconfigurar zonas que são afetadas por uma alteração de ID de domínio.
Para impedir que as definições de zoneamento fiquem inválidas quando a
participação como membro for definida por ID de domínio/número de porta
ou endereço Fibre Channel, é necessário travar os IDs de domínio.

Aliases: Para facilitar a inclusão de um grupo de portas ou dispositivos em uma
ou mais zonas, você pode criar um alias. Um alias é um conjunto nomeado de
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portas ou dispositivos que são agrupados por conveniência. Ao contrário das
zonas, os aliases não impõem restrições de comunicação entre seus membros. Um
alias pode ser incluído em uma ou mais zonas. No entanto, não é possível incluir
uma zona em um alias, e um alias não pode ser membro de outro alias.

Conjuntos de Zonas: Um conjunto de zonas é um grupo nomeado de zonas.
Uma zona pode ser membro de mais de um conjunto de zonas. Todas as zonas
que não são membros de um conjunto de zonas pertencem ao conjunto de zonas
órfãos. O conjunto de zonas órfãos é salvo no módulo de chave. Cada módulo de
chave na malha mantém seu próprio banco de dados de zoneamento que contém
um ou mais conjuntos de zonas. Esse banco de dados de zoneamento reside na
memória não volátil ou permanente e por isso é conservado após uma
reinicialização. Para obter informações sobre como exibir o banco de dados de
zoneamento, consulte “Janela Configured Zonesets Data” na página 104.

Para aplicar zoneamento em uma malha, selecione um conjunto de zonas e
ative-o. Quando um conjunto de zonas é ativado, o módulo de chave distribui esse
conjunto de zonas para cada chave da malha. Portanto, cada módulo de chave da
malha terá conjuntos de zonas ativas idênticos. Para obter informações sobre como
exibir o conjunto de zonas ativas, consulte “Janela Active Zoneset Data” na
página 88.

Banco de Dados de Zoneamento: Cada módulo de chave tem seu próprio
banco de dados de zoneamento. O zoneamento database é composto de todos os
aliases, zonas e conjuntos de zonas que foram criados na chave ou recebidos de
outros módulos de chave. O módulo de chave mantém duas cópias do banco de
dados de zoneamento: uma cópia é mantida na memória temporária para fins de
edição; a segunda cópia é mantida na memória permanente. As edições do banco
de dados de zoneamento são em uma base de chave individual e não são
propagadas para outros módulos de chave da malha quando salvas.

O parâmetro de configuração de zoneamento Auto Save controla se o banco de
dados de zoneamento temporário é salvo automaticamente na memória
permanente. Para obter informações adicionais sobre os parâmetros Auto Save,
consulte “Configuração de Zoneamento”.

Os limites de zoneamento de uma malha são:

v O número máximo de conjuntos de zonas é 256

v O número máximo de zonas é 256

v O número máximo de aliases é 256

v O número máximo de membros por zona é 2000

v O número máximo de membros por alias é 2000

v O número total máximo de membros de zona e alias é 2000

v O número total máximo de membros do conjunto de zonas é 1000

Configuração de Zoneamento: Você pode definir o parâmetros de configuração
zoneamento utilizando o SAN Utility ou o comando Set Zoning Config. Para obter
informações sobre configuração de zoneamento utilizando o SAN Utility, consulte
“Utilizando a Janela Zoning Config” na página 92 e “Comando Set Config” na
página 28.

Os seguintes parâmetros compõem a configuração de zoneamento:

v Salvamento Automático

v Visibilidade Padrão
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Salvamento Automático: O parâmetro Auto Save determina se as alterações no
conjunto de zonas ativas que um módulo de chave recebe de outras chaves da
malha são salvas na memória permanente desse módulo de chave. As alterações
são salvas quando um conjunto de zonas atualizado é ativado. As alterações de
zoneamento são sempre salvas na memória temporária. No entanto, se
Salvamento Automático for ativado, o firmware do módulo de chave salva as
alterações no conjunto de zonas ativas nas memórias temporária e permanente. Se
Salvamento Automático for desativado, as alterações no conjunto de zonas ativas
são armazenadas somente na memória temporária.

Visibilidade Padrão: O parâmetro Default Visibility determina o nível de
comunicação que é permitido entre dispositivos quando não há conjunto de zonas
ativas. O parâmetro de visibilidade padrão pode ser definido de modo diferente em
cada módulo de chave. Quando a visibilidade padrão é ativada (definida para All-)
em um módulo de chave, todas as portas na chave podem comunicar com todas
as portas nos módulos de chave que também têm o parâmetro Default Visibility
definido para Enabled. Quando a visibilidade padrão é desativada (definida para
None) em um módulo de chave, nenhuma das portas nesse módulo de chave pode
comunicar-se com qualquer outra chave da malha.

Utilizando a Janela Zoning Config
Utilize a janela Zoning Config para alterar os parâmetros de configuração Auto
Save e Default Visibility. Conclua as etapas a seguir para abrir a janela Zoning
Config e alterar os parâmetros de configuração:

1. Na janela Faceplate, clique em Zoning → Edit Zoning Config. A janela Zoning
Config é exibida.

2. Faça as alterações necessárias nos campos Auto Save e Default Visibility e
clique em OK.

Restaurando o Zoneamento Padrão
Restaurando o zoneamento padrão limpa o módulo de chave de todas as
definições de zoneamento. Conclua as etapas a seguir para restaurar o
zoneamento padrão de um módulo de chave.

Atenção: A utilização desse comando irá desativar qualquer conjunto de zonas
ativas. Se o módulo de chave não estiver isolado da malha, esse comando irá
desativar o conjunto de zonas ativas da malha inteira.

1. N janela Faceplate, clique em Zoning → Restore Default Zoning.

Figura 10. Janela Zoning Config
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2. Clique em OK para confirmar que deseja restaurar o zoneamento padrão e
salvar as alterações do banco de dados de zoneamento.

Mesclando Malhas e Zoneamento
Se duas malhas forem unidas, os conjuntos de zonas ativas das duas malhas
tentam mesclar. As malhas podem consistir em um único módulo de chave ou
muitas chaves já conectadas juntas. Os módulos de chave nas duas malhas
tentam criar um novo conjunto de zonas ativas contendo a união do conjunto de
zonas ativas de cada malha. A propagação das informações de zoneamento afeta
somente o conjunto de zonas ativas, não os conjuntos de zonas configuradas.

Falha ao Mesclar Zonas
Se uma mesclagem de zona não tiver êxito, os links interchaves entre as malhas
serão isolados devido a um defeito na mesclagem de zonas, o que gera uma
entrada no log de alarme. A razão do isolamento da E_Port também pode ser
determinada pela exibição das informações sobre a porta. Consulte o “Janela Port
Information Data” na página 104 e o “Comando Show” na página 42 (Palavra-chave
de porta).

Uma mesclagem de zonas irá falhar se dois conjuntos de zonas ativas tiverem
zonas membro com nomes idênticos que diferem em conteúdo ou tipo. Por
exemplo, considere Malha A e Malha B, cada uma com uma zona em seu conjunto
de zonas ativas denominada “ZS1.” A Malha A “ZS1” contém um membro
especificado pelo ID de Domínio 1 e Porta 1; a Malha B “ZS1” contém um membro
especificado pelo ID de Domínio 1 e Porta 2. Neste caso, a mesclagem falha e os
links interchaves entre as malhas são isolados.

Recuperação do Defeito de Mesclagem de Zonas
Quando ocorre um defeito de mesclagem, o conflito que causou o defeito deve ser
resolvido. Você pode corrigir um defeito resultante de um conflito de zonas
desativando um dos conjuntos de zonas ativas ou editando as zonas em conflito
para que seus membros sejam os mesmos. Você pode desativar o conjunto de
zonas ativas em um módulo de chave se o conjunto de zonas ativas na outra
chave definir com precisão as necessidades de zoneamento. Caso contrário, será
necessário editar os membros da zona e reativar os conjuntos de zonas. Para
obter informações sobre como incluir e remover membros da zona, consulte
“Gerenciando Zonas” na página 97. Para permitir que as malhas se unam, redefina
as portas que foram isoladas. Consulte “Reinicializando Uma Porta” na página 124.

Utilizando a Janela Edit Zoning
Utilize a janela Edit Zoning para editar o banco de dados de zoneamento de um
módulo de chave específico. Para editar o banco de dados de zoneamento, na
janela Faceplate, clique em Zone → Edit Zoning. A janela Edit Zoning é exibida.

Nota: É possível fazer alterações somente em um conjunto de zonas ativas, que
esteja armazenado em uma memória flash (não volátil) e conservado após a
definição de um módulo de chave.
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A janela Edit Zoning exibe uma árvore Zone Sets no painel esquerdo e uma árvore
Port and Device (ou membros) no painel direito, como mostrado na Figura 11. As
duas árvores utilizam convenções de exibição semelhantes à árvore de malhas
para expandir e contrair conjuntos de zonas, zonas e portas. Uma porta expandida
mostra o endereço Fibre Channel da porta; um endereço expandido mostra o nome
universal da porta da porta. Também é possível selecionar conjuntos de zonas,
zonas e portas das seguintes maneiras:

v Clique em um ícone de zona, conjunto de zonas ou porta.

v Clique com o botão direito para selecionar uma zona ou um conjunto de zonas e
abra o menu popup correspondente.

v Mantenha pressionada a tecla Shift enquanto clica em vários ícones
consecutivos.

v Mantenha pressionada a tecla Ctrl enquanto clica em vários ícones não
consecutivos.

Utilizando a barra de ferramentas, menus popup ou um método de arrastar e soltar,
você pode criar e gerenciar conjuntos de zonas e zonas no banco de dados de
zoneamento. Clique em Apply para salvar as alterações no banco de dados de
zoneamento sem fechar a janela. Clique em OK para salvar as alterações no
banco de dados de zoneamento e fechar a janela.

A tabela a seguir explica os botões da barra de ferramentas e suas funções.

Tabela 18. Botões da Barra de Ferramentas da Janela Edit Zoning

Botão da barra de
ferramentas

Função

Criar um novo conjunto de zonas.

Figura 11. Janela Edit Zoning
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Tabela 18. Botões da Barra de Ferramentas da Janela Edit Zoning (continuação)

Botão da barra de
ferramentas

Função

Criar uma nova zona.

Criar um nome adicional para um conjunto de objetos.

Inclua a zona selecionada em um conjunto de zonas ou inclua a
porta selecionada em uma zona.

Excluir a zona selecionada de um conjunto de zonas ou excluir a
porta selecionada de uma zona.

Gerenciando Conjuntos de Zonas
Efetuar zoneamento em uma malha envolve criar um conjunto de zonas, criar
zonas como membros de conjuntos de zonas, em seguida incluir dispositivos como
membros da zona. O banco de dados de zoneamento suporta vários conjuntos de
zonas para servir as diferentes necessidades de segurança a acesso da rede da
área de armazenamento. Somente um conjunto de zonas pode estar ativo de cada
vez. Gerenciar conjuntos de zonas envolve as seguintes tarefas:

v Criar conjuntos de zonas

v Ativar e desativar conjuntos de zonas

v Copiar uma zona em um conjunto de zonas

v Remover uma zona de um conjunto de zonas ou de todos os conjuntos de
zonas

v Remover um conjunto de zonas

v Remover todas as definições de zoneamento

Nota: As alterações feitas no banco de dados de zoneamento são limitadas ao
módulo de chave gerenciado e não se propagam para o resto da malha.
Para distribuir alterações para conjuntos de zonas configuradas em toda a
malha, é necessário editar os bancos de dados de zoneamento nos módulos
de chave individuais.

Criando um Conjunto de Zonas
Conclua as seguintes etapas para criar um conjunto de zonas:

1. Na janela Faceplate, clique em Zoning → Edit Zoning.

A janela Edit Zoning é exibida.

2. Clique em Edit → Create Zone Set.

A janela Create Zone Set é exibida.
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3. Digite um nome para o conjunto de zonas e clique em OK. O novo nome do
conjunto de zonas é exibido na janela Zone Sets.

4. Conclua uma das seguintes tarefas para criar novas zonas em um conjunto de
zonas:

v Clique com o botão direito em um conjunto de zonas e selecione Create A
Zone no menu popup. Na janela Create A Zone, digite um nome para a nova
zona e clique em OK. O novo nome da zona é exibido na janela Zone Sets.

v Para copiar uma zona existente no novo conjunto de zonas, na janela
Faceplate, selecione a zona e arraste-a para o novo conjunto de zonas.

5. Clique em Apply para salvar as alterações no banco de dados de zoneamento.

Ativando e Desativando um Conjunto de Zonas
É necessário ativar um conjunto de zonas para aplicar suas definições de
zoneamento à malha. Somente um conjunto de zonas pode estar ativo de cada vez
Quando um conjunto de zonas é ativado, o módulo de chave distribui esse
conjunto de zonas para o banco de dados de zoneamento temporário em cada
chave da malha, substituindo qualquer conjunto de zonas que tenha o mesmo
nome. Se Salvamento Automático estiver ativado, o conjunto de zonas é salvo no
banco de dados de zoneamento permanente também. Para obter informações
adicionais, consulte “Salvamento Automático” na página 92.

O objetivo da função desativar é suspender todo o zoneamento de malha, o que
resulta na comunicação livre em toda a malha ou nenhuma comunicação,
dependendo da definição de visibilidade padrão. Para obter informações adicionais,
consulte “Visibilidade Padrão” na página 92. Não é necessário desativar o conjunto
de zonas ativas antes de ativar um novo.

Conclua as etapas a seguir para ativar um conjunto de zonas:

1. Na a Faceplate, clique em Zoning → Activate Zone Set.

A janela Activate Zoneset é exibida.

2. No menu Select Zone Set, clique em Zone Set → Activate.

Conclua as etapas a seguir para desativar um conjunto de zonas:

1. Na janela Faceplate, clique em Zoning → Deactivate Zone Set.

Uma mensagem avisando interrupção de tráfego é exibida.

2. Clique em Yes para confirmar que deseja desativar a zona ativa.

Copiando uma Zona em um Conjunto de Zonas
Conclua as seguintes etapas para copiar uma zona existente e seus membros de
um conjunto de zonas para outro:

1. Na janela Faceplate, selecione a zona e arraste-a para o conjunto de zonas
que deseja.

2. Clique em Apply para salvar as alterações no banco de dados de zoneamento.

Removendo uma Zona de um Conjunto de Zonas ou de Todos os
Conjuntos de Zonas
Conclua as seguintes etapas para remover uma zona de um conjunto de zonas ou
de todos os conjuntos de zonas do banco de dados:

1. Na janela Faceplate, clique em Zoning → Edit Zoning.

A janela Edit Zoning é exibida.

2. Na árvore Zone Sets, selecione a zona que deseja remover.
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3. Clique em Edit → Remove para remover a zona do conjunto de zonas ou
selecione Remove from All Zones para remover a zona de todos os conjuntos
de zonas.

4. Clique em Apply para salvar as alterações no banco de dados de zoneamento.

Nota: Você pode utilizar menus de atalho para remover uma zona de um conjunto
de zonas ou de todos os conjuntos de zonas no banco de dados.

Removendo um Conjunto de Zonas
Remover um conjunto de zonas do banco de dados afeta as zonas membros das
seguintes maneiras:

v As zonas membros que são membros de outros conjuntos de zonas não são
afetadas.

v As zonas membros que não são membros de outros conjuntos de zonas
tornam-se membros do conjunto de zonas órfãos. O conjunto de zonas órfãos é
salvo no módulo de chave.

Conclua as etapas a seguir para remover um conjunto de zonas do banco de
dados:

1. Na janela Faceplate, clique em Zoning → Edit Zoning.

A janela Edit Zoning é exibida.

2. Na árvore Zone Sets, selecione o conjunto de zonas a ser removido.

3. Clique em Edit → Remove para remover o conjunto de zonas.

4. Clique em Apply para salvar alterações no banco de dados de zoneamento.

Nota: Você pode utilizar menus de atalho para remover um conjunto de zonas do
banco de dados.

Removendo Todas as Definições de Zoneamento
Para remover todas as zonas e conjunto de zonas definições do banco de dados
de zoneamento, utilize um dos seguintes métodos:

v Clique em Edit → Remove All. Na janela Remove All, clique em Yes para
confirmar que deseja excluir todas as zonas e conjuntos de zonas.

v Clique com o botão direito no título Zone Sets na parte superior da árvore Zone
Sets e selecione Clear Zoning no menu popup. Clique em Yes para confirmar
que deseja excluir todos os conjuntos de zonas e zonas.

Gerenciando Zonas
Gerenciar zonas envolve as seguintes tarefas:

v Criar uma zona em um conjunto de zonas

v Incluir membros de zonas

v Renomear uma zona ou um conjunto de zonas

v Remover um membro de zona

v Remover uma zona de um conjunto de zonas

v Remover uma zona de todos os conjuntos de zonas

v Alterar tipos de zonas

Nota: As alterações feitas no banco de dados de zoneamento são limitadas ao
módulo de chave gerenciado e não se propagam para o resto da malha.
Para distribuir alterações para conjuntos de zonas configuradas em toda a
malha, é necessário editar os bancos de dados de zoneamento nos módulos
de chave individuais.
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Criar uma Zona em um Conjunto de Zonas
Quando uma zona é criada, seu tipo de zona é temporária. Para alterar o tipo de
zona para zona fixa, consulte “Alterando os Tipos de Zona” na página 99 para obter
informações adicionais. Consulte “Zonas” na página 89 para obter informações
sobre tipos de zonas (temporária e fixa). Conclua as seguintes etapas para criar
uma zona em um conjunto de zonas:

1. Na janela Faceplate, clique em Zoning → Edit Zoning.

A janela Edit Zoning é exibida.

2. Clique em Edit → Create a Zone.

A janela Create a Zone é exibida.

3. Digite um nome para a nova zona e clique em OK. O novo nome da zona é
exibido na janela Zone Sets.

Nota: Se for digitado o nome de uma zona que já existe no banco de dados, o
SAN Utility criará uma cópia dessa zona e seus membros no conjunto de
zonas.

4. Utilize um dos seguintes métodos para incluir portas ou dispositivos na zona:

v Na árvore de conjunto de zonas, selecione o conjunto de zonas. Na janela
de gráficos, selecione a porta para incluir na zona. Clique em Edit → Add
Members.

v Selecione uma porta pelo número da porta, endereço Fibre Channel ou
nome universal da porta na árvore da Porta ou Dispositivo e arraste-a para a
zona.

v Selecione uma porta pelo número da porta, endereço Fibre Channel ou
nome universal da porta na árvore da Porta e Dispositivo. Clique com o
botão direito na zona e selecione Add Zone Members no menu popup.

5. Clique em Apply para salvar as alterações no banco de dados de zoneamento.

Incluir Membros de Zonas
Incluir um membro de zona a uma zona afetará todo conjunto de zonas do qual
essa zona seja membro. Para incluir portas e dispositivos membros em uma zona,
escolha um dos métodos a seguir:

v Selecione uma porta pelo número da porta, endereço Fibre Channel ou nome
universal da porta na árvore da Porta e Dispositivo e arraste-a para a zona. Para
selecionar e arrastar várias portas e dispositivos, mantenha pressionada a tecla
Ctrl enquanto arrasta.

v Selecione uma ou mais portas pelo número da porta, endereço Fibre Channel ou
nome universal da porta na árvore da Porta e Dispositivo. Clique com o botão
direito na zona e selecione Add Zone Members no menu popup.

Clique em Apply para salvar as alterações no banco de dados de zoneamento.

Nota: Os conflitos de ID de domínio podem resultar em reatribuição automática de
IDs de domínio de módulo de chave. Essas reatribuições não são refletidas
em zonas que utilizam ID de domínio e par de números de porta Channel
para definir seus membros. Certifique-se de reconfigurar zonas que são
afetadas por uma alteração de ID de domínio.

Renomear uma Zona ou um Conjunto de Zonas
Conclua as seguintes etapas para renomear uma zona:

1. Na janela Edit Zoning, na árvore Zone Sets, clique na zona ou conjunto de
zonas a ser renomeado.

2. Clique em Edit → Rename.
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3. Na janela Rename Zone/Rename Zone Set, digite um novo nome para a zona
e conjunto de zonas.

4. Clique em OK.

Remover um Membro de Zona
Remover um membro de zona afetará toda zona e conjunto de zonas do qual essa
zona seja membro. Conclua as etapas a seguir para remover um membro de uma
zona:

1. Na janela Edit Zoning, selecione o membro da zona a ser removido.

2. Clique em Edit → Remove.

3. Clique em OK para salvar as alterações e fechar a janela Edit Zoning.

Remover uma Zona de um Conjunto de Zonas
Remover uma zona de um conjunto de zonas afetará todo conjunto de zonas do
qual essa zona seja membro. Zonas que não são mais membros de qualquer
conjunto de zonas são movidas para o conjunto de zonas órfãos. O conjunto de
zonas órfãos é salvo no módulo de chave.

Conclua as etapas a seguir para excluir uma zona de um conjunto de zonas:

1. Na janela Edit Zoning, selecione a zona a ser removida.

2. Clique em Edit → Remove.

3. Clique em OK para salvar as alterações e fechar a janela Edit Zoning.

Remover uma Zona de Todos os Conjuntos de Zona
Conclua as etapas a seguir para excluir uma zona de todos os conjuntos de zonas:

1. Na janela Edit Zoning, selecione a zona a ser removida

2. Clique em Edit → Remove Zone from All Sets.

3. Clique em OK para salvar as alterações e fechar a janela Edit Zoning.

Alterando os Tipos de Zona
Zonas que não são mais membros de qualquer conjunto de zonas são movidas
para o conjunto de zonas órfãos. O conjunto de zonas órfãos é salvo no módulo de
chave.

Conclua as etapas a seguir para alterar um tipo de zona:

1. Na janela Faceplate, selecione o módulo de chave com o tipo de zona que
deseja alterar.

2. Clique em Zoning → Edit Zoning ou clique no ícone Zoning para abrir a janela
Edit Zoning.

3. Na árvore Zone Sets, selecione a zona a alterar.

4. Clique em Edit → Set Zone Type.

A janela Set Zone Type é exibida.

5. Clique em Zone Type → Soft, ACL (zoneamento fixo) ou VPF (zoneamento
fixo).

v O zoneamento temporário é o tipo de zoneamento menos restritivo.

v O zoneamento ACL é zoneamento fixo e é aplicado por hardware e define o
acesso a uma porta determinada. As zonas ACL não precisam incluir links
interchaves.

v O zoneamento VPF é zoneamento fixo que define portas que podem
comunicar umas com as outras. As zonas VPF devem incluir links
interchaves.
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Para obter informações adicionais sobre tipos de zonas, consulte “Zonas” na
página 89.

Gerenciando Aliases
Um alias é um conjunto nomeado de portas ou dispositivos que são agrupados por
conveniência. Um alias não é uma zona e não pode ter uma zona ou outro alias
como membro. Esta seção descreve como criar, remover e incluir um membro em
um alias.

Nota: As alterações feitas no banco de dados de zoneamento são limitadas ao
módulo de chave gerenciado e não se propagam para o resto da malha.
Para distribuir alterações para conjuntos de zonas configuradas em toda a
malha, é necessário editar os bancos de dados de zoneamento nos módulos
de chave individuais.

Criar um Alias
Conclua as etapas a seguir para criar um alias:

1. Na janela Faceplate, clique em Zoning → Edit Zoning.

A janela Edit Zoning é exibida.

2. Clique em Edit → Create Alias.

A janela Create Alias é exibida.

3. Digite um nome para o alias e clique em OK. O nome do alias é exibido na
janela Zone Sets.

4. Clique em OK para salvar o nome do alias no banco de dados de zoneamento.

Incluir um Membro em um Alias
Para incluir um membro em um alias, utilize um dos seguintes métodos:

v Método arrastar e soltar

v Opções de menu

Conclua as etapas a seguir para incluir um membro em um alias utilizando o
método arrastar e soltar:

1. No painel direito da janela Faceplate, clique e mantenha pressionado o botão
do mouse no membro a ser incluído no alias.

2. Arraste o membro selecionado do painel direito para o alias no painel esquerdo.

Conclua as etapas a seguir para incluir um membro em um alias utilizando as
opções de menu:

1. Clique em Zoning → Edit Zoning.

A janela Edit Zoning é exibida.

2. No painel esquerdo da janela Edit Zoning, selecione um alias.

3. No painel direito, selecione o membro a incluir no alias selecionado.

4. Conclua uma das seguintes ações:

v Clique em Edit → Add Members.

v Clique em Insert.

5. Clique em OK para salvar as alterações e fechar a janela Edit Zoning.

Remover um Alias de Todas as Zonas
Conclua as seguintes etapas para remover um alias de todas as zonas:

1. Na árvore Conjuntos de Zonas na janela Edit Zoning, selecione o alias a ser
removido.
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2. Clique em Edit → Remove Alias from All Zones.

3. Na janela Remove, clique em Yes.

Gerenciando Módulos de Chave
Esta seção descreve as tarefas a seguir que gerenciam módulos de chave na
malha.

v Exibindo informações de módulo de chave

v Gerenciando alarmes

v Exportando informações do servidor de nomes para um arquivo

v Localizando um módulo de chave

v Definindo data e hora do módulo de chave

v redefinindo um módulo de chave

v Configurando um módulo de chave

v Arquivando um módulo de chave

v Gerenciando firmware

Exibindo Informações de Módulo de Chave
A janela Faceplate e as janelas de dados fornecem as seguintes informações
específicas do módulo de chave:

v Informações sobre o servidor de nomes

v Especificações e endereços do módulo de chave

v Parâmetros de configuração

v Estatísticas de desempenho

v Conjuntos de zonas configuradas

v Informações de log de alarme

Uma malha atualiza as janelas Topology e Faceplate transmitindo as alterações no
status para a estação de trabalho de gerenciamento de rede à medida que
ocorrem. Você pode utilizar a malha para atualizar o status do módulo de chave ou

Figura 12. Janela de Dados Faceplate
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pode atualizar o status da chave a qualquer momento. Para atualizar um status de
módulo de chave que esteja exibido, execute uma das seguintes ações:

v Clique em Refresh.

v Clique em View → Refresh.

v Pressione a tecla F5.

v Clique com o botão direito no módulo de chave na janela Topology e clique em
Refresh Switch.

v Clique com o botão direito na janela de gráficos na janela Faceplate e clique em
Refresh Switch.

Janela de Dados Name Server
A janela de dados Name Server exibe informações sobre os dispositivos que estão
registrados na malha. Clique na guia Name Server abaixo da janela de dados para
exibir informações sobre o servidor de nomes de todos os dispositivos que estão
registrados na malha selecionada. Para limitar a exibição a dispositivos que estão
registrados nos módulos de chave específicos, selecione uma ou mais chaves na
árvore de malha ou na janela Topology. Para obter uma descrição das entradas na
janela Name Server Data, consulte a Tabela 19. Para exportar informações sobre o
servidor de nomes, consulte “Exportando Informações Sobre o Log de Alarme para
um Arquivo” na página 106.

Nota: As portas internas 1 a 14 são fixas.

Tabela 19. Entradas da Janela de Dados do Servidor de Nomes

Entrada Descrição

Dispositivo Número de dispositivo na malha

Número Nome do módulo de chave

Porta Número da porta: Ext1:0, Ext2:15

Endereço Endereço Fibre Channel

Tipo Tipo de nó

NWWN Node worldwide name

PWWN Port worldwide name

Fornecedor Placa de barramento de host e fornecedor de dispositivo

Tipos FC-4 Tipos de protocolo Device Fibre Channel

Zonas ativas Zonas no conjunto de zonas ativas atual que contêm o dispositivo

Janela Switch Data
A janela Switch Data exibe informações de rede e de módulo de chave atuais para
as chaves selecionadas. Para obter informações adicionais sobre a janela de
dados Switch, consulte “Configurando um Módulo de Chave” na página 107. Para
abrir a janela Switch Data, selecione um ou mais módulos de chave na janela
Topology e clique na guia Switch abaixo da janela. Também é possível abrir a
janela Switch Data a partir da janela Faceplate.

Tabela 20. Entradas da Janela de Dados de Chave

Entrada Descrição

FcAddress Endereço Fibre Channel do módulo de chave

World Wide name Nome universal do módulo de chave

Razão do status Informações adicionais de status
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Tabela 20. Entradas da Janela de Dados de Chave (continuação)

Entrada Descrição

Nome do usuário Nome de usuário

Nível de login Nível de segurança

Segurança ativada Segurança de malha no módulo de chave que impõe nomes de
conta e senhas

Fornecedor Fabricante de módulo de chave

Versão flash Flash ativo

Versão de flash inativa Versão de firmware inativa

Versão PROM/Flasher Versão de firmware

Endereço MAC Endereço de controle de acesso de mídia

Endereço IP Endereço Internet Protocol

Máscara de sub-rede Máscara que determina a sub-rede do endereço IP

Gateway Endereço de gateway

ID de domínio negociado O ID de domínio atualmente utilizado pela malha

ID de domínio
configurado

O ID de domínio definido pelo administrador da rede

Trava do ID de domínio Status da trava do ID de domínio. Impede (True) ou permite
(False) atribuição de ID de domínio dinâmico

Número de portas Número de portas no módulo de chave

Tipo de chave Modelo de módulo de chave IBM Fibre Channel

Estado operacional Estado operacional do módulo de chave: Online, offline e
diagnóstico

Estado administrativo Estado administrativo atual do módulo de chave: Online, offline e
diagnóstico

Estado Administrativo
Configurado

Estado administrativo de de módulo de chave que está
armazenado na configuração de chave

’Tempo limite MFS Valor de tempo limite de seqüenciamento de quadros múltiplos

Tempo limite de RA Valor de tempo limite de alocação de recursos

Tempo limite de RT Valor de tempo limite de receptor transmissor

Tempo limite de ED Valor de tempo limite de detecção de erro

Modo de mesclagem de
zoneamento

Mesclagem de conjuntos de zonas ativas ou mesclagem de
conjuntos de todas as zonas

Salvamento automático
de mesclagem de
zoneamento

Status de salvamento automático de zoneamento. Salva
atualizações de zoneamento nas memórias temporária e
permanente (Verdadeiro) ou somente na memória temporária
(Falso).

Visibilidade padrão de
zoneamento

Status da visibilidade de zoneamento. Permite (TODOS) ou
impede (Nenhum) a comunicação com outros módulos de chave
na ausência de um conjunto de zonas ativas.

Temperatura Não aplicável

Status do ventilador 1 Não aplicável

Status do ventilador 2 Não aplicável

Status do ventilador 3 Não aplicável

Status da fonte de
alimentação 1

Não aplicável
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Tabela 20. Entradas da Janela de Dados de Chave (continuação)

Entrada Descrição

Status da fonte de
alimentação 2

Não aplicável

Status da estação de
orientação

Status da estação de orientação. Os LEDs registrados na porta
estão piscando (Ligados) ou não (Desligados).

Suporte à difusão Status do suporte à difusão. O suporte à difusão é ativado ou
desativado (padrão).

Em banda ativado Status de gerenciamento de entrada de banda. Permite
(Verdadeiro) ou impede (Falso) que um módulo de chave seja
gerenciado por um ISL.

Data da chave Data e hora do módulo de chave

Janela de Dados Link
A janela dados Link exibe informações sobre todos os links de módulo de chave na
malha ou nos links selecionados. Essas informações incluem o nome do módulo de
chave e número da porta no final de cada link. Para abrir a janela de dados Link,
clique na guia Link abaixo da janela.

Aplicativo Gráfico da Porta de Exibição de Malha
Você pode utilizar o aplicativo Fabric View para exibir o desempenho da porta
como gráficos. A janela Fabric View exibe taxas de comunicação de dados e total
de erros das portas selecionadas como mostrado na Figura 23 na página 133. É
possível fazer o gráfico das taxas de dados de comunicação em quadros por
segundo ou KB por segundo. Consulte “Utilizando o Aplicativo Fabric View” na
página 133 para obter informações sobre tarefas que podem ser desempenhadas
utilizando o aplicativo Fabric View.

Janela Port Statistics Data
A janela Port Statistics Data exibe dados de desempenho de porta das portas
selecionadas. Para abrir a janela Port Statistics Data, clique na guia Port Statistics
abaixo da janela de dados na janela Faceplate. Para obter uma descrição das
entradas da janela Port Statistics Data, consulte a Tabela 28 na página 115.

O menu Statistics é acessível na janela Port Statistics Data e fornece maneiras
diferentes de exibir informações detalhadas sobre portas. Clique na seta para baixo
para abrir o menu Statistics. No menu StatIstics, você pode:

v Clicar em Absolute para exibir a contagem total de estatísticas desde a última
redefinição do módulo de chave.

v Clique em Rate para exibir o número de estatísticas contadas por segundo em
um período de polling.

v Clique em Baseline para exibir a contagem total de estatísticas desde a última
vez que a linha de base foi definida.

v Clique em Clear Baseline para definir a linha de base atual.

Janela Port Information Data
A janela Port Information Data exibe informações sobre detalhes de porta das
portas selecionadas. Para abrir a janela Port Information Data, clique na guia Port
Info abaixo da janela de dados na janela Faceplate. Para obter uma descrição das
entradas da janela Port Information Data, consulte a Tabela 29 na página 117.

Janela Configured Zonesets Data
A janela Configured Zonesets Data exibe todos os conjuntos de zonas, zonas e
membros de zonas no banco de dados de zoneamento. Para abrir a janela
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Configured Zonesets Data, clique na guia Configured Zonesets abaixo da janela
de dados na janela Faceplate mostrada na Figura 13.

A janela Zonesets Data utiliza convenções de exibição para expandir e contrair
entradas semelhantes à árvore de malha. Um identificador de entrada à esquerda
de uma entrada na árvore indica que é possível expandir a entrada. Clique nesse
identificador ou dê um clique duplo nas seguintes entradas para expandi-las ou
contrai-las:

v Uma entrada de conjuntos de zonas se expande para mostrar suas zonas
membros.

v Uma entrada de zona se expande para mostrar seus membros por número de
porta, worldwide name ou endereço Fibre Channel.

Janela Alarm Log Data
A janela Alarm Log Data exibe informações de eventos de módulo de chave. Para
abrir a janela Alarm Log Data, clique na guia Alarm Log abaixo da janela de dados
na janela Faceplate.

Gerenciando Alarmes
O módulo de chave pode ser configurado para gerar e registrar alarmes. Para
exibir o Log de Alarme, clique na guia Alarm Log na janela Faceplate. Para obter
informações sobre o log de alarme, consulte “Janela Alarm Log Data”. Também é
possível exportar o log de alarme para um arquivo no formato XML.

Configurando Alarmes
Configurar um alarme envolve escolher um tipo de evento, elevar e abaixar limites,
um intervalo de amostra e ativar ou desativar o alarme.

Conclua as seguintes etapas para configurar um alarme:

1. Na janela Faceplate, clique em Switch → Configure Alarm Threshold.

2. A janela Alarm Threshold Configuration mostrada na Figura 14 na página 106,
avisa-o para selecionar um evento, definir limites, definir um intervalo de
amostra ou desativar o alarme.

Figura 13. Janela Zonesets Data
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3. Selecione um tipo de evento no menu pulldown Alarm Threshold. Escolha
entre as seguintes opções:

v Monitoração de erros de CRC

v Monitoração de erros de decodificação

v Monitoração de ISL

v Monitoração de login

v Monitoração de logout

v Perda de monitoração de sinal

4. Insira um valor no campo Falling Threshold. O limite em queda é a contagem
de evento acima da qual um evento torna-se qualificado para registro no log
de alarme.

5. Insira um valor no campo Rising Threshold. O limite em elevação é a
contagem de evento acima da qual um evento é registrado. Após a contagem
exceder o limite em elevação, um alarme é registrado. O módulo de chave
não irá gerar outro alarme para esse evento até a contagem cair abaixo do
limite em queda e elevar-se novamente acima do limite em elevação.

6. Insira um intervalo de amostra, em milissegundos. O intervalo de amostra
define o intervalo de tempo no qual contar eventos.

7. Selecione a caixa de opções Enable para tornar o alarme qualificado para
uso.

8. Repita a etapa 3 até a etapa 7 para cada alarme que deseja configurar ou
ativar.

9. Selecione a caixa de opções Enable Alarm Threshold Generation para ativar
todos os alarmes qualificados na etapa 7.

10. Clique em OK para salvar todas as alterações.

Exportando Informações Sobre o Log de Alarme para um
Arquivo
Conclua as seguintes etapas para salvar o log de alarme de módulo em um
arquivo:

1. Na janela Faceplate, clique em Switch → Export Alarm Log.

2. Digite um nome de arquivo na janela Save.

3. Clique em Save.

Figura 14. Janela Alarm Threshold Configuration
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Exportando Informações do Servidor de Nomes para um Arquivo
Conclua as seguintes etapas para salvar informações do servidor de nomes do
módulo de chave em um arquivo:

1. Na janela Topology, clique em Switch → Export Name Server.

2. Digite um nome de arquivo na janela Save.

3. Clique em Save.

Localizando um Módulo de Chave
Você pode utilizar o recurso de estação de orientação para localizar um módulo de
chave. O recurso estação de orientação faz os dois LEDs registrados da porta
externa piscar, facilitando a localização do módulo de chave que está sendo
localizado. Para localizar uma chave, na janela Faceplate, clique em Switch →
Toggle Beacon. Para cancelar a estação de orientação, clique em Toggle
Beacon.

Definindo Data e Hora
Conclua as seguintes etapas para definir a data e hora em um módulo de chave:

1. Selecione uma chave na janela Topology e abra a janela Faceplate.

2. Na janela Faceplate, clique em Switch → Set Date/Time

3. Digite o ano, mês, dia e hora na janela Switch Date and Time e clique em OK.
O sistema avisa para redefinir o módulo de chave pata implementar a nova
data e hora.

Redefinindo um Módulo de Chave
Redefinir um módulo de chave inicia novamente a chave utilizando parâmetros de
configuração na memória. Um módulo de chave pode ser redefinido utilizando os
seguintes métodos:

v Selecione o módulo de chave a ser redefinido na árvore de malha. Clique em
Switch → Reset Switch.

v Remova e em seguida insira novamente o módulo de chave Fibre Channel na
unidade BladeCenter.

Configurando um Módulo de Chave
O SAN Utility é utilizado para configurar o módulo de chave. A configuração do
módulo de chave é dividida em duas áreas: configuração do chassi e configuração
da rede. A configuração do chassi especifica parâmetros que se relacionam à
identidade do módulo de chave na rede Fibre Channel. A configuração da rede
especifica parâmetros que se relacionam à identidade do módulo de chave na rede
Ethernet. Para abrir a janela Switch Properties, clique em Switch → Switch
Properties. Você também pode clicar com o botão direito em uma chave de
gráficos na janela Topology ou janela Faceplate e clicar em Switch Properties.

Propriedades do Módulo de Chave
Utilize a janela Switch Properties mostrada na Figura 15 na página 108 para alterar
o nome do módulo, estado administrativo e ID de domínio; ativar ou desativar
suporte à difusão; e ativar ou desativar gerenciamento de entrada de banda. Os
valores de tempo limite são exibidos apenas para fins de referência quando o
módulo de chave estiver online. Esses campos ficam ativos quando o módulo de
chave é levado para offline. Após fazer alterações, clique em OK para tornar os
novos valores efetivos.
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Symbolic Name: O nome simbólico é um nome definido pelo usuário que
identifica o módulo de chave.

Switch Module Administrative State: O estado administrativo do módulo de
chave determina o estado operacional da chave e suas portas. O estado
administrativo do módulo de chave existe em duas formas: o estado administrativo
configurado e o estado administrativo atual. O estado administrativo configurado é
o estado que é salvo na configuração da chave e é preservado através das
reinicializações da chave. O SAN Utility sempre faz alterações no estado
administrativo configurado. O aplicar administrativo atual é o estado que é aplicado
ao módulo de chave para fins temporários e não é conservado através das
redefinições da chave. O estado administrativo atual é definido com o comando Set
Switch. Para obter informações adicionais sobre o comando Set Switch, consulte
“Comando Set” na página 26.

Tabela 21. Estados Administrativos do Módulo de Chave

Parâmetro Descrição

Online O módulo de chave está disponível.

Offline O módulo de chave não está disponível.

Test O módulo de chave está no modo de diagnóstico e não está
disponível.

ID de Domínio e Trava do ID de Domínio
O ID de domínio é um identificador Fibre Channel exclusivo do módulo de chave. O
endereço Fibre Channel consiste no ID de domínio, ID da porta e ALPA (Arbitrated
Loop Physical Address). O número máximo de módulos de chave em uma malha é
239, com cada chave tendo um ID de domínio exclusivo.

Os módulos de chave vêm de fábrica com os IDs de domínio destravados. Isso
significa que se houver um conflito do ID de domínio na malha, o módulo de chave
com a prioridade principal mais alta ou a chave principal irá reatribuir quaisquer
conflitos de ID de domínio e estabelecer a malha. Se você travar o ID de domínio
em um módulo de chave e ocorrer um conflito de ID de domínio, o módulo de
chave com o WWN mais alto será isolado como uma malha separada e os LEDs
registrados nos dois módulos de chave piscarão para mostrar as portas afetadas.

Figura 15. Janela Switch Properties
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Consulte “Comando Set Config” na página 28 para obter informações sobre a
palavra-chave do módulo de chave e os parâmetros Domain ID Lock e Principal
Priority.

Se você conectar um novo módulo de chave a uma malha existente com seu ID de
domínio destravado e ocorrer um conflito de domínio, o novo módulo de chave será
isolado como uma malha separada. Porém, é possível remediar isso redefinindo o
novo módulo de chave ou tirando-o offline e em seguida colocando-o novamente
online. O módulo de chave principal reatribuirá o ID de domínio e a chave se unirá
à malha.

Nota: A reatribuição do ID de domínio não é refletida no zoneamento que é
definido pelo ID de domínio e par de números de porta. É necessário
reconfigurar as zonas que forem afetadas pela reatribuição do ID de
domínio.

Suporte à Difusão
A difusão é suportada pelo módulo de chave, que ativa o suporte a TCP/IP. A
difusão é implementada utilizando o padrão proposto especificado em Multi-Switch
Broadcast para FC-SW-3, T11 Presentation Number T11/02-031v0. O FSPF é
utilizado para configurar uma árvore estendida de malha utilizada na transmissão
de quadros de difusão. Os quadros de difusão são retransmitidos em todos os ISLs
indicados na árvore estendida e todas as F/FL_Ports online. O zoneamento de
difusão é suportado com zonas fixas ACL e VPF. Quando um quadro de difusão é
recebido, essas zonas fixas são impostas na F/FL_Port. Se o originador da difusão
estiver em uma zona fixa, o quadro é retransmitido para todas as F/FL_Ports online
na zona fixa. Se o originador do quadro de difusão não estiver em uma zona fixa, o
quadro é retransmitido em F/FL_Ports online que não estão em uma zona fixa.

Gerenciamento em Banda
Gerenciamento em banda é a capacidade de gerenciar módulos de chave através
de links interchaves. Se o gerenciamento em banda for desativado em um módulo
de chave particular, não será possível comunicar-se mais com esse módulo de
chave por nenhum outro meio que não uma conexão Ethernet ou serial direta.

Valores de Tempo Limite
Os valores de tempo limite do módulo de chave determinam os valores de tempo
limite de todas as portas externas da chave. A Tabela 22 descreve os parâmetros
de tempo limite do módulo de chave. Os valores R_A_TOV, R_T_TOV ou
E_D_TOV devem ser os mesmos para todos os módulos de chave da malha.

Nota: Os valores de tempo limite podem ser alterados somente se o estado
operacional do módulo de chave for offline.

Tabela 22. Valores de Tempo Limite

Parâmetro Descrição

R_A_TOV Tempo Limite de Alocação de Recursos. Representa o tempo
máximo que um quadro pode ser atrasado na malha e ainda ser
entregue. O padrão é 10000 milissegundos.

R_T_TOV Tempo Limite do Receptor Transmissor. O intervalo de tempo que
Sync pode ser perdido entre duas portas antes do Defeito de Link
ser detectado. O padrão é 100 milissegundos.

E_D_TOV Tempo Limite de Detecção de Erro. Representa o tempo máximo
de percurso circular que uma operação entre duas N_Ports requer.
O padrão é 2000 milissegundos.
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Propriedades da Rede
Utilize a janela Network Properties mostrada na Figura 16 para alterar os
parâmetros parâmetros de configuração do SNMP. Após fazer as alterações, clique
em OK para tornar os novos valores efetivos. Para abrir a janela Network
Properties, clique em Switch → Network Properties.

Nota: As definições de Read Community, Trap Community e Write Community são
como senhas; portanto, são campos somente leitura. As definições atuais
não são exibidas.

Configuração do IP
A configuração do IP identifica o módulo de chave na rede Ethernet e determina
qual método de inicialização (reinicialização) usar. Os métodos de inicialização
descritos na tabela a seguir são para portas externas e internas. A Tabela 23
descreve os parâmetros de configuração do IP.

Tabela 23. Parâmetros de Configuração do IP

Parâmetro Descrição

IP address Endereço IP (Internet Protocol) da porta Ethernet.
Nota: Quando a unidade BladeCenter é ligada, o módulo de
gerenciamento carrega os seguintes endereços IP padrão de fábrica:

v Compartimento do módulo de chave 3: 192.168.70.129

v Compartimento do módulo de chave 4: 192.168.70.130

Subnet mask Endereço da máscara de sub-rede da porta Ethernet. O valor padrão é
255.255.255.0.

Boot method Estático - Utiliza os parâmetros de configuração do IP inseridos na janela
Switch Properties.

Gateway Endereço de gateway IP. O valor padrão é 10.90.90.254.

Figura 16. Janela Network Properties
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Registro Remoto
O recurso Registro Remoto (syslog) ativa o salvamento das informações de log em
um host remoto que suporta o protocolo syslog. Quando ativadas, as entradas de
log são enviadas ao host syslog host no endereço IP que você especifica no
campo Logging Host IP Address. As entradas de log são salvas no log do módulo
de chave interno quer esse recurso esteja ativado ou não.

Para salvar informações de log em um host remoto, é necessário editar o arquivo
syslog.conf e, em seguida, iniciar novamente o daemon syslog. O arquivo
syslog.conf no host remoto deve conter uma entrada que especifique o nome do
arquivo de log no qual salvar mensagens de erro. Inclua a seguinte linha no
arquivo syslog.conf:
local0.info <tab> /var/adm/messages.name

Utilize <tab> para separar o campo seletor (local0.info) e o campo de ação, que
contém o nome do caminho do arquivo de log
(/var/adm/messages/messages.name).

Arquivando um Módulo de Chave
Você pode criar um arquivo archive XML que contenha o módulo de chave
parâmetros de configuração. Os parâmetros arquivados incluem os seguintes:

v Estatísticas e propriedades do módulo de chave

v Configuração do IP

v Configuração SNMP

v Estatísticas e propriedades da porta

v Configuração de zoneamento

Este arquivo archive pode ser utilizado para restaurar a configuração no mesmo
módulo de chave ou em uma chave de substituição. Também é possível utilizar o
arquivo archive como um gabarito para configurar novos módulos de chave para
incluir em uma malha. As definições de segurança e as informações da conta do
usuário não são arquivadas. O archive pode ser utilizado posteriormente para
restaurar o módulo de chave. Para obter informações adicionais, consulte
“Restaurando um Módulo de Chave” na página 132.

Conclua as etapas a seguir para arquivar uma configuração de módulo de chave:

1. Na janela Faceplate, clique em Switch → Archive.

2. Na janela Save, digite um nome de arquivo.

3. Clique em Save.

Gerenciando Firmware
A memória do módulo de chave é particionada para duas imagens de firmware.
Isso é útil ao fazer upgrade de firmware para que o firmware antigo e o novo sejam
mantidos no módulo de chave. Ao carregar novo firmware, o firmware atualmente
ativo é preservado e o novo firmware torna-se a segunda imagem ou a versão de
emergência. Você pode ativar qualquer das imagens de firmware. Se ativar o
firmware de emergência, o firmware atual torna-se a versão de emergência.

Carregando Firmware
O módulo de chave não precisa estar offline para ser feito o download do firmware.
No entanto, o módulo de chave deve ser reinicializado para ativar o novo firmware,
o que requer autoridade administrativa. O SAN Utility avisa para reinicializar o
módulo de chave após o firmware ser carregado.
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Conclua as etapas a seguir para carregar o firmware em um módulo de chave:

1. Na janela Faceplate, clique em Switch → Load Firmware.

A janela Firmware Upload é exibida.

2. Na janela Firmware Upload, clique em Select para procurar e selecionar o
arquivo de firmware a ser carregado.

3. Clique em Start para começar o processo de instalação do firmware.

4. Quando a instalação estiver concluída, clique em Close. A janela Firmware
Upload fecha.

5. O SAN Utility avisa para reinicializar o módulo de chave. Clique em OK para
reinicializar a chave e ativar o novo firmware.

Ativando o Firmware de Emergência
Conclua as etapas a seguir para ativar o de emergência:

1. Na janela Faceplate, clique em Switch → Firmware Fallback.

2. A janela Firmware Fallback exibe o nome de arquivo do firmware atual e as
versões do firmware de emergência. Clique em Yes para selecionar o firmware
de emergência ou em No para cancelar.

3. O SAN Utility avisa para reinicializar o módulo de chave. Clique em OK para
reinicializar a chave e ativar o novo firmware de emergência.

Gerenciando Portas
Esta seção descreve as tarefas a seguir que gerenciam portas e dispositivos:

v Exibindo informações de porta

v Configurando portas

Exibindo Informações sobre a Porta
As informações sobre a porta estão disponíveis principalmente na janela Faceplate
mostrada na Figura 17 na página 113. As janelas Faceplate Faceplate Display Data
fornecem informações estatísticas de módulos de chave e portas. Utilize a janela
Topology para mostrar informações de status de links entre módulos de chave.
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Monitorando o Status da Porta
A janela Faceplate fornece as seguintes informações relacionadas à porta:

v Configuração do SNMP (consulte “Monitoração de Módulo de Chave Fibre
Channel Utilizando SNMP” na página 130 para obter informações adicionais)

v Modo da porta

v Estado operacional da porta

v Velocidade da porta

v Mídia da porta

Para exibir o número da porta e informações de status de uma porta, posicione o
cursor sobre uma porta exibida na janela Faceplate. As informações de status
mudam, dependendo da opção do menu View que você selecionar.

Exibindo Modos da Porta: Para exibir o status do modo da porta, na janela
Faceplate, clique em View → View Port Modes. A Tabela 24 relaciona os modos de
porta disponíveis e suas descrições.

Tabela 24. Descrições do Modo da Porta

Modo Descrição

F Porta da malha

FL Porta do loop da malha

TL Porta do loop traduzida

G Porta genérica

GL Porta do loop da malha genérica

E Porta de expansão

D Porta do doador

Figura 17. Janela Faceplate Display Data
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Exibindo Estados Operacionais da Porta: Para exibir o estado operacional de
cada porta, na janela Faceplate, clique em View → View Port States. A Tabela 25
relaciona e descreve os estados operacionais disponíveis. O estado operacional da
porta refere-se ao estado da porta real e não ao estado administrativo que você
poderá atribuir.

Tabela 25. Estados Operacionais da Porta

Estado Descrição

Aceso Online - A porta está ativa e pronta para enviar dados.

la Inativa - O estado operacional da porta é Offline, mas o estado
administrativo é Online.

Desativada Offline - A porta está ativa e pode receber um sinal mas não pode
aceitar um login de dispositivo.

Tst Diagnóstico - A porta está no modo Diagnóstico em preparação
para testes.

Dn Desativada – A porta está inativa ou desativada; não está
recebendo um sinal e não pode ser efetuado login nela.

Exibindo Velocidades da Porta: Para exibir a velocidade de cada porta na janela
Faceplate, clique em View → View Port Speeds. A Tabela 26 relaciona as
velocidades disponíveis.

Tabela 26. Velocidades de porta

Estado Descrição

1 Gb Velocidade de transmissão de 1 Gbps (gigabits por segundo)

2 Gb Velocidade de transmissão de 2 Gbps

Exibindo Status de Mídia do Módulo SFP: Para exibir o status de mídia do
módulo SFP, clique em View → View Port Media. A Tabela 27 relaciona e descreve
os estados de mídia disponíveis.

Tabela 27. Exibição de Mídia do Módulo SFP

Ícone de mídia Descrição

O módulo SFP está online (verde)

O módulo SFP está offline (cinza)

Nenhum A porta está vazia; nenhum módulo SFP foi detectado ou está
instalado

Gráficos de Porta e Aplicativo Fabric View
Você pode utilizar o aplicativo Fabric View para exibir o desempenho da porta
como gráficos. A janela Fabric View exibe taxas de comunicação de dados e total
de erros das portas selecionadas como mostrado na Figura 23 na página 133. É
possível fazer o gráfico das taxas de dados de comunicação usando quadros por
segundo ou KB por segundo. Para obter informações adicionais sobre gráficos de
porta, consulte “Utilizando o Aplicativo Fabric View” na página 133.
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Janela Port Statistics Data
A janela Port Statistics Data exibe estatísticas sobre o desempenho da porta. Para
abrir a janela Port Statistics Data, selecione uma ou mais portas na janela
Faceplate e clique na guia Port Stats no painel de dados da janela Faceplate. A
Tabela 28 descreve as entradas da janela Port Statistics Data. Consulte a
Tabela 37 na página 137 para obter informações sobre numeração e mapeamento
da porta.

O menu Statistics está disponível na janela Port Statistics Data. Clique na seta
para baixo para abrir o menu Statistics e utilize um dos seguintes métodos para
exibir as informações detalhadas sobre a porta:

v Clique em Absolute para exibir a contagem total de estatísticas desde a última
reinicialização do módulo de chave.

v Clique em Rate para exibir o número de estatísticas contadas por segundo
durante o período de polling.

v Clique em Baseline para exibir a contagem total de estatísticas desde a última
vez que a linha de base foi definida.

Ao exibir estatísticas da linha de base, clique em Clear Baseline para definir a
linha de base atual.

Tabela 28. Entradas da Janela Port Statistics Data

Entrada Descrição

Start time O início do intervalo de tempo ao qual as estatísticas se aplicam. A
hora de início da exibição Absolute não é aplicável. A hora de início
da exibição Rate é o início do intervalo de polling. A hora de início
da exibição Baseline é a última vez que a linha de base foi
definida.

End time A última vez que as estatísticas foram atualizadas na exibição.

Total time O intervalo de tempo total da hora de início à hora final.

Login count Número de logins que ocorreram no módulo de chave.

Logout count Número de logouts que ocorreram no módulo de chave.

AI init count O número de vezes em que a porta entrou no estado de
inicialização.

Invalid destination
address

Número de identificadores de endereço (S_ID, D_ID) encontrados
em erro.

Total LIP received Número de quadros primitivos de inicialização de loop recebidos.

LIP F7F7 count Um quadro primitivo de inicialização de loop utilizado para adquirir
um AL_PA (Arbitrated Loop Physical Address).

LIP F8F7 count Atualmente não utilizada.

LIP F7AIPs count Esse LIP é utilizado para reinicializar o loop. Uma L_Port,
identificada por AL_PS, poderá ter notado uma degradação do
desempenho e está tentando restaurar o loop.

LIP F8AIPs Count Esse LIP representa um defeito de loop detectado pela L_Port
identificada por AL_PS.

LIP AIPdAIPs Count Número de reinicializações F7, AL_PS LIPs ou AL_PD (específico
do fornecedor), desempenhado.

Class 2 In Frames Número de quadros classe 2 recebidos por essa porta.

Class 2 Out Frames Número de quadros classe 2 transmitidos por essa porta.

Class 2 Words In Número de palavras classe 2 recebidas por essa porta.

Class 2 Words Out Número de palavras classe 2 transmitidas por essa porta.
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Tabela 28. Entradas da Janela Port Statistics Data (continuação)

Entrada Descrição

Class 3 In Frames Número de quadros classe 3 recebidos por essa porta.

Class 3 Out Frames Número de quadros classe 3 transmitidos por essa porta.

Class 3 Words In Número de palavras classe 3 recebidas por essa porta.

Class 3 Words Out Número de palavras classe 3 transmitidas por essa porta.

Decode Error Count Número de palavras de transmissão inválidas detectadas durante a
decodificação. A decodificação é dos caracteres de 10 bits e
caracteres K especiais.

Loss Of Sync Count Número de perdas de sincronização (>100 ms) detectadas por
essa porta. Uma perda de sincronização é detectada pelo
recebimento de uma palavra de transmissão inválida.

Invalid CRC Count Número de quadros CRC inválidos detectados.

Tx Wait Count Número de vezes que a porta informou um estado de espera por
estar sem créditos de buffer para buffer.

Class 3 Toss Count Número de seqüências classe 2 e classe 3 que foram descartadas
por essa porta. Uma seqüência pode ser descartada devido à
detecção de um quadro faltando (com base em SEQ_CNT),
detecção de um tempo limite E_D_TOV, recebimento de um quadro
rejeitado, recebimento de quadros para uma seqüência parada ou
outras causas.

FReject Count Número de quadros, de dispositivos, que foram rejeitados. Os
quadros podem ser rejeitados por muitas razões.

FBusy Count Número de quadros classe 2 e classe 3 F_BSY (malha ocupara)
gerados por essa porta em resposta a quadros de entrada.
Geralmente isso indica uma condição ocupada na malha ou N_Port
que está impedindo a entrega desse quadro.

Link Failures Número de defeitos de link óptico detectados por essa porta. Um
defeito de link é uma perda de sincronização durante um intervalo
de maior que o valor de R_T_TOV ou uma perda de sinal enquanto
não estiver no estado offline. Uma perda de sinal faz com que o
módulo de chave tente restabelecer o link. Se o link não for
restabelecido no período especificado por R_T_TOV, um defeito de
link é contado. Uma reinicialização do link é desempenhada após
um defeito de link.

Primitive Sequence
Errors

Número de primitivas inválidas recebidas pela porta.

Rx Link Resets Número de primitivas de reinicialização de link recebidas de um
dispositivo anexado.

Tx Link Resets Número de primitivas de reinicialização de link enviadas dessa
porta para uma porta anexada.

Rx Offline Sequences Número de primitivas de seqüência offline recebidas pela porta.

Tx Offline Sequences Número de primitivas offline transmitidas pela porta.

Total Errors Número total de erros de link de porta primitiva e não primitiva.

Total Tx Frames Número total de quadros transmitidos pela porta.

Total Rx Frames Número total de quadros recebidos pela porta.

Total Tx Words Número total de palavras transmitidas pela porta.

Total Rx Words Número total de palavras recebidas pela porta.

Total Link Resets Número de primitivas link-reset que são transmitidas pela porta.
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Tabela 28. Entradas da Janela Port Statistics Data (continuação)

Entrada Descrição

Total Offline Sequences Número total de seqüências offline transmitidas e recebidas pela
porta.

Consulte a Tabela 37 na página 137 para obter informações sobre numeração e
mapeamento da porta.

Janela de Dados Port Information
A janela de dados Port Information exibe informações detalhadas da porta
selecionada. Para abrir a janela de dados Port Information, clique na guia Port Info
abaixo da janela de dados na janela Faceplate.

Tabela 29. Entradas da Janela Port Information Data

Entrada Descrição

Port Address Endereço Fibre Channel da porta.

Administrative Port
Mode

O modo de porta administrativa atual: GL, G, FL, F, TL.

Operational Port Mode O modo de porta operacional.

Administrative Port State O estado da porta administrativa atual: online, offline, diagnóstico
ou desativado.

Operational Port State O estado operacional da porta.

Configured
Administrative Port State

O estado administrativo da porta que é armazenado na
configuração do módulo de chave.

Logged In Indica se foi efetuado login ou não.

E Port Connection
Status

Indica se a conexão E_Port está ativada.

E Port Isolation Reason Indica por que E_Port está isolada.

MFS Mode Indicador de ajuste de porta.

I/O Stream Guard Se a supressão RSCN está ativada ou desativada.

Administrative Port
Speed

A velocidade solicitada pelo usuário.

Operational Port Speed A velocidade realmente utilizada pela porta.

TLMode Indica se destino TL ou iniciador TL é utilizado.

BB Credits Indica se os créditos buffer para buffer estão definidos.

Ext Credits Requested Indica se os créditos estendidos são solicitados para portas.

Medium O tipo de módulo SFP.

Janela Name Server Data
A janela Name Server Data exibe informações sobre a porta e o dispositivo
conectado. Para abrir a janela Name Server Data, selecione um ou mais módulos
de chave na janela Topology e clique na guia Name Server abaixo da janela de
dados. Também é possível abrir a janela Name Server Data na janela Faceplate.
Consulte Tabela 19 na página 102 para obter uma descrição das entradas da janela
Name Server Data.
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Configurando Portas

Nota: Para portas externas (0, 15), todos os parâmetros de porta aplicam-se. Para
portas internas, apenas a definição do estado da porta é configurável.

As portas Fibre Channel externas são GL_Ports autoconfiguradas que
autonegociam velocidades de transmissão de 1 Gbps ou 2 Gbps dependendo do
dispositivo conectado. Uma GL_Port conecta a um loop de dispositivos públicos ou
um dispositivo único e configura a si mesma como uma FL_Port (porta de loop de
malha), F_Port (porta de malha) ou uma E_Port (porta de expansão). Cada porta
externa tem 12 créditos de buffer. Isso permite um cabo com comprimento de até
20 km a 1 Gbps ou 10 km a 2 Gbps. Onze créditos de uma porta podem ser
emprestados pela outra porta para estender as distâncias de transmissão.

O mecanismo de controle de fluxo do crédito de buffer fornece uma maneira de
assegurar uso pleno da mídia, independente do comprimento, ao permitir streaming
de quadro. Com streaming de quadro, o emissor pode transmitir tantos quadros
quanto créditos houver sem precisar aguardar resposta para um quadro antes de
transmitir o próximo quadro. A mídia, por isso, pode estar continuamente em uso
na sua capacidade nominal.

As definições ou características da porta externa (0,15) são configuradas
usando-se a janela Port Properties mostrada na Figura 18 na página 119. Para abrir
a janela Port Properties, selecione uma ou mais portas externas e clique em Port →
Port Properties.
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A janela Port Properties exibe o nome do módulo de chave e as portas externas
selecionadas. Utilize a janela Port Properties para alterar os seguintes parâmetros:

v Port state

v Port speed

v Port mode

v TL mode

v Port buffer credits

v I/O stream guard (RSCN suppression)

A configuração da porta interna (1 a 14) é limitada ao estado da porta como
mostrado na Figura 19 na página 120. Para abrir a janela Port Properties, selecione
uma ou mais portas internas e clique em Port → Port Properties.

Figura 18. Janela External Port Properties
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Alterando os Estados Administrativos da Porta
O Estado Administrativo da Porta determina o estado operacional de uma porta. O
estado administrativo da porta existe em duas formas: o estado administrativo
configurado e o estado administrativo atual.

O estado Administrativo Configurado é o estado que é salvo na configuração do
módulo de chave e é conservado através das reinicializações do módulo de chave.
O SAN Utility sempre faz alterações no estado administrativo configurado.

O estado Administrativo Atual é o estado que é aplicado à porta para fins
temporários e não é conservado através das reinicializações do módulo de chave.
O estado administrativo atual é definido usando o comando Set Port. Consulte a
seção “Comando Set Port” na página 37 para obter informações adicionais.
Consulte a Tabela 30 para obter mais descrições do estado administrativo da porta.

O estado Administrativo da Porta determina o estado operacional interno e externo
da porta. O estado administrativo da porta refere-se ao estado solicitado no SAN
Utility ou através de um comando Telnet. O estado operacional da porta refere-se
ao estado realmente utilizado pela porta.

Conclua as seguintes etapas para alterar o estado administrativo da porta:

1. Selecione uma ou mais portas na janela Faceplate.

2. Clique em Port → Port Properties.

A janela Port Properties é exibida.

3. Clique no Port States que corresponder ao estado da porta que deseja.

4. Clique em OK para gravar o novo estado da porta no módulo de chave.

Tabela 30. Estados Administrativos da Porta

Estado Descrição

Online Ativa e prepara a porta para enviar dados.

Offline A porta não pode receber um sinal ou aceitar um login de
dispositivo.

Test Prepara uma porta para teste e impede a porta de aceitar um
login de dispositivo.

Figura 19. Janela Internal Port Properties
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Alterando Velocidades de Porta (Apenas Portas Externas)
As portas externas do módulo de chave (0,15) são capazes de transmitir e receber
a 1 Gbps ou 2 Gbps. As portas são configuradas para velocidade de transmissão
ou para sentir a velocidade de transmissão do dispositivo ao qual estão
conectadas. As portas internas (1 a 14)são fixas a 2 Gbps. A Tabela 31 descreve
as velocidades da porta. Conclua as seguintes etapas para alterar a velocidade a
porta:

1. Selecione uma ou mais portas na janela Faceplate.

2. Clique em Port → Port Properties.

3. Selecione a velocidade que deseja.

4. Clique em Apply para gravar a nova velocidade da porta no módulo de chave.

Tabela 31. Velocidades da Porta

Estado Descrição

Auto-detect Corresponde a velocidade de transmissão do dispositivo
conectado. Auto-detect é o padrão.

1 Gb Define a velocidade de transmissão para 1 Gbps.

2 Gb Define a velocidade de transmissão para 2 Gbps.

Alterando Modos de Porta (Apenas Portas Externas)
As portas externas do módulo de chave (0,15) suportam dispositivos públicos e
privados como dispositivos únicos ou em loops. As portas externas podem ser
configuradas para autodescobrir o modo correto de corresponder ao dispositivo ou
módulo de chave ao qual está conectado. As portas internas (1 a 14) são fixas
como F_Ports. A Tabela 32 descreve os modos de porta. Conclua as seguintes
etapas para alterar o modo da porta:

1. Selecione uma ou mais portas na janela Faceplate.

2. Clique em Port → Port Properties.

A janela Port Properties é exibida.

3. Selecione a velocidade do Modo de Porta que deseja.

4. Clique em OK para gravar o novo modo de porta no módulo de chave.

Tabela 32. Modos de Porta

Estado Descrição

F_Port Porta de malha - Suporta um único dispositivo público (N_Port).

FL_Port Porta de loop de malha - Suporta um loop de até 126 dispositivos
públicos (NL_Port).

TL_Port Porta em loop traduzida - Suporta um loop de até 124 dispositivos
de destino privados ou 125 dispositivos iniciadores privados
capazes de comunicar com até 63 dispositivos iniciadores fora do
loop ou 64 dispositivos de destino fora do loop.

G_Port Porta genérica - Autodescobre como uma F_Port ou uma E_Port.

GL_Port Porta em loop genérica - Autodescobre como uma F_Port,
FL_Port ou E_Port.

Donor Porta do doador - Permite que créditos do buffer sejam usados
por outra porta.
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Configurando Modos TL (Translated Loop) (Apenas Portas
Externas)
Você pode configurar uma TL_Port (0,15) externa para suportar um loop de
dispositivos de destino privados ou um loop de dispositivos iniciadores privados.

v Para um loop de até 124 dispositivos de destino privados, clique em TL Target.
Isso ativa até 63 dispositivos iniciadores em qualquer lugar da malha para
conectar automaticamente com os dispositivos privados na TL_Port. Agrupe a
TL_Port e até 63 iniciadores na mesma zona ACL ou temporária utilizando o
nome universal ou ID de domínio e membros do ID de porta, para limitar o
número de possíveis iniciadores a 63.

v Para um loop de até 125 dispositivos iniciadores privados, clique em TL
Initiator. Isso ativa os iniciadores privados na TL_Port para conectar
automaticamente a até 64 dispositivos iniciadores e de destino na mesma zona
ACL ou temporária. É necessário agrupar a TL_Port e os dispositivos de destino
na mesma zona ACL ou temporária utilizando o nome universal ou ID de
domínio e membros do ID de porta. Se houver mais de 65 membros a zona, a
TL_Port é incapaz de comunicar com a malha.

Alterando os Créditos Buffer para Buffer (Somente Portas
Externas)
Cada porta externa do módulo de chave (0,15) tem uma capacidade de buffer de
recepção de 12 créditos ou quadros Fibre Channel, que é igual a aproximadamente
24 KB. Os créditos de buffer de porta podem ser alterados em portas para
acomodar conexões com outros módulos de chave que têm capacidades de buffer
de porta diferentes. Conclua as seguintes etapas para alterar créditos de buffer de
porta externa:

1. Selecione uma ou mais portas na janela Faceplate.

2. Clique em Port → Port Properties.

3. No campo E_Port BB Credits, digite o novo número.

4. Clique em OK para gravar a nova definição buffer para buffer no módulo de
chave.

Stream Guard de E/S
O recurso Stream Guard de E/S suprime mensagens RSCN (Registered State
Control Notification) em portas externas (0,15).

Estendendo Créditos de Porta
Cada porta externa (0,15) é suportada por um buffer de dados com capacidade de
12 créditos; ou seja, 12 quadros de tamanho máximo. Para cabos de fibra óptica,
isso permite serviço classe 2 com largura de banda completa por uma distância de
20 km a 1 Gbps (0,6 créditos por km) ou 10 km a 2 Gbps (1,2 créditos por km).
Distâncias mais longas podem ser percorridas com largura de banda total
emprestando créditos de portas doadoras designadas; portanto, agrupando as
capacidades de buffer. Isso é chamado de extensão de crédito. Cada porta
doadora contribui com 11 créditos para o pool ao qual as portas destinatárias
podem recorrer. Somente portas externas (0,15) podem ser doadoras ou
destinatárias. Por exemplo, uma porta doadora contribui com 11 créditos para o
pool ao qual um destinatário recorre para um total de 23 créditos (11+12). Isso
fornece aproximadamente 38 Km a 1 Gbps ou 19 km a 2 Gbps.

Conclua as seguintes etapas para estender créditos de buffer de porta:

1. Na janela Faceplate, selecione as portas que devem servir como portas
doadoras. Clique em Port → Port Properties. Na janela Port Properties, clique
em Donor → OK.
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Nota: As portas doadoras são incapazes de transmitir ou receber dados.

2. Na janela Faceplate, selecione a porta destinatária. As portas destinatárias
devem ser portas externas configuradas como G_Ports ou F_Ports. Clique em
Port → Extended Credits. A janela Extended Credits abre como mostrado na
Figura 20.

3. Distribua os créditos emprestados incrementando o campo Ext Credits
Requested das portas destinatárias até o total de créditos no pool. Clique em
OK. Se esse total for ultrapassado, uma mensagem é inserida no log de alarme
indicando que algumas portas destinatárias não receberam os créditos
solicitados.

4. Para confirmar que os créditos solicitados foram recebidos, abra novamente a
janela Extended Credits e corresponda o número de créditos na coluna Ext
Credits Requested com o número na coluna Donated to Port.

Nota: À medida que os créditos são utilizados, os LEDs registrados nas portas
doadoras correspondentes são acesos continuamente. Além disso, os LEDs
Activity da porta doadora refletirão o mesmo tráfego que a porta destinatária.
As portas doadoras cujos créditos estão sendo usados não estão
disponíveis para dispositivos que estão conectados a eles.

Figura 20. Janela Extended Credits

Capítulo 3. Utilizando o SAN Utility 123



Reinicializando Uma Porta
A opção Reinicializar Porta reinicializa a porta usando parâmetros de configuração
armazenados na memória. Conclua as seguintes etapas para reinicializar uma
porta:

1. Na janela Faceplate, selecione as portas a serem reinicializadas.

2. Clique em Port → Reset Port.

Para executar um teste de loopback de porta interna, externa ou online em uma
porta externa, consulte “Teste de Porta” na página 128.
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Capítulo 4. Funções do Utilitário de Gerenciamento de Chave

Este capítulo contém informações sobre os seguintes tópicos:

v Diagnósticos de LED

v Teste de porta

v Monitoração do módulo de chave Fibre Channel usando SNMP

v Restaurando os padrões de configuração do módulo de chave Fibre Channel

v Usando o aplicativo Fabric View

Diagnósticos de LED
O módulo de chave Fibre Channel do BladeCenter executa um POST como parte
de seu procedimento de inicialização. Os programas de diagnóstico POST
executam os seguintes testes:

v O checksum testa o firmware de reinicialização em PROM e o firmware do
módulo de chave nos dados Internos da memória flash. teste loopback em todas
as portas

v Teste de acesso e integridade no módulo de chave ASIC

Durante os POST, o módulo de chave registra todos os erros encontrados. Alguns
erros de POST são fatais, outros não. O módulo de chave usa o LED de sinal de
funcionamento e o LED registrado para indicar o status da chave e da porta. Um
erro fatal desativa o módulo de chave e portanto ele não continuará em operação.
Se ocorrer um erro não fatal, o módulo de chave poderá ainda operar mas
desativará as portas com erros. Seja fatal ou não fatal o erro, entre em contato
com o representante de suporte técnico da IBM.

Se não houver erros e POST, o LED de sinal de funcionamento piscará a intervalos
regulares de uma vez por segundo. Se ocorrer um erro fatal, o LED de sinal de
funcionamento emitirá um padrão de flash de erro. Se houver erros não fatais, o
módulo de chave desativa as portas com falha e pisca os LEDs com login
associados. Consulte “Padrões de LED de Sinal de Funcionamento” na página 126
para obter mais informações sobre os padrões de flash de LED de sinal de
funcionamento.

Há três conjuntos de LEDs no painel de informações. A primeira linha de LEDs na
parte superior do módulo de chave representa os do status do módulo de chave e
inclui o OK, ♥ (sinal de funcionamento) e ! (falha de chave Fibre Channel). Os
conjuntos segundo e terceiro de LEDs representam os status da porta 2 externa
Fibre Channel e da porta 1 Fibre Channel. Os LEDs de portas incluem o da porta
com login, o de atividade de porta e de porta com falha. A Figura 21 na página 126
mostra a localização desses LEDs no módulo de chave. Para obter mais
informações sobre LEDs de módulo de chave, consulte o IBM Eserver
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Padrões de LED de Sinal de Funcionamento
Os LEDs de sinal de funcionamento usam diferentes padrões de flash para indicar
as seguintes condições:

v Normal

v Falha de firmware interna

v Erro fatal

v Erro do sistema de arquivos de configuração

Padrão de Flash de LED Normal (Tudo OK)
Se o diagnóstico POST estiver OK e o processador do módulo de chave estiver
operando corretamente, a chave entrará em operação normal e o LED de sinal de
funcionamento piscará a intervalos regulares de uma vez por segundo.

Padrão de Flash de LED de Falha de Firmware Interna
O padrão de flash de falha de firmware interna é de dois flashes por segundo,
seguidos por uma pausa de 2 segundos, como mostrado na ilustração a seguir. O
padrão de erro de dois flashes indica que o firmware falhou e que o módulo de
chave deve ser reinicializado.

Padrão de Flash de LED de Erro Fatal
O padrão de flash de erro fatal é de três flashes por segundo seguidos por uma
pausa de 2 segundos, como mostrado na ilustração a seguir. O padrão de erro de
três flashes indica que um erro fatal deixou o módulo de chave inoperante. Se

Figura 21. LEDs de Módulo de Chave
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ocorrer um erro fatal, entre em contato com o representante de suporte técnico da
IBM.

Padrão de Flash de LED de Erro de Sistema de Arquivos de
Configuração
Um padrão de flash de erro de sistema de arquivos de configuração é de quatro
flashes por segundo seguidos por uma pausa de 2 segundos, como mostrado na
ilustração a seguir. O padrão de erro de quatro flashes indica que ocorreu um erro
no sistema de arquivos de configuração.

Padrão de Flash de LED de Falha do Módulo de Chave
O LED de Falha de Chave âmbar acende para indicar uma ou mais das seguintes
condições:

v Falha de POST

v Condição de superaquecimento

v Falha do teste operacional de portas. Consulte “Padrões de Flash de LED de
Falha de Porta” na página 128 para obter informações sobre testes operacionais
de portas.

Se o LED de Falha de Chave acender por motivo que não seja uma falha do teste
operacional de porta, coloque o módulo de chave Fibre Channel do BladeCenter
offline e entre em contato com o representante de suporte técnico da IBM.

LED OK do Módulo de Chave
O LEDOK verde acende para indicar que o módulo de chave concluiu os
diagnósticos POST sem erros. Se este LED não acender quando você ligar a
unidade BladeCenter ou se desligar-se durante a operação, remova o módulo de
chave e verifique se o conector está danificado.

Padrões de Flash de LED com Login de Porta
O LED com login de Porta tem os seguintes padrões de flash:

v Com login - O LED com login fica aceso continuamente.

v Com login - O LED com login pisca uma vez por segundo como mostrado na
seguinte ilustração.

v Set beacon - Ativa ou desativa os flashes dos LEDs da Porta com Login de
acordo com [state]. Para obter informações sobre o comando set beacon,
consulte “Comando Set” na página 26.

v Erro - O LED com login pisca duas vezes por segundo como mostrado na
seguinte ilustração.
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Com Login

Erro

Uma indicação de erro de LED com login geralmente resulta do isolamento da
E_Port. A Tabela 33 descreve as causas e os recursos para condições de
isolamento da E_Port. Uma E_Port isolada é indicada por um link vermelho na
janela Topology. Consulte “Valores de Tempo Limite” na página 109, “ID de Domínio
e Trava do ID de Domínio” na página 108 e “Efetuando Zoneamento em uma
Malha” na página 89, para obter informações sobre como definir IDs, valores de
tempo limite e edição de zoneamento.

Tabela 33. Causas e correções do isolamento da E-port

Causa do isolamento Correção

Dois módulos de chave têm o
mesmo ID de domínio na mesma
malha

Corrija os IDs de domínio nos módulos de chave com
mal funcionamento. Os IDs de domínio são números
decimais dentro do limite de 1 a 239. Os IDs de
domínio devem ser exclusivos.

Os mesmos valores de tempo
limite não figuram em todos os
módulos de chave na malha

Corrija os valores de tempo limite dos módulos de
chave com mal funcionamento.

Ao mesclar duas malhas, os
conjuntos de zonas ativos contêm
zonas com os mesmos nomes mas
com associações diferentes.

Desative um dos conjuntos de zonas ativas ou edite as
zonas em conflito de modo que suas associações
sejam iguais. As zonas em conflito têm o mesmo nome
mas possuem associações diferentes. Coloque as
portas afetadas offline e em seguida online para
restaurar os links entre as chaves.

Padrões de Flash de LED de Falha de Porta
âmbar O LED de falha de porta está aceso para indicar que a porta falhou em um
dos testes operacionais executados com o SAN Utility ou com a CLI:

v Interno

v Externo

v Online

Se o LED de falha de porta estiver aceso, coloque a porta offline e entre em
contato com o representante de suporte técnico da IBM.

Teste de Porta
A porta testes loopback verificam a operação correta da porta enviando um quadro
de dados de teste pelo loop e verificando em seguida se o quadro recebido
corresponde ao quadro que foi enviado. É possível realizar os seguintes testes de
porta na janela Port Loopback:

v Teste SerDes Interno (portas internas e externas) - A teste de nível SerDes
(Serializador/Desserializador) verifica os circuitos de porta interno e externo. O
teste de nível SerDes envia um quadro de teste do ASIC pelo chip SerDes e
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retorna-o das portas internas selecionadas para o ASIC. A porta passa no teste
se o quadro enviado pelo ASIC corresponder ao quadro de teste recebido.

Nota: É necessário um plugue loopback para executar um teste SFP externo.

v Teste SFP externo (somente portas externas) - O teste de nível SFP verifica os
circuitos da porta. O teste de nível SFP envia um quadro de teste do ASIC pelo
chip SerDes, através do módulo SFP que contém o plugue loopback, e o retorna
das portas externas selecionadas para o ASIC. A porta externa passa no teste
se o quadro de teste enviado pelo ASIC corresponder ao quadro de teste
recebido.

v Teste nó a nó online (portas internas) - A teste nó a nó verifica as comunicações
entre a porta e seu nó de dispositivo ou loop de dispositivo. A porta em teste
deve estar online e conectada a um dispositivo. A porta passa no teste se o
quadro de teste enviado corresponder ao quadro de teste recebido.

Nota: Os níveis de SerDes interno e de SFP externo testam a interrupção de
comunicações na porta selecionada. O teste de nível nó a nó online não
interrompe a comunicação, porque requer que a porta esteja online.

Execute as seguintes etapas para fazer os testes interno, externo ou de loopback
de porta online em uma porta externa:

1. Na janela Faceplate, selecione a porta externa a ser testada.

2. Clique em Port → Port Loopback Test.

Abre-se a janela Port Loopback Test.

3. Na área de janela de seleção de teste, selecione o tipo de teste loopback
(interno, externo ou online) a ser executado. Se desejar executar os testes
interno ou externo, o SAN Utility avisa-o para confirmar que o estado da porta
precisa ser alterado para o estado de diagnóstico. Clique em OK. O SAN Utility
altera o estado da porta.

4. Digite a contagem de quadros, tamanho de quadro e selecione um padrão de
teste. Pode ser usado o modelo padrão ou digite um padrão de 8 dígitos

Figura 22. Janela de Teste de Loopback de Porta
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(hexadecimal). Em testes online, clique na caixa de opções Terminate Test
Upon Error se desejar que o teste pare ao encontrar um erro.

5. Clique em Start Test para iniciar o teste. A área de janela de resultados de
teste exibe o status do teste, número de quadros enviados e número de erros
encontrados.

Monitoração de Módulo de Chave Fibre Channel Utilizando SNMP
Esta seção descreve Parâmetros de configuração SNMP e de trap. O módulo de
chave agente SNMP permite o gerenciamento da monitoração de rede externa e a
notificação do status do módulo de chave.

Configuração SNMP
A configuração SNMP define como os traps de autenticação são gerenciados. A
Tabela 34 descreve os parâmetros de configuração de SNMP.

Tabela 34. Parâmetros de Configuração SNMP

Parâmetro Descrição

Contact Especifica o nome da pessoa de contato para comunicar eventos
de trap. O padrão é indefinido.

Read community Autenticação da Comunidade Read. Um campo somente gravação;
os valores do módulo de chave e do servidor de gerenciamento
SNMP devem ser os mesmos. O valor padrão é Public.

Trap community Autenticação da Comunidade Trap. Um campo somente gravação;
os valores do módulo de chave e do servidor de gerenciamento
SNMP devem ser os mesmos. O valor padrão é Public.

Location Especifica o nome da localização módulo de chave. O padrão é
indefinido.

Authentication trap Ativa ou desativa o relatório de falhas de autenticação de SNMP.
Se ativado e forem usados valores incorretos da cadeia da
comunidade, ocorrerá um evento de falha de autenticação e um
trap de notificação será enviado aos endereços trap configurados.
O valor padrão é False.

Write community Autenticação de Comunidade de Gravação. Um campo somente
gravação; o valor no módulo de chave e no servidor de
gerenciamento de SNMP deve ser o mesmo. O valor padrão é
Private.

Configuração de Trap de SNMP
A configuração de trap de SNMP define quantos traps são definidos. A Tabela 35
descreve os parâmetros de configuração de trap de SNMP.

Tabela 35. Parâmetros de Configuração de Trap de SNMP

Parâmetro Descrição

Trap enabled Selecione esta caixa de opções para ativar ou desativar o trap.

Trap address Especifica o endereço IP para o qual são enviados os traps de
SNMP. O padrão é 10.0.0.1 para o trap 1 e 0.0.0.0 para os traps
2–5. É dado suporte a cinco endereços trap, no máximo.

Trap port A porta de trap na qual o trap é definido.
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Tabela 35. Parâmetros de Configuração de Trap de SNMP (continuação)

Parâmetro Descrição

Trap severity Especifica o nível de gravidade a ser atribuído ao trap. Abra o
menu e selecione um nível. Para acessar esse menu, os traps
devem estar ativados . Os níveis de gravidade de trap incluem
Unknown, Emergency, Alert, Critical, Error, Warning, Notify, Info,
Debug e Mark.

Restaurando a Configuração do Módulo de Chave Fibre Channel
Esta seção descreve as tarefas de restauração da configuração do módulo de
chave executadas com a interface CLI Telnet e o módulo de gerenciamento.

Backup de Configuração
As alterações feitas no módulo de chave desde que ele foi fabricado podem ser
salvas em um arquivo na memória não volátil. No entanto, o arquivo de backup
será perdido se o módulo de chave for reinicializado. Use os procedimentos de
imagens de usuário do FTP (File Transfer Protocol) para salvar o arquivo
configdata na estação de trabalho de gerenciamento da rede. (No FTP, não há
listagem de diretórios disponível. O arquivo de configuração de backup é sempre
nomeado configdata). Para obter informações sobre a configuração SNMP, consulte
“Configuração SNMP” na página 130 e “Configuração de Trap de SNMP” na
página 130.

Restauração da Configuração
As configurações do módulo de chave podem ser duplicadas para facilitar a
propagação de uma configuração idêntica a outros módulos de chave. Use os
procedimento de Imagens de Usuário do FTP com o comando Put para enviar o
arquivo configdata salvo anteriormente (usando o config backup) para o módulo de
chave. Na Telnet, use o comando Config Restore para retornar a configuração do
módulo de chave à configuração anteriormente salva. O módulo de chave é
reinicializado automaticamente após uma restauração com êxito.

Restaurando a Configuração Padrão de Fábrica
As definições de configuração do módulo de chave e da porta podem ser
restauradas para os valores padrão de fábrica. Para restaurar as configurações de
fábrica em um módulo de chave, clique em Switch → Restore Factory Defaults. A
Tabela 36 lista as definições de configuração do módulo de chave padrão de
fábrica. A restauração do módulo de chave para a configuração padrão de fábrica
não restaura as definições de nome de login e de senha.

Tabela 36. Definições de Configuração Padrão de Fábrica

Definições Valor

Nome do módulo Módulo de chaves Fibre Channel

Estado administrativo Online

ID de domínio 1

RA_TOV (Tempo Limite
de Alocação de
Recurso)

10.000 milissegundos
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Tabela 36. Definições de Configuração Padrão de Fábrica (continuação)

Definições Valor

RT_TOV (Tempo Limite
do Transmissor
Receptor)

100 milissegundos

ED_TOV (Tempo Limite
de Detecção de Erro)

2.000 milissegundos

Endereço IP Compartimento 3 do módulo de chave: 192.168.70.129

Compartimento 4 do módulo de chave: 192.168.70.130

Endereço de máscara
de sub-rede

255.255.255.0

Endereço de gateway 10.90.90.254

Método de
reinicialização

Estático

Contato Indefinido

Localização Indefinida

Endereço de trap Trap 1: 10.0.0.1, Traps 2–5: 0.0.0.0

Comunidade de trap Público

Comunidade de leitura Público

Comunidade de
gravação

Privada

Estado da porta Online - portas interna e externa

Velocidade da porta Auto-detec. - externa; 2G - interna

Modo da porta GL - externa; F - interna

Reinicializando o Sistema de Arquivos de Configuração
Se o LED de sinal de funcionamento no módulo de chave estiver mostrando o
padrão de quatro flashes, o sistema de arquivos de configuração pode estar
danificado. Para recuperar a configuração do módulo de chave de fábrica, use o
comando de Telnet Config Restore. O LED de sinal de funcionamento de quatro
flashes continuará inalterado até que uma configuração anterior do módulo de
chave seja restaurada com êxito. O LED de sinal de funcionamento não é refletido
no SAN Utility.

Restaurando um Módulo de Chave
Ao restaurar um módulo de chave, os parâmetros de configuração arquivados do
módulo são carregados no módulo de chave. A configuração do módulo de chave
deve ser arquivada antes de ser restaurada. Consulte “Arquivando um Módulo de
Chave” na página 111 para obter mais informações.

1. Efetue login na malha através do módulo de chave que deseja restaurar. Não é
possível restaurar um módulo de chave em um ISL.

2. Na janela Faceplate, clique em Switch → Restore.

3. Na janela Restore, digite o nome do arquivo archive ou procure o arquivo.

4. Clique em Restore.
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Utilizando o Aplicativo Fabric View
Utilize o aplicativo Fabric View para visualizar graficamente o desempenho da
porta. A janela Fabric View exibe as taxas de comunicação de dados e o total de
erros de portas selecionadas como mostrado na Figura 23. Podem ser feitos
gráficos das taxas de dados de comunicação usando-se quadros por segundo ou
KB por segundo.

Esta seção fornece as instruções necessárias para executar as seguintes tarefas
na janela Fabric View:

v Iniciar o aplicativo Fabric View

v Visualizar os gráficos de desempenho da porta

v Organizar e dimensionar os gráficos de desempenho da porta

v Personalizar os gráficos de desempenho da porta

Iniciando o Aplicativo Fabric View
Para iniciar Fabric View usando o SAN Utility, abra a janela Faceplate e clique em
Start Fabric View no menu Switch.

Visualizando os Gráficos de Desempenho de Porta
Execute as seguintes etapas para visualizar os gráficos de desempenho de porta:

1. Clique em Fabric e selecione Add Fabric ou clique no botão Add. Digite um
nome de malha e um endereço IP na janela Add a New Fabric. Inclua um
nome de login e uma senha se necessário.

2. Defina as opções de gráfico e a freqüência de polling. Por padrão, o aplicativo
Fabric View plota o total de bytes transmitidos e recebidos em uma freqüência
polling de uma vez por segundo. Consulte “Personalizando Gráficos de
Desempenho de Porta” na página 134 para obter informações sobre como
alterar o que é plotado e como é plotado.

Figura 23. Gráficos do Fabric View
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3. Selecione um ícone do módulo de chave na Árvore da Malha para exibir um
gráfico para cada porta com login nesse módulo de chave; ou exiba um gráfico
de uma única porta clicando no identificador de entrada do módulo de chave e
selecionando uma ou mais portas.

4. É possível mover os gráficos individualmente neles clicando e arrastando-os, ou
organizá-los em grupos. Consulte “Organizando e Dimensionando os Gráficos
de Desempenho de Porta” para obter mais informações.

5. Para remover um gráfico, clique em Close. Para remover todos os gráficos,
clique em View e clique em Close All Graphs.

Fabric View pode acessar apenas uma malha por vez. Para acessar outra malha, é
necessário remover a malha atual. Para remover uma malha, clique em Fabric e
selecione Remove Fabric ou clique no botão Remove.

Organizando e Dimensionando os Gráficos de Desempenho de Porta
Execute as seguintes etapas para organizar e dimensionar gráficos na janela
Fabric View:

1. Clique em View e selecione Tile Graphs Vertically. Organizar verticalmente
dimensiona e organiza os gráficos em colunas com o maior comprimento
possível.

2. Clique em View e selecione Tile Graphs Horizontally. Organizar
horizontalmente dimensiona e organiza os gráficos em linhas com o maior
comprimento possível.

3. Clique em View e selecione Cascade Graph Panels. A exibição em cascata
sobrepõe os gráficos de modo que todos os gráficos são, pelo menos,
parcialmente visíveis.

Personalizando Gráficos de Desempenho de Porta
É possível personalizar a freqüência de polling dos gráficos, o que neles é plotado
e seu esquema de cores. Execute as seguintes etapas para personalizar os
gráficos de desempenho de portas:

1. Para definir a freqüência de polling de todos os gráficos, clique em Graph e
clique em Set Polling Frequency.

2. Digite um intervalo, em segundos (de 0 a 60) e clique em OK.

3. Para selecionar o que vai ser plotado, clique em Graph e clique em Options. É
aberta a janela Modify Graph Display.
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4. Para modificar a exibição de gráficos, selecione as unidades de gráficos:

v Selecione a caixa de opções Show Bytes Data on Graph para plotar os
dados em KB por segundo.

v Selecione a caixa de opções Show Frames Data on Graph para plotar
dados em quadros por segundo.

5. Escolha o tipo de dados a serem plotados. Por exemplo, se tiver selecionado
Show Frames Data on Graph na etapa 4, você poderá plotar um ou todos os
itens a seguir:

v Total de quadros transmitidos e recebidos (Total de Quadros)

v Total de quadros transmitidos (Total Tx Quadros)

v Total de quadros recebidos (Total Rx Quadros)

Além desses, é possível plotar o total de erros selecionando a caixa de opções
Total Errors.

6. Exibe ou oculta a grade unitária. Selecione a caixa de opções Display Grid on
Graph para exibir a grade unitária.

7. Escolha o esquema de cores do gráfico. É possível selecionar a cor de cada
tipo de dados, da grade unitária e do plano de fundo clicando no campo ou
botão de cor correspondentes. Em cada caso, é possível escolher uma cor
usando as amostras, RGB (Red-Green-Blue) ou HSB (Hue-Saturation-
Brightness):

v Amostras – Clique na guia Swatches. Selecione uma amostra na paleta e
clique em OK.

Figura 24. Janela Modify Graph Display
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v RGB – Clique na guia RGB. Selecione uma cor movendo as réguas para
ajustar os valores de vermelho, azul e verde; ou digite os valores nos
campos. Clique em OK.

v HSB – Clique na guia HSB. Selecione uma cor usando um dos seguintes
métodos e clique em OK:

– Clique na paleta de cores.

– Selecione H, S ou B e use a régua para variar o valor selecionado.

– Digite os valores nos campos H, S ou B.
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Apêndice A. Mapeando Localizações de Portas e Numeração
de Software

Seu módulo de chave possui duas portas externas do Fibre Channel (a porta
externa 1 do Fibre Channel e a porta externa 2 do Fibre Channel) e 14 portas
internas do Fibre Channel que se conectam a cada um dos 14 compartimentos do
servidor blade (portas 1 a 14). O SAN Utility e a CLI para o módulo de chave
requerem a numeração de porta de 0 a 15. O agente de monitoração SNMP para o
módulo de chave enumera as portas de 1 a 16.

Mapeamento de Portas
A Tabela 37 mostra o mapeamento de numeração de portas do módulo de chave e
se a porta possui a capacidade para ser configurada.

Tabela 37. Mapeamento de Portas

Conexão de porta física
do módulo de chave

Número da porta lógica
do SAN Utility e da CLI

Numeração de
portas SNMP

Configurável

Porta externa 1 0 (Ext1:0*) 1 Sim

Compartimento do
servidor Blade 1

1 2 Não

Compartimento do
servidor Blade 2

2 3 Não

Compartimento do
servidor Blade 3

3 4 Não

Compartimento do
servidor Blade 4

4 5 Não

Compartimento do
servidor Blade 5

5 6 Não

Compartimento do
servidor Blade 6

6 7 Não

Compartimento do
servidor Blade 7

7 8 Não

Compartimento do
servidor Blade 8

8 9 Não

Compartimento do
servidor Blade 9

9 10 Não

Compartimento do
servidor Blade 10

10 11 Não

Compartimento do
servidor Blade 11

11 12 Não

Compartimento do
servidor Blade 12

12 13 Não

Compartimento do
servidor Blade 13

13 14 Não

Compartimento do
servidor Blade 14

14 15 Não

Porta externa 2 15 (Ext2:15*) 16 Sim

* Indica um nome simbólico da porta, caso seja diferente do número lógico da porta.
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Nota: As portas do Fibre Channel que se conectam a cada um dos
compartimentos do servidor blade (1 a 14) são configurações fixas de
F_Port a 2 Gbps. Apenas o estado administrativo para essas portas pode
ser alterado.
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Apêndice B. Obtendo Ajuda e Assistência Técnica

Se precisar de ajuda, serviço ou assistência técnica ou apenas desejar informações
adicionais sobre produtos IBM, você encontrará uma ampla variedade de fontes de
informações disponíveis através da IBM para ajudá-lo. Este apêndice contém
informações sobre onde procurar informações adicionais sobre a IBM e os produtos
IBM, o que fazer se tiver problemas com o sistema xSeries ou IntelliStation e para
quem solicitar assistência, se necessário.

Antes de Ligar
Antes de ligar, certifique-se de executar estas etapas para tentar resolver o
problema sozinho:

v Verifique se todos os cabos estão conectados.

v Verifique os interruptores da fonte de alimentação para certificar-se de que o
sistema está ligado.

v Utilize as informações sobre detecção de problemas na documentação do
sistema e utilize as ferramentas de diagnóstico fornecidas com o seu sistema.

v Vá para o site do Suporte IBM na Web em http://www.ibm.com/pc/support/ para
obter informações técnicas, conselhos, dicas e novos drivers de dispositivo.

v Utilize um fórum de discussão da IBM no site da IBM na Web para fazer
perguntas.

Você pode resolver muitos problemas sem assistência externa, seguindo os
procedimentos de detecção de problemas que a IBM fornece na ajuda online ou
nas publicações fornecidas com o sistema e o software. As informações fornecidas
com o sistema descrevem também os testes de diagnóstico que você pode
executar. A maioria dos sistemas xSeries e IntelliStation, sistemas operacionais e
programas é fornecida com informações que contêm procedimentos de detecção
de problemas e explicações de mensagens e códigos de erro. Se suspeitar de um
problema de software, consulte as informações do sistema operacional ou
programa.

Utilizando a Documentação
As informações sobre o sistema IBM xSeries ou IntelliStation e o software
pré-instalado, se houver algum, estão disponíveis na documentação fornecida com
o sistema. Essa documentação inclui manuais impressos, manuais online, arquivos
README e arquivos de ajuda. Consulte as informações sobre detecção de
problemas na documentação de seu sistema para obter instruções sobre como
utilizar os programas de diagnóstico. As informações de resolução de problemas ou
os programas de diagnóstico podem informá-lo de que você precisa de drivers de
dispositivo adicionais ou atualizados, ou até mesmo de outros softwares. A IBM
mantém páginas na World Wide Web, nas quais é possível obter informações
técnicas mais recentes e fazer download de drivers de dispositivo e atualizações.
Para acessar essas páginas, vá para http://www.ibm.com/pc/support/ e siga as
instruções. Você pode também solicitar publicações através do IBM Publications
Ordering System em
http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/ pbi.cgi.
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Obtendo Ajuda e Informações na World Wide Web
Na World Wide Web, o Web site da IBM contém informações atualizadas sobre os
produtos IBM xSeries e IntelliStation, serviços e suporte. O endereço para obter
informações sobre o IBM xSeries é http://www.ibm.com/eserver/xseries/. O
endereço para obter informações sobre o IBM IntelliStation é
http://www.ibm.com/pc/intellistation/.

Você encontrará informações sobre serviço dos produtos IBM, incluindo opções
suportadas, em http://www.ibm.com/pc/support/. Se você clicar em Profile na
página de suporte, poderá criar uma página de suporte personalizada. A página de
suporte possui muitas fontes de informações e maneiras de resolver problemas
incluindo:

v Diagnóstico de problemas utilizando o IBM Online Assistant.

v Download dos drivers de dispositivo e das atualizações mais recentes para seus
produtos.

v Exibição de Perguntas Freqüentes.

v Exibição de dicas e sugestões para ajudá-lo a resolver problemas.

v Participação nos fóruns de discussão da IBM.

v Configuração da notificação por e-mail de atualizações técnicas sobre seus
produtos.

Assistência e Suporte do Software
Através da IBM Support Line, você pode obter assistência por telefone, tarifada,
para resolver problemas de uso, configuração e software dos servidores xSeries,
das estações de trabalho IntelliStation e de dispositivos. Para obter informações
sobre quais produtos são suportados pela Support Line de seu país ou de sua
região, vá para http://www.ibm.com/services/sl/products/.

Para obter informações adicionais sobre a Support Line e outros serviços da IBM,
vá para http://www.ibm.com/services/ ou vá para http://www.ibm.com/planetwide/
para obter os telefones de suporte.

Assistência e Suporte do Hardware
Você pode receber assistência para o hardware através do IBM Integrated
Technology Services ou através de um revendedor IBM, se ele tiver autorização da
IBM para fornecer serviços de garantia. Vá para http://www.ibm.com/planetwide/
para obter os telefones de suporte.

Nos Estados Unidos e no Canadá a assistência e o suporte de hardware está
disponível 24 horas por dia, 7 dias da semana. No Reino Unido esses serviços
estão disponíveis de segunda a sexta-feira, das 9h às 18h.
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Apêndice C. Avisos

Estas informações foram desenvolvidas para produtos e serviços oferecidos nos
Estados Unidos.

A IBM pode não oferecer os produtos, serviços ou recursos discutidos neste
documento em outros países. Consulte um representante IBM local para obter
informações sobre os produtos e serviços disponíveis atualmente em sua área.
Qualquer referência a produtos, programas ou serviços IBM não significa que
apenas produtos, programas ou serviços IBM possam ser utilizados. Qualquer
produto, programa ou serviço funcionalmente equivalente, que não infrinja nenhum
direito de propriedade intelectual da IBM, poderá ser utilizado em substituição a
este produto, programa ou serviço. A avaliação e verificação da operação de outros
produtos, programas ou serviços não-IBM são de inteira responsabilidade do
Cliente.

A IBM pode ter patentes ou aplicativos de patentes pendentes relativas a assuntos
tratados nesta publicação. O fornecimento desta publicação não garante ao Cliente
nenhum direito sobre tais patentes. Consultas sobre licenças devem ser enviadas,
por escrito, para:

Gerência de Relações Comerciais e Industriais da IBM Brasil
Av. Pasteur 138-146
Rio de Janeiro - RJ
CEP 22290-240
Brasil

A INTERNATIONAL BUSINESS MACHINES CORPORATION FORNECE ESTA
PUBLICAÇÃO “NO ESTADO EM QUE SE ENCONTRA” SEM GARANTIA DE
NENHUM TIPO, SEJA EXPRESSA OU IMPLÍCITA, INCLUINDO, MAS NÃO SE
LIMITANDO ÀS GARANTIAS IMPLÍCITAS DE NÃO-VIOLAÇÃO, MERCADO OU
ADEQUAÇÃO A UM DETERMINADO PROPÓSITO. Alguns países não permitem a
exclusão de garantias expressas ou implícitas em certas transações; portanto, esta
disposição pode não se aplicar ao Cliente.

Estas informações podem conter imprecisões técnicas ou erros tipográficos.
Periodicamente, são feitas alterações nas informações aqui contidas; tais
alterações serão incorporadas em futuras edições desta publicação. A IBM pode, a
qualquer momento, aperfeiçoar e/ou alterar os produtos e/ou programas descritos
nesta publicação, sem aviso prévio.

Quaisquer referências nestas informações a Web sites não-IBM são fornecidos
apenas por conveniência e não representam de forma alguma um endosso a esses
Web sites. Os materiais contidos nesses sites da Web não fazem parte dos
materiais deste produto IBM e a utilização desses sites da Web é de inteira
responsabilidade do Cliente.

A IBM pode utilizar ou divulgar quaisquer informações fornecidas, de qualquer
forma que julgar adequada, sem incorrer em qualquer obrigação com relação ao
Cliente.

Aviso sobre a Edição
© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2003.
Todos os direitos reservados.
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Nota sobre Direitos Restritos para Usuários do Governo dos Estados Unidos —
Uso, duplicação e divulgação restritos pelo documento GSA ADP Schedule
Contract com a IBM Corporation.

Marcas
Os termos a seguir são marcas de International Business Machines Corporation
nos Estados Unidos e/ou em outros países:

Active Memory Predictive Failure
Analysis

Active PCI PS/2
Active PCI-X ServeRAID
Alert on LAN ServerGuide
BladeCenter
C2T Interconnect ServerProven
Chipkill TechConnect
EtherJet Tivoli
logotipo e-business Tivoli Enterprise
FlashCopy Update Connector
IBM Wake on LAN
IntelliStation XA-32
Light Path Diagnostics XA-64
NetBAY X-Architecture
Netfinity XceL4
NetView XpandOnDemand
OS/2 WARP xSeries

Lotus, Lotus Notes, SmartSuite e Domino são marcas da Lotus Development
Corporation e/ou da IBM Corporation nos Estados Unidos e/ou em outros países.

ActionMedia, LANDesk, MMX, Pentium e ProShare são marcas da Intel Corporation
nos Estados Unidos e/ou em outros países.

Microsoft, Windows e Windows NT são marcas da Microsoft Corporation nos
Estados Unidos e/ou em outros países.

UNIX é marca registrada da The Open Group nos Estados Unidos e em outros
países.

Java e todas as marcas e logotipos baseados em Java são marcas ou marcas
registradas da Sun Microsystems, Inc. nos Estados Unidos e/ou em outros países.

Linux é uma marca registrada da Linus Torvalds.

Outros nomes de empresas, produtos ou serviços podem ser marcas ou marcas de
serviços de terceiros.

Notas Importantes
Velocidade do processador indica a velocidade do clock interno do
microprocessador; outros fatores também afetam o desempenho de aplicativos.
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A velocidade da unidade de CD-ROM lista a taxa variável de leitura. As velocidades
reais variam e geralmente são menores que o máximo possível.

Nas referências ao armazenamento do processador, armazenamento real e virtual
ou volume do canal, KB significa aproximadamente 1.000 bytes, MB
aproximadamente 1.000.000 bytes e GB aproximadamente 1.000.000.000 bytes.

Nas referências à capacidade de unidade de disco rígido ou volume de
comunicação, MB significa 1.000.000 bytes e GB significa 1.000.000.000 bytes. A
capacidade total acessível pelo usuário pode variar, dependendo dos ambientes
operacionais.

As capacidades máximas internas de unidades de disco rígido assumem a
substituição de todas as unidades de disco rígido padrão e a ocupação de todos os
compartimentos de unidades de disco rígido com as maiores unidades suportadas
disponíveis atualmente na IBM.

A memória máxima pode requerer substituição da memória padrão por um módulo
de memória opcional.

A IBM não estabelece representações ou garantias com relação a produtos e
serviços não-IBM que sejam ServerProven, incluindo, sem limitações, as garantias
implícitas de comercialização ou adequação a um objetivo específico. Esses
produtos são oferecidos e garantidos unicamente por terceiros.

A IBM não estabelece representações ou garantias com relação a produtos
não-IBM. O suporte (se disponível) a produtos não-IBM é fornecido por terceiros,
não pela IBM.

Alguns produtos de software podem ser diferentes de sua versão de revenda (se
disponível) e podem não incluir manuais do usuário ou todos os recursos do
programa.
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diagnóstico de LED 125
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teste de portas 128
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gerenciando chaves 101
gerenciar malhas 83
gráficos de porta 114
Guias da janela de dados Faceplate
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estatísticas da porta 82
informações sobre a porta 82
log de alarme 83

guias da janela Topology Data
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interface gráfica com o usuário, SAN Utility
janela Faceplate 73
janela Topology 73

interface Telnet
efetuando logon em um módulo de chaves 5
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Padrões do flash de diagnóstico 125
porta com login 127
sinal de funcionamento 126
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menus popup 81
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